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Preface

Profile

Prerequisites

There are no prerequisites for this course.

How This Course Is Organized

11i Implement and Use Work in Process is an instructor-led course featuring
lecture and hands-on exercises.  Online demonstrations and written practice
sessions reinforce the concepts and skills introduced.
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System release bulletins
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read.me files
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
  (OG_GET_LAYER
(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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After completing this lesson, you should be able to
do the following:
•  Explain concepts in repetitive line scheduling
•  Set up repetitive line scheduling
•  Schedule repetitive schedules
•  Reschedule repetitive schedules
•  Sequence repetitive production

After completing this lesson, you should be able to
do the following:
•  Explain concepts in repetitive line scheduling
•  Set up repetitive line scheduling
•  Schedule repetitive schedules
•  Reschedule repetitive schedules
•  Sequence repetitive production
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• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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• Lesson 8: Summary
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OverviewOverview

Business needs:
• Optimized use of line capacity
• Effectively sequenced repetitive production
• Time-phase repetitive component demand and

assembly availability

Business needs:
• Optimized use of line capacity
• Effectively sequenced repetitive production
• Time-phase repetitive component demand and

assembly availability

Definition
Repetitive line scheduling is a method of scheduling repetitive production on a
line that considers hourly production rate, line start and stop times, assembly lead
time, workday calendar, and optionally minimum and maximum line rates.
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Functionality:
• You can model your repetitive environment

using line attributes, assembly and line
attributes, and schedule attributes, all of which
are used in repetitive line scheduling.

• The line start and stop times define repetitive
resource shifts.

• You can use repetitive line scheduling when you
define repetitive schedules manually and when
you mass load them based on suggestions from
Oracle Planning or other sources.

Functionality:
• You can model your repetitive environment

using line attributes, assembly and line
attributes, and schedule attributes, all of which
are used in repetitive line scheduling.

• The line start and stop times define repetitive
resource shifts.

• You can use repetitive line scheduling when you
define repetitive schedules manually and when
you mass load them based on suggestions from
Oracle Planning or other sources.
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• You can reschedule a repetitive schedule by
changing quantities or dates in the Repetitive
Schedules window.

• You can sequence repetitive production by using
the Repetitive Line Report or outside sequencing
applications.

• You can reschedule a repetitive schedule by
changing quantities or dates in the Repetitive
Schedules window.

• You can sequence repetitive production by using
the Repetitive Line Report or outside sequencing
applications.
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Line Scheduling

Elements of Repetitive
Line Scheduling

Description
The minimum number of completed assemblies a
production line can produce per hour.

Element

Minimum rate

The maximum number of completed assemblies a
production line can produce per hour.Maximum rate

The time required to complete the first assembly on
a production line - from the first manufacturing
operation to completion into inventory. Simply
called lead time in this section.

Line lead time

The rate at which the production line can assemble
items.

Hourly production
rate

Concepts in Repetitive Line Scheduling
• Lead time and hourly production rate are not formally related. The two are

independent in the system.
• If you physically speed up your production line, so that it takes less time

to produce each assembly, you should lower the line’s lead time. If this
change in speed also results in more assemblies being completed per hour,
you should also increase your hourly production rate.

• Two assemblies on the same line can have the same lead time but different
hourly production rates.
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Repetitive Line Scheduling Elements
(continued)

Element Description
The time a production line starts running every
day. The line start time is used to schedule
repetitive schedules on a line.

Line start time

The time a production line stops running every
day. The line stop time is used to schedule
repetitive schedules on a line.

Line stop time

The daily production rate of assemblies on a
production line. This is equal to the hourly
production rate times the line production hours.

Daily line capacity

The number of completed assemblies a
repetitive schedule plans to produce per day.
Also known as a production rate.

Daily rate

The number of days you plan to work on a
repetitive schedule, from the first unit start date
to the last unit start date.

Repetitive processing
days

Example
To schedule your repetitive production, you need to put all the elements together.
Assume that:
•   For a particular assembly on a production line, lead time = 1 hour
•   Hourly production rate = 10 assemblies per hour
•   Demand is 101 assemblies for that day
•   Line start time = 8 a.m.
•   Line stop time = 8 p.m.
• Given this information:
1   If work starts at 8 a.m., when will the first assembly be completed?
   The first assembly will be completed in 1 hour (lead time)–at 9 a.m.
2   When will the second unit be completed?
    The hourly production rate is 10 assemblies per hour; therefore, one assembly
     is completed every 6 minutes. The second unit will be completed at 9:06 a.m.
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Single-Day ScheduleSingle-Day Schedule

ScheduleSchedule
productionproduction

hourshours

QuantityQuantity
completedcompleted
per hourper hour

First unitFirst unit
completioncompletion
date/time (FUCD)date/time (FUCD)

Last unitLast unit
completioncompletion
date/time (LUCD)date/time (LUCD)

First unit startFirst unit start
date/time (FUSD)date/time (FUSD)

Last unit startLast unit start
date/time (LUSD)date/time (LUSD)

TimeTime

LineLine
speedspeed

Line production hoursLine production hours
Line start timeLine start time Line stop timeLine stop time

Lead timeLead time

Example (continued)
3 How long after the first unit is completed will the last (101st) assembly be

completed?
The hourly production rate is 10 assemblies per hour; therefore it takes 10
hours to complete 100 assemblies from the time you completed the first. Your
last assembly will be completed at 7 p.m.

4 How long does it take to build 101 assemblies?
From the first unit start time at 8 a.m. to the last completion unit time at 7 p.m.,
it takes 11 hours to build 101 assemblies. That is equal to the lead time (1 hour)
plus the number of assemblies left to build after the first, divided by the hourly
production rate (100/10).

Note: The top horizontal line indicates the constant hourly production rate that
you defined for the line for this assembly.
In this slide, schedule production hours = quantity per day/hourly production
rate.
The faster the hourly production rate, the shorter the schedule. The greater the
quantity per day, the longer the schedule.
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Multiple-Day ScheduleMultiple-Day Schedule

QuantityQuantity
completedcompleted
per hourper hour

FUSDFUSD

LUSDLUSD

WorkWork
daysdays

LineLine
speedspeed

Processing days

11 22 33 44 55

LUCDLUCDFUCDFUCD
LeadLead
timetime

Schedule
You can run a schedule for several days.
Each shaded area represents the quantity produced (the daily rate) in a day.
The unshaded area represents idle time for this assembly on this line. Other
assemblies may be running on the line at this time, or the line may be truly idle.
The total quantity for the schedule is processing days times daily rate–the sum
of all the shaded areas.
Example
You can run a schedule for several days. Assume that:
•   For a particular assembly on a production line, lead time = 1 hour.
•   Hourly production rate = 10 assemblies per hour.
•   Demand is 100 assemblies for that date.
•   Line start time = 8 a.m. and line stop time = 8 p.m.
•   You want to run the assembly on the line with these parameters for four days.
Given this information:
•   You would run the same schedule for four days.
•   With Oracle Work in Process, you can define this as a repetitive schedule,
    with processing days = 4, daily rate = 100, and total quantity = 400.
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Daily SchedulingDaily Scheduling

Daily lineDaily line
capacitycapacity

FUSD LUSDLUSD

WorkWork
daysdays

LineLine
speedspeed

Processing daysProcessing days

LUCDLUCDFUCDFUCD

QuantityQuantity
completedcompleted
per hourper hour

Graphical Representation
If you are mostly concerned with daily rate, processing days, and total quantity,
rather than hourly rates, production hours, and minute-by-minute line sequencing,
you can use a simpler graphical representation.
In this model the total quantity produced is equal to the area of the parallelogram.
Idle time or time producing other assemblies on the line in this model could be
represented as the upward continuation of the parallelogram.
Daily line capacity = hourly production rate * line production hours.
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Daily Line Capacity ExampleDaily Line Capacity Example

FUSD LUSDLUSD

120120

WorkWork
daysdays

4 Days4 Days

QuantityQuantity
completedcompleted
per hourper hour

100100
LUCDLUCDFUCDFUCD

Formula
Daily line capacity = hourly production rate * line production hours.
Example
Where hourly production rate = 10, and line production hours = 12 (from 8:00am
to 8:00pm), the daily line capacity = 120 (10 * 12).
Note: Although the daily line capacity is 120, the line is only producing the daily
demand of 100.
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Review QuestionReview Question

Repetitive processing days: the number of days you
plan to work on a repetitive schedule, from the first
unit start date to the last unit completion date.
• True
• False

Repetitive processing days: the number of days you
plan to work on a repetitive schedule, from the first
unit start date to the last unit completion date.
• True
• False
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Answer to Review QuestionAnswer to Review Question

Repetitive processing days: the number of days you
plan to work on a repetitive schedule, from the first
unit start date to the last unit completion date.
• True
• False

Repetitive processing days: the number of days you
plan to work on a repetitive schedule, from the first
unit start date to the last unit completion date.
• True
• False
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Lesson 3: Combined Assembly
and Line Attributes

Lesson 3: Combined Assembly
and Line Attributes

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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• Lesson 8: Summary
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Combined Assembly and Line AttributesCombined Assembly and Line Attributes

That assembly runs on this line.That assembly runs on this line.

(N) WIP > Repetitive > Associate Lines and Assemblies

Combined Line Attributes and Assembly
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Associating Lines and Assemblies
You can enter an alternate routing to use for lead-time calculations for
routing-based lines.
The hourly production rate determines how fast each line can produce this
assembly. The maximum hourly rate that you defined for the line serves as the
default and upper limit for the hourly production rate of any assembly running on
this line. You can override this rate by entering a new one, but not to exceed the
maximum.
Note: Oracle Work in Process does not enforce a minimum rate restriction, partly
because it does not currently check the line capacity when setting hourly
production rate. It is possible that the line is building several assemblies at the
same time and that the total production rate for all assemblies does exceed the
minimum rate, even if the speed of one individual assembly does not.
Note: The maximum rate restriction also restricts only the hourly production rate
of each individual assembly on one line. It is possible that the line is building
several assemblies and that the hourly production rate for each does not exceed
the maximum rate, but the sum of all the hourly production rates on the line does.
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Review QuestionReview Question

Oracle Work in Process enforces a minimum rate
restriction so that it can check the line capacity when
setting an hourly production rate.
•  True
•  False

Oracle Work in Process enforces a minimum rate
restriction so that it can check the line capacity when
setting an hourly production rate.
•  True
•  False
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Answer to Review QuestionAnswer to Review Question

Oracle Work in Process enforces a minimum rate
restriction so that it can check the line capacity when
setting an hourly production rate.
•  True
•  False

Oracle Work in Process enforces a minimum rate
restriction so that it can check the line capacity when
setting an hourly production rate.
•  True
•  False
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Lesson 4: Production Lines
in Repetitive Production

Lesson 4: Production Lines
in Repetitive Production

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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• Lesson 8: Summary
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Production Lines in Repetitive ProductionProduction Lines in Repetitive Production

You can set up repetitive line scheduling using the
Production Lines window.
You can set up repetitive line scheduling using the
Production Lines window.

(N) WIP > Setup > Production Lines

start
stop

07:00:00
15:30:00

minimum
maximum

100
140

Production Line Attributes
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Setting Up
You use the minimum and maximum rates to model your production line’s hourly
capacity.
You use the line’s start and stop time instead of a shift calendar to schedule
resources. Resource capacity is assumed to be available while the line is
operating. Any shift information, if defined, is ignored.
For fixed lead-time lines, you use the predefined lead time to schedule all
production on the line.
For routing-based lead-time lines, you use the detailed scheduling algorithm with
a lead-time lot size of 1 to find the lead time based on the routing of the assembly
running on the line.
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Repetitive Schedule QuantitiesRepetitive Schedule Quantities

With repetitive line scheduling, you:
• Use daily quantity to specify how many

assemblies per day to build
Note: A warning message is displayed if you try to

define a schedule whose rate exceeds the
maximum daily rate  of the line, but it does not
prevent you from defining such a schedule.

• Use days to specify for how many days you want
to produce this assembly at the specified rate

• Can use the line minimum and maximum daily rate
as a guideline for the daily quantity of schedule

With repetitive line scheduling, you:
• Use daily quantity to specify how many

assemblies per day to build
Note: A warning message is displayed if you try to

define a schedule whose rate exceeds the
maximum daily rate  of the line, but it does not
prevent you from defining such a schedule.

• Use days to specify for how many days you want
to produce this assembly at the specified rate

• Can use the line minimum and maximum daily rate
as a guideline for the daily quantity of schedule

(N) WIP > Repetitive > Repetitive Schedules

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Creating Repetitive Schedules >
Overview of Building Repetitive Schedules



Copyright © Oracle Corporation, 2000. All rights reserved.

Scheduling Repetitive Production
Chapter 6 - Page 25

Repetitive Schedule Dates and Times

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Repetitive Schedule Dates and TimesRepetitive Schedule Dates and Times

You:
• Can specify to the minute the start and completion

dates and times of your repetitive schedule
• Can schedule to the minute each day the

operations and resources of the schedule.
• Can schedule all the requirements based on

operation dates each day of the schedule.
• Must enter either the first unit start date and time

and the first unit completion date and time, or the
last unit start date and time and the last unit
completion date and time, in order to define the
lead time for a routingless assembly running on a
routing-based line.

You:
• Can specify to the minute the start and completion

dates and times of your repetitive schedule
• Can schedule to the minute each day the

operations and resources of the schedule.
• Can schedule all the requirements based on

operation dates each day of the schedule.
• Must enter either the first unit start date and time

and the first unit completion date and time, or the
last unit start date and time and the last unit
completion date and time, in order to define the
lead time for a routingless assembly running on a
routing-based line.

Note:
You can use the start and completion dates and times as a guideline for when to
produce your schedule.
You can view the operation start and end dates and times and the associated
resources of a repetitive schedule in the View Operations window.
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Repetitive Schedule RoutingRepetitive Schedule Routing

You can enter a routing revision date to specify which
revision of the routing to use for scheduling, or select
a valid routing revision from a drop-down list.

You can enter a routing revision date to specify which
revision of the routing to use for scheduling, or select
a valid routing revision from a drop-down list.
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Review QuestionReview Question

For routing-based lead-time lines, you use the
detailed scheduling algorithm with a lot size of:
•  1
•  10
•  100

For routing-based lead-time lines, you use the
detailed scheduling algorithm with a lot size of:
•  1
•  10
•  100
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Answer to Review QuestionAnswer to Review Question

For routing-based lead-time lines, you use the
detailed scheduling algorithm with a lot size of:
•  1
•  10
•  100

For routing-based lead-time lines, you use the
detailed scheduling algorithm with a lot size of:
•  1
•  10
•  100
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Lesson 5: Scheduling Repetitive
Schedules

Lesson 5: Scheduling Repetitive
Schedules

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
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• Lesson 8: Summary
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Mass Loading Repetitive SchedulesMass Loading Repetitive Schedules

You can define repetitive schedules based on
suggestions from Oracle Planning or any other
planning system.
• You can load repetitive schedules from Oracle
    Planning using the Planner Workbench.
• Oracle Planning uses lead-time offset to calculate
    the start date you see in the Planner Workbench.
• Oracle Work in Process uses repetitive line
    scheduling to calculate the exact start date you see
    in the Repetitive Schedules window after the load.

You can define repetitive schedules based on
suggestions from Oracle Planning or any other
planning system.
• You can load repetitive schedules from Oracle
    Planning using the Planner Workbench.
• Oracle Planning uses lead-time offset to calculate
    the start date you see in the Planner Workbench.
• Oracle Work in Process uses repetitive line
    scheduling to calculate the exact start date you see
    in the Repetitive Schedules window after the load.

(N) Material Planning > MRP or MPS > Workbench

(N) WIP > Repetitive > Repetitive Schedules

(Help) Oracle Master Scheduling/MRP > Planner Workbench
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Creating Repetitive Schedules >
Overview of Building Repetitive Schedules
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Mass Loading StatusMass Loading Status

Schedules are loaded into Oracle Work in Process
with a status of Pending—Mass Loaded.
Reasons for this status:
• MRP does not consider existing schedules.

Implementing these schedules without looking at
existing ones can result in overproduction.

• MRP-suggested schedules may overlap with
existing schedules, which is not allowed.

Schedules are loaded into Oracle Work in Process
with a status of Pending—Mass Loaded.
Reasons for this status:
• MRP does not consider existing schedules.

Implementing these schedules without looking at
existing ones can result in overproduction.

• MRP-suggested schedules may overlap with
existing schedules, which is not allowed.

Some Rules
•   Repetitive schedules building the same assembly on the same line may not
   overlap.
•   The first unit start date and time of a schedule must never precede the last unit
    start date and time of the previous schedule.



Copyright © Oracle Corporation, 2000. All rights reserved.

Scheduling Repetitive Production
Chapter 6 - Page 32

Importing Repetitive Schedules

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Importing Repetitive SchedulesImporting Repetitive Schedules

• You can load repetitive schedules from any
outside planning system.

• Oracle Work in Process uses repetitive line
scheduling to schedule the repetitive schedules
being loaded in.

• You can load repetitive schedules from any
outside planning system.

• Oracle Work in Process uses repetitive line
scheduling to schedule the repetitive schedules
being loaded in.
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Scheduling Repetitive SchedulesScheduling Repetitive Schedules

Rule: You cannot overlap repetitive schedules.
Example:
Rule: You cannot overlap repetitive schedules.
Example:
QuantityQuantity
completedcompleted
per hourper hour

TimeTime

LineLine
speedspeed

FUCD 1FUCD 1 LUCD 1LUCD 1 FUCD 2FUCD 2 LUCD 2LUCD 2

FUSD 1FUSD 1 LUSD 1LUSD 1 FUSD 2FUSD 2 LUSD 2LUSD 2

Example
The above schedules do not overlap because FUSD2 is greater than LUSD1. This
means that even if there is idle time on the line on any given day of the schedule,
you cannot define another schedule for the same assembly on this line.
Not allowing overlap enables Oracle Work in Process to perform flow charging
for repetitive schedules. (Flow charging is when you charge the repetitive
assembly and line rather than a specific job. It is based on FIFO. If more than one
schedule is running at the same time, you do not know to which schedule
transaction charges need to be allocated.)
Overlapping
It is helpful to think of the assembly moving down the production line, so that
even though the first unit of the second schedule starts before the first schedule is
completed, the units of the first schedule are far enough down the line for the
second schedule to begin.
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Scheduling Repetitive ShiftsScheduling Repetitive Shifts

Rule: You cannot overlap repetitive schedules.
Example:
Rule: You cannot overlap repetitive schedules.
Example:
QuantityQuantity
completedcompleted
per hourper hour

TimeTime

LineLine
speedspeed

FUCD 1FUCD 1 LUCD 1LUCD 1 FUCD 2FUCD 2 LUCD 2LUCD 2

FUSD 1FUSD 1 LUSD 1LUSD 1 FUSD 2FUSD 2 LUSD 2LUSD 2

Consideration
The overlap restriction means that you cannot schedule repetitive shifts using
multiple-day schedules.
For example, you cannot define two schedules to run concurrently for several
days, one to represent the day shift, the other to represent the night shift.
If you have a need to separate the schedules in a way that matches the repetitive
production shifts, you need to create repetitive schedules that align with, or
simulate, these shifts. For instance, you may want to simulate the repetitive shifts
if you are building one bill revision during the day and a different bill revision at
night.
You may also want to simulate repetitive shifts if you want to keep separate
performance data for each shift.
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Scheduling Repetitive Schedules:
Option 1

Scheduling Repetitive Schedules:
Option 1

You have two options for simulating repetitive shifts.You have two options for simulating repetitive shifts.

QuantityQuantity
completedcompleted
per hourper hour

TimeTime6 a.m.6 a.m.

Day
shift
(S1)

Night
shift
(S2)

Day
shift
(S3)

Night
shift
(S4)

6 p.m.6 p.m. 6 a.m.6 a.m. 6 p.m.6 p.m.

Option 1
• Define two or more schedules on the same line for each day of production.

S1, S2, S3, and S4 in the diagram are separate repetitive schedules.
• This option uses the same line and assembly for all schedules, so that you

can still do flow charging on transactions.
• With this option you have to define as many schedules as you have shifts

for each day of production.
• With this option you cannot separate costs, hourly production rates,

performance, and so on, across shifts.
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Scheduling Repetitive Schedules:
Option 2

Scheduling Repetitive Schedules:
Option 2

QuantityQuantity
completedcompleted
per hourper hour
on line 1on line 1

TimeTime6 a.m.6 a.m. 6 a.m.6 a.m.

Day
shift

Day
shift

QuantityQuantity
completedcompleted
per hourper hour
on line 2on line 2

TimeTime

Night
shift

6 p.m.6 p.m. 6 p.m.6 p.m.

Night
shift

S1

S2

Option 2
• Define your production line as two lines in the system and set your line

start and stop times equal to the shift start and stop times. Define one
schedule on each line to last for several days.
S1 and S2 are the only two schedules you have to define using this option.

• If you use this option, you cannot do flow charging on transactions,
because you are producing on a different line.

• You cannot consolidate your costs across different lines.
• You can support performance evaluations, hourly production rate

differences, and cost differences across shifts.
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Review QuestionReview Question

If more than one schedule is running at the same
time, you can still know to which schedule
transaction charges can be allocated.
•  True
•  False

If more than one schedule is running at the same
time, you can still know to which schedule
transaction charges can be allocated.
•  True
•  False
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Answer to Review QuestionAnswer to Review Question

If more than one schedule is running at the same
time, you can still know to which schedule
transaction charges can be allocated.
•  True
•  False

If more than one schedule is running at the same
time, you can still know to which schedule
transaction charges can be allocated.
•  True
•  False
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Review QuestionReview Question

Option 1 allows you to define two or more schedules
on the same line for each day of production.
•  True
•  False

Option 1 allows you to define two or more schedules
on the same line for each day of production.
•  True
•  False
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Answer to Review QuestionAnswer to Review Question

Option 1 allows you to define two or more schedules
on the same line for each day of production.
•  True
•  False

Option 1 allows you to define two or more schedules
on the same line for each day of production.
•  True
•  False
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Review QuestionReview Question

Which of the following statements is/are not true?
1 You can load repetitive schedules from a 3rd party

system.
2 You should load schedules from MRP in an

unreleased status.
3 When importing repetitive schedules, the first unit

start date and time must never precede the last unit
start date and time of the previous schedule.

4 You should never overlap schedules when building
the same assembly on separate lines.

Which of the following statements is/are not true?
1 You can load repetitive schedules from a 3rd party

system.
2 You should load schedules from MRP in an

unreleased status.
3 When importing repetitive schedules, the first unit

start date and time must never precede the last unit
start date and time of the previous schedule.

4 You should never overlap schedules when building
the same assembly on separate lines.
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Answer to Review QuestionAnswer to Review Question

Which of the following statements is/are not true?
1 You can load repetitive schedules from a 3rd party

system.
2 You should load schedules from MRP in an

unreleased status.
3 When importing repetitive schedules, the first unit start

date and time must never precede the last unit start
date and time of the previous schedule.

4 You should never overlap schedules when building
the same assembly on separate lines.

Which of the following statements is/are not true?
1 You can load repetitive schedules from a 3rd party

system.
2 You should load schedules from MRP in an

unreleased status.
3 When importing repetitive schedules, the first unit start

date and time must never precede the last unit start
date and time of the previous schedule.

4 You should never overlap schedules when building
the same assembly on separate lines.
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Lesson 6: Rescheduling Repetitive
Schedules

Lesson 6: Rescheduling Repetitive
Schedules

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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Benefits of ReschedulingBenefits of Rescheduling

By rescheduling your repetitive schedules, you can
respond quickly to:
•  New information
•  Temporary increases or decreases in demand
•  Changes in priority
•  Temporary increases or decreases in capacity
•  MRP recommendations

By rescheduling your repetitive schedules, you can
respond quickly to:
•  New information
•  Temporary increases or decreases in demand
•  Changes in priority
•  Temporary increases or decreases in capacity
•  MRP recommendations
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Changing Schedule AttributesChanging Schedule Attributes

You can change:
• Schedule dates and times to reflect priority

changes
• Schedule processing days to lengthen or shorten

the schedule
• Schedule daily rate to increase or decrease your

daily production
• Schedule total quantity to increase or decrease

your total production. This implies a change in
processing days and daily rate.

You can change:
• Schedule dates and times to reflect priority

changes
• Schedule processing days to lengthen or shorten

the schedule
• Schedule daily rate to increase or decrease your

daily production
• Schedule total quantity to increase or decrease

your total production. This implies a change in
processing days and daily rate.

Consideration
To deal with permanent changes in demand or capacity, you should change line or
assembly and line attributes.
For example, you could change your line start and stop times or change the hourly
production rate for that assembly.
Changes in this type of setup information are not automatically reflected in
existing schedules.
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Changing DatesChanging Dates

• You can reschedule your repetitive production
using the Repetitive Schedules window.

• You can change any of the four date and time sets
    to reflect changes in your production schedule,

and
    the other dates are calculated automatically.
• To change dates for assemblies without routings

on a routing-based line, you must provide either
the first unit start date and the first unit completion
date or the last unit start date and the last unit
completion date.

• You can reschedule your repetitive production
using the Repetitive Schedules window.

• You can change any of the four date and time sets
    to reflect changes in your production schedule,

and
    the other dates are calculated automatically.
• To change dates for assemblies without routings

on a routing-based line, you must provide either
the first unit start date and the first unit completion
date or the last unit start date and the last unit
completion date.

Example
Suppose you have to meet customer demand by December 15, or sooner if
possible.
You originally backward-scheduled your schedule using the December 15 date as
your last unit completion date. Your calculated first unit start date was December
1. Today is November 25, and you are ready to start your production on this
schedule.
You can update the first unit start date of the schedule to November 25, and
inform the customer that the assemblies will be ready on the date that is calculated
as the new last unit completion date.
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Changing Processing DaysChanging Processing Days

• You can change your processing days to reflect a
lengthening or shortening of your schedule.

• The total quantity is automatically adjusted to be
the daily rate multiplied by the new processing
days.

• Repetitive schedule dates are recalculated around
whichever date you choose to reflect the change
in processing days.

• You can change your processing days to reflect a
lengthening or shortening of your schedule.

• The total quantity is automatically adjusted to be
the daily rate multiplied by the new processing
days.

• Repetitive schedule dates are recalculated around
whichever date you choose to reflect the change
in processing days.

Example (continued)
Assuming the same scenario as in the previous example, suppose the schedule
was defined to run for 10 processing days with a daily rate of 1,500 units, for a
total quantity of 15,000 units. Now you get another order for 1,500 units of the
same assembly, due on December 31.
If the line on which your current schedule has adequate capacity to keep
producing the assembly past the completion date of the first schedule, you can
increase the processing days on the schedule to 20. The new total quantity is
calculated as 20 * 1,500 = 30,000 units, which will meet the total demand.
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Changing the Daily RateChanging the Daily Rate

• To change the quantity of the assembly produced
on your line daily, you can change the daily rate of
your schedule.

• A change in the daily rate results in the
recalculation of the total quantity of the schedule
and the adjustment of the schedule requirements.

• To change the quantity of the assembly produced
on your line daily, you can change the daily rate of
your schedule.

• A change in the daily rate results in the
recalculation of the total quantity of the schedule
and the adjustment of the schedule requirements.

Example (continued)
Suppose that instead of the new demand being due two weeks after the original
demand, it is due at the same time.
The production line is currently working only on the original schedule, and it is
idle for half of its production hours.
You can define the schedule to run at a rate of 3,000 units daily to meet the
demand of 30,000 assemblies in 10 processing days.
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Changing the Total QuantityChanging the Total Quantity

• Changing the total schedule quantity results in a
change in processing days by default.

• You can change the daily rate directly if you also
want to change the quantity produced per day.

• Changing the total schedule quantity results in a
change in processing days by default.

• You can change the daily rate directly if you also
want to change the quantity produced per day.

Note
Since Oracle Planning does not consider existing schedules in its netting
calculations, it does not recommend rescheduling changes for repetitive
schedules.
You cannot manually change individual operation dates for repetitive schedules.
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Review QuestionReview Question

You must provide either the first unit start and
completion dates or the last unit start and completion
dates when changing dates for assemblies without
routings on a routing-based line.
•  True
•  False

You must provide either the first unit start and
completion dates or the last unit start and completion
dates when changing dates for assemblies without
routings on a routing-based line.
•  True
•  False
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Answer to Review QuestionAnswer to Review Question

You must provide either the first unit start and
completion dates or the last unit start and completion
dates when changing dates for assemblies without
routings on a routing-based line.
•  True
•  False

You must provide either the first unit start and
completion dates or the last unit start and completion
dates when changing dates for assemblies without
routings on a routing-based line.
•  True
•  False
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Lesson 7: Sequencing a Repetitive
Production

Lesson 7: Sequencing a Repetitive
Production

• Lesson 1: Overview
• Lesson 2: Concepts in repetitive line scheduling
• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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Sequencing Your Production
Meaningfully

Sequencing Your Production
Meaningfully

You can plan your repetitive production to meet your
goals.
•  You can maximize efficiency by sequencing your
    production to cut down on setup and teardown
    costs.
•  You can sequence your production to maintain the
    right product mix in inventory.

You can plan your repetitive production to meet your
goals.
•  You can maximize efficiency by sequencing your
    production to cut down on setup and teardown
    costs.
•  You can sequence your production to maintain the
    right product mix in inventory.

Options
• You can run several assemblies on the same line.
• You can sequence the schedules for the different assemblies on the line by date

and time.
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Suppose you want to make vanilla ice cream,
chocolate chip ice cream, and chocolate chocolate
chip ice cream on the same line at the same speed.
The ice cream line runs from 8 a.m. to 5 p.m. every
day. You want to maintain equal amounts of each in
inventory.

Suppose you want to make vanilla ice cream,
chocolate chip ice cream, and chocolate chocolate
chip ice cream on the same line at the same speed.
The ice cream line runs from 8 a.m. to 5 p.m. every
day. You want to maintain equal amounts of each in
inventory.

Sequencing of Repetitive Production
• You should define the ice cream flavors as different assemblies and associate

them with your ice cream production line.
• Sequence them by date and time from the simplest, vanilla, to the most

complex, chocolate chocolate chip.
• Define the vanilla schedule to start at 8 a.m., the chocolate chip schedule to start

at 11 a.m., and the chocolate chocolate chip schedule to start at 2 p.m.
• Consideration
• The schedules in the example above can run on the same days for several
processing days because they produce different assemblies. The overlap rule does
not apply in this case.



Copyright © Oracle Corporation, 2000. All rights reserved.

Scheduling Repetitive Production
Chapter 6 - Page 55

Repetitive Line Report

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Repetitive Line ReportRepetitive Line Report

You can use the repetitive line report to prioritize the
schedules on a given line. You can view:
•  All schedules defined on a line for any assemblies
    that you build on this line
•  The date and quantity information of  the schedules
    and prioritize your production accordingly
•  Any mass-loaded schedules that reflect the newest
    production requirement information here.

You can use the repetitive line report to prioritize the
schedules on a given line. You can view:
•  All schedules defined on a line for any assemblies
    that you build on this line
•  The date and quantity information of  the schedules
    and prioritize your production accordingly
•  Any mass-loaded schedules that reflect the newest
    production requirement information here.

(N) WIP > Report > Run WIP Reports (Repetitive Line Report)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Reports and Processes > Work in Process Reports >
Repetitive Line Report
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Making ChangesMaking Changes

• You can use the Repetitive Schedules window to
make necessary changes, such as moving a
schedule start date forward or backward.

• You can use past start dates to signify high
priority.

     (N) WIP > Repetitive > Repetitive Schedules

• You can use the Repetitive Schedules window to
make necessary changes, such as moving a
schedule start date forward or backward.

• You can use past start dates to signify high
priority.

     (N) WIP > Repetitive > Repetitive Schedules

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Creating Repetitive Schedules >
Overview of Building Repetitive Schedules
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Using Other Prioritizing ApplicationsUsing Other Prioritizing Applications

You can use the Job and Schedule Interface to load
prioritized schedules from a source.
1 Load the Job and Interface table from other

applications.
2 Move the schedules into WIP using Import Jobs

and Schedules window.
3 Adjust the schedules’ statuses in the Repetitive

Schedules window.

You can use the Job and Schedule Interface to load
prioritized schedules from a source.
1 Load the Job and Interface table from other

applications.
2 Move the schedules into WIP using Import Jobs

and Schedules window.
3 Adjust the schedules’ statuses in the Repetitive

Schedules window.
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Lesson 8: SummaryLesson 8: Summary
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• Lesson 3: Combined assembly and line attributes
• Lesson 4: Production lines in repetitive production
• Lesson 5: Scheduling repetitive schedules
• Lesson 6: Rescheduling repetitive schedules
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• Lesson 8: Summary
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• Lesson 7: Sequencing a repetitive production
• Lesson 8: Summary
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SummarySummary

• You can model your repetitive environment
using line attributes, assembly and line
attributes, and schedule attributes, all of which
are used in repetitive line scheduling.

• The line start and stop times define repetitive
resource shifts.

• You can use repetitive line scheduling when you
define repetitive schedules manually and when
you mass load them based on suggestions from
Oracle Planning or other sources.

• You can model your repetitive environment
using line attributes, assembly and line
attributes, and schedule attributes, all of which
are used in repetitive line scheduling.

• The line start and stop times define repetitive
resource shifts.

• You can use repetitive line scheduling when you
define repetitive schedules manually and when
you mass load them based on suggestions from
Oracle Planning or other sources.
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Summary (continued)Summary (continued)

• You can reschedule a repetitive schedule by
changing quantities or dates in the Repetitive
Schedules window.

• You can sequence repetitive production by using
the Repetitive Line Report or outside sequencing
applications.

• You can reschedule a repetitive schedule by
changing quantities or dates in the Repetitive
Schedules window.

• You can sequence repetitive production by using
the Repetitive Line Report or outside sequencing
applications.
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Practice 1 OverviewPractice 1 Overview

Describing repetitive productionDescribing repetitive production

Practice 1
1. Why are attributes, such as alternate bill and routing, accounting class, hourly

production rate, and completion location, determined at the assembly/line
level, rather than at the individual schedule level? Also, why is the hourly
production rate not determined at the line level?

2. Under what circumstances would you want to use option 1 for simulating
repetitive shifts (that is, defining one schedule per shift each day)? Under
what circumstances would you want to use option 2 (that is, defining different
lines)?
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Practice 1 SolutionPractice 1 Solution
Describing repetitive productionDescribing repetitive production

Practice 1
1. Why are attributes, such as alternate bill and routing, accounting class, hourly

production rate, and completion location, determined at the assembly/line
level, rather than at the individual schedule level? Also, why is the hourly
production rate not determined at the line level?
It is characteristic of repetitive manufacturing that these types of
attributes are the same for many repetitive schedules. Defining these
attributes at the assembly/line level makes defining schedules easier and
faster.
Hourly rate is not determined at the line level because different
assemblies may run down the same line at different speeds.

2. Under what circumstances would you want to use option 1 for simulating
repetitive shifts (that is, defining one schedule per shift each day)? Under
what circumstances would you want to use option 2 (that is, defining different
lines)?
Option 1 has the disadvantage that you have to define many schedules. If
you use the mass load functionality, this would not be a big problem.
You would also want to use option 1 if you have an obvious need to do
flow charging - for example, if your first shift is likely to start some
assemblies that would be completed by the next shift. In that case, you
have to run on the same line in order to complete the assemblies in the
second shift.
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Practice 1 Solution (continued)
Option 2 would work only if you do not need to do flow charging - for
example, if you can be sure that all transactions pertaining to a particular
assembly will be completed before the next shift starts. If you have short
lead times and sufficiently long breaks between shifts, this would be a
viable option.
Option 2 also separates the costing reporting of the shifts, which may or
may not be desirable for your business.
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Practice 2 OverviewPractice 2 Overview

Instructions
You are a production manager at Vision. You want to
build 12,000 Envoy base assemblies repetitively on
line EnvBase1 in 12 days. There are no base
assemblies in inventory.

Instructions
You are a production manager at Vision. You want to
build 12,000 Envoy base assemblies repetitively on
line EnvBase1 in 12 days. There are no base
assemblies in inventory.

Practice 2
1. What are the original daily rate, processing days, and total quantity of the

schedule?
Suppose that on your second day of production, your customer inquiries
whether it would be possible to move shipment up by two days. You are in
your second day of production, so this means that the customer needs the
completed assemblies in another 8 days.
How would you update the schedule to reflect the new requirements?

2. What special considerations are warranted due to the fact that production has
started? Under what circumstances would you not be able to meet the new
demand?

3. Aside from updating the original schedule, what other possibilities might
Vision consider?
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Practice 2 SolutionPractice 2 Solution

Instructions
You are a production manager at Vision. You want to
build 12,000 Envoy base assemblies repetitively on
line EnvBase1 in 12 days. There are no base
assemblies in inventory.

Instructions
You are a production manager at Vision. You want to
build 12,000 Envoy base assemblies repetitively on
line EnvBase1 in 12 days. There are no base
assemblies in inventory.

Practice 2
1. What are the original daily rate, processing days, and total quantity of the

schedule?
Daily rate = 1,000; processing days = 12; total quantity = 12,000
Suppose that on your second day of production, your customer inquiries
whether it would be possible to move shipment up by two days. You are in
your second day of production, so this means that the customer needs the
completed assemblies in another 8 days.
How would you update the schedule to reflect the new requirements?
The new processing days is 10, since you are in the second day of
production and have 8 days left. To deliver 12,000 units in 10 days,
update the daily rate to 1,200.

2. What special considerations are warranted due to the fact that production has
started? Under what circumstances would you not be able to meet the new
demand?
The fact that you started the schedule at a lower rate means that you are
behind in your schedule. You have to find a way to catch up to your
schedule if you want to make your deadline. In effect, you  probably want
to run your schedule at a daily rate higher than 1,200 to catch up.
You would not be able to meet the new demand if you were already
operating at 100% capacity.

3. Aside from updating the original schedule, what other possibilities might
Vision consider?
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Practice 2 Solution (continued)
You could define a schedule to build the same assembly on another line at
a rate of 200 a day for 10 days, and shorten your original schedule to 10
days. Your total quantity would add up to 12,000.
You could run production day 2 out at the old daily rate of 1,000, shorten
the schedule to 2 processing days, and define a new schedule with a rate of
1,250 for the remaining 8 days. This would formalize the need to build
more than 1,200 units a day to catch up.
Note that 1,000 is your daily line capacity, you would have to increase the
line speed or add production hours to be able to produce more assemblies
per day.
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Chapter 7
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Work In Process Transactions - Issues Release 11i

Work In Process
Transactions - Issues

Release 11i

Work In Process
Transactions - Issues

Release 11i
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ObjectivesObjectives

After this component, you should be able to:
• Issue components from inventory to work in

process
• Issue negative requirements to a job or schedule
• Manage rejected material in inventory
• Manage rejected components in work in process
• Return components to inventory
• Replenish supply subinventories and locators

After this component, you should be able to:
• Issue components from inventory to work in

process
• Issue negative requirements to a job or schedule
• Manage rejected material in inventory
• Manage rejected components in work in process
• Return components to inventory
• Replenish supply subinventories and locators
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AgendaAgenda

• WIP transactions overview
• Issuing and returning material
• Managing rejected material
• Costing overview
• Viewing and reporting

• WIP transactions overview
• Issuing and returning material
• Managing rejected material
• Costing overview
• Viewing and reporting
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Work In Process Transactions
Overview

Work In Process Transactions
Overview
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OverviewOverview

InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

With Oracle WIP transactions, you can:
• Track and report your inventory accurately.
• Maintain accurate supply and demand information.
• Track activity costs.
• Value work in process.

Transactions are driven by actions.
Examples

• Picking material from a picklist drives a material issue transaction in Oracle Work
in Process.

• Completing an assembly at an operation drives a move and possibly a backflush
transaction.

• Replenishing your subinventories drives a subinventory transfer transaction.
• Failing a test at an operation drives a scrap transaction.
• Shipping an assembly to an outside vendor drives a move transaction.
• Finishing an assembly drives a completion into inventory and possibly a backflush

transaction.
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Work in ProcessWork in Process

OverviewOverview
Issuing Components in Work in ProcessIssuing Components in Work in Process

ReplenishReplenish

PushPush
issueissue

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory

Floor stockFloor stock
inventoryinventory

BulkBulk
SupplierSupplier
(outside(outside

processing)processing)
MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

Definitions
• Issue transaction is a material transaction to issue component items from

inventory to work in process.
• Replenishment transaction is a material transaction to stage components in

advance of backflushing.
• Return transaction is a material transaction to return components from WIP

back to inventory. Return transactions increase WIP material requirements,
inventory balances, and valuation, and decrease WIP valuation.

Distinguishing Between Types of Material Transactions
• Material issue transactions fulfill WIP material requirements on jobs or

schedules.
• Issue transactions reduce inventory balances and valuation.
• Issue transactions incur WIP costs and increase WIP valuation.
• You can use supply types to control how components are supplied to fulfill

material requirements.
• Push issue transaction is a material transaction to issue component items from

inventory to work in process before you manufacture the assembly.
• Backflush transaction is a material transaction that automatically issues

component items into work in process from inventory when you move or
complete the assembly. A backflush transaction is also known as post–deduct or
pull.
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OverviewOverview

Raw materialRaw material
inventoryinventory

InventoryInventory

MRBMRB
subinventorysubinventory

Issue to scrap accountIssue to scrap account

Scrap accountScrap account

TransferTransfer

DockDock

SupplierSupplier
warehousewarehouse

Return toReturn to
suppliersupplier

SupplierSupplier

 Managing Rejected Material in Inventory Managing Rejected Material in Inventory

Return to Supplier
Return to supplier is a transaction that allows you to return to the supplier items from a
fully or partially received purchase order and receive credit for them.
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OverviewOverview

Managing Rejected Components in WIPManaging Rejected Components in WIPManaging Rejected Components in WIP

Raw materialRaw material
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory

ReturnReturn
rejectedrejected

componentscomponents

Issue moreIssue more
componentscomponents

Component Yield
• Component yield is the amount of a component you require to build plus the

amount of the component you lose or waste while building an assembly.
• A yield factor of 100% indicates no loss in the manufacturing process.
• A yield factor of less than 100% indicates that less than 100% of the components

you issue survive the build process. Thus the component usage quantity
increases.

• The cost rollup optionally includes the effect of component yield in the assembly
costs.
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

OracleOracle
WIPWIP

OracleOracle
InventoryInventory

Complete finishedComplete finished
and rejectedand rejected
assembliesassemblies

IssueIssue
materialmaterial

Return finishedReturn finished
assembliesassemblies

Return rejectedReturn rejected
componentscomponents
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

Issuing MaterialIssuing Material

InventoryInventory

Raw materialRaw material
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

IssueIssue
materialmaterial

ReturnReturn
materialmaterial

Issuing Material
An issue transaction is a material transaction to issue component items from inventory
to work in process.

• Material issue transactions fulfill WIP material requirements on jobs or
schedules.

• Issue transactions reduce inventory balances and valuation.
• Issue transactions incur WIP costs and increase WIP valuation.
• You can use supply types to control how components are supplied to fulfill

material requirements.
• A push issue transaction is a material transaction to issue component items from

inventory to work in process before you manufacture the assembly.
• A backflush transaction is a material transaction that automatically issues

component items into work in process from inventory when you move or
complete the assembly. A backflush transaction is also known as post-deduct or
pull.
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

Completing Finished AssembliesCompleting Finished Assemblies

CompleteComplete

Finished goodsFinished goods
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

Completing Finished Assemblies
• Assembly completion transaction is a material transaction in which you receive

assemblies into inventory from a job or repetitive assembly/line upon completion
of the manufacture of the assembly.

• The finished assemblies are received into inventory, either to be used as
subassemblies or to be shipped as finished goods.

• All assembly pull material attached on the bill is backflushed.
• The quantity in the To Move step of the last operation is decreased, if there is a

routing.
• The Quantity Complete on the job or repetitive schedule is increased.
• If the quantity completed equals the total quantity for a schedule, and there are

other active schedules following it on the assembly/line, the schedule’s status is
changed to Complete—No Charges. If the schedule is the last active schedule, its
status is changed to Complete.

• If the quantity completed equals the start quantity for a discrete job, the job status
is changed to Complete.
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

Returning Finished AssembliesReturning Finished Assemblies

ReturnReturn

Finished goodsFinished goods
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

Returning Finished Assemblies
• Returning assemblies means moving them back from inventory to work in

process.
• All backflush transactions that took place during the corresponding completion

transaction are reversed.
• The Quantity Complete is reduced.
• The quantity in the To Move step of the last operation in the routing is increased

(assuming there is a routing).
• A discrete job’s status is changed back to Released.
• Repetitive schedule statuses are only changed back to Released from Complete,

never from Complete—No Charges.
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

MRBMRB
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory

ReturnReturn
rejectedrejected

componentscomponents

Returning Rejected ComponentsReturning Rejected Components

Returning Rejected Components
• You can return rejected components to a nonnettable MRB subinventory to

possibly recover them later.
• You can use the WIP Material Transactions window to return rejected

components from WIP to inventory.
• You should make sure the components are returned to a nonnettable subinventory

so they are not considered as supply by the planning processes.
• You can evaluate whether the components can be recovered.
• If the raw material subinventory is close to your shop floor, you can directly

exchange a rejected component in WIP with a good component in inventory. You
should isolate the rejected component in the raw material subinventory and then
dispose of it as you would any other rejected component in inventory.

• After returning the components to the MRB subinventory, you can also perform
an inventory transaction to issue the failed components to a scrap account.
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WIP Integration to Oracle InventoryWIP Integration to Oracle Inventory

WIP material transactions use Oracle Inventory
controls.
• Item attribute
• Subinventories and locators
• Lot control
• Serial number control
• Revisions

WIP material transactions use Oracle Inventory
controls.
• Item attribute
• Subinventories and locators
• Lot control
• Serial number control
• Revisions

Item Attribute
The item being transacted must be transactable in Oracle Inventory.

Subinventories and Locators
You can use the subinventories and locators and any transaction default values defined in
Oracle Inventory.

Lot Control
• Oracle Work in Process supports lot control for all material transactions.
• You can use the same entry window for issues, backflushes, and completions.
• You can enter lot numbers for items under lot control when performing issues,

returns, and completions.
• You can use the lot number assigned upon receipt of an item into inventory when

issuing that item to work in process.
Serial Number Control

• Oracle Work in Process supports serial number control for all material transactions.
• You can use the same entry window for issues, backflushes, and completions.
• When performing issues, returns, and completions, you can enter serial numbers for

items under serial number control.
• When issuing that item to work in process, you can use the predefined or dynamically

created serial numbers assigned upon receipt of an item into inventory.
Revisions

• You can issue, return, or complete components under revision quantity control.
• Transaction quantities are tracked by revision.
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WIP Integration to Oracle Cost
Management

WIP Integration to Oracle Cost
Management

CostCost
informationinformation

Transaction costsTransaction costs

Oracle CostOracle Cost
ManagementManagement

OracleOracle
WIPWIP

Costing Transactions
• Issue and return transactions affect your work in process and inventory

valuations.
• Issue transactions increase your work in process valuation and decrease your

inventory valuation.
• Return transactions increase your inventory valuation and decrease your work in

process valuation.
• Move transactions can automatically launch backflush transactions and charge

resources and overheads.
• Backflush material transactions increase your work in process valuation and

decrease you inventory valuation.
• Resource charges increase your work in process valuation.
• Overhead charges increase your work in process valuation.
• You can cost resource transactions at either standard or actual.
• Completion transactions affect your work in process and inventory valuations.
• Completion transactions decrease your work in process valuation and increase

your inventory valuation.
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OracleOracle
PlanningPlanning

Planned jobsPlanned jobs
SchedulesSchedules

Open jobsOpen jobs
SchedulesSchedules

Repetitive assemblyRepetitive assembly
and line informationand line informationOracleOracle

WIPWIP

Requirements
The planning process inflates the demand for a component with a yield factor of less
than 1 to compensate for the expected component rejection in WIP.
New Component Usage Quantity = Component Usage Quantity / Yield Factor
The planning process creates additional demand for an item to compensate for the
expected assembly shrinkage loss and maintain supply.
Supply Quantity = (MRP Net Quantity - Quantity Completed - Quantity
Scrapped) * (1 - Shrinkage Rate) 
Net Requirement = Original Demand - Supply Quantity From the Job
Shrinkage Demand = Demand * 1 / (1 - Shrinkage Rate)
Total Demand = Manual (Original) Demand + Discrete Job Shrinkage + Planned
Order Shrinkage
Discrete Job Shrinkage = MRP Net Quantity - Supply Quantity from the Job
Planned Order Shrinkage = Shrinkage Demand - Net Requirement
Total Supply = Discrete Job Quantity + Planned Order Quantity
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Product structureProduct structure
InformationInformation

Routing informationRouting information
Resource informationResource information

OracleOracle
BOMBOM

OracleOracle
WIPWIP
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OracleOracle
EngineeringEngineering
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Quality dataQuality data

OracleOracle
WIPWIP

OracleOracle
QualityQuality

WIP Integration to Oracle Quality
• Collecting transactional data when doing move transactions.
• Writing context information for reference collection elements to the quality data

repository.
Collection Elements

Before you can collect data with Oracle Quality, you must first set up your data
collection structure. The basic building block of this structure is the collection element,
which is used in both the specification and the collection plan.
Collection elements define the characteristics of the product or process for which you
are collecting, analyzing, and reporting data. For each collection element, you can
specify a list of acceptable values or specification limits, such as target value and upper
and lower limits.

Specifications
Specifications describe the requirements of a product. You can define specification
limits for key characteristics of the product that you produce.

Collection Plans
Collection plans are similar to test or inspection plans. Collection plans specify the
collection elements to use in collecting data. Collection plans specify when and how to
collect the data as well as the actions to take based on the data collected.
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Work order-Work order-
lessless

CompletionsCompletions

OracleOracle
WIPWIP

OracleOracle
Flow ManufacturingFlow Manufacturing

Flow Manufacturing is a manufacturing approach with the objective of building the
highest quality product in the shortest possible time at the lowest cost.
Production is recorded with the Work Order-less Completion transaction against flow
schedules created with the Line Scheduling Workbench. Completions can be either
unscheduled or scheduled against a flow schedule. The system backflushes all
components and performs resource and overhead transactions upon recording
completion of the finished product. Additionally, Oracle Flow Manufacturing allows
assembly completions to be recorded without having to create work order, a job or
repetitive schedule, or a flow schedule.
Work order-less completions do the following:
• Backflush pull and push components
• Charge resources and overhead based on the flow routing
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OracleOracle
WIPWIP

OracleOracle
ProjectProject

ManufacturingManufacturing

Project/taskProject/task
referencesreferences

Project WIP Jobs
You can create WIP jobs (work orders) with project/task references. Both standard and
non-standard WIP jobs are supported. Standard Project WIP jobs can be created
automatically and released from the Planner Workbench.
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InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap
assemblies

Scrap
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources

Definitions
• Issue transaction is a material transaction to issue component items from

inventory to work in process.
• Replenishment transaction is a material transaction to stage components in

advance of backflushing.
• Return transaction is a material transaction to return components from WIP

back to inventory. Return transactions increase WIP material requirements,
inventory balances, and valuation, and decrease WIP valuation.

Distinguishing Between Types of Material Transactions
• Material issue transactions fulfill WIP material requirements on jobs or

schedules.
• Issue transactions reduce inventory balances and valuation.
• Issue transactions incur WIP costs and increase WIP valuation.
• You can use supply types to control how components are supplied to fulfill

material requirements.
• Push issue transaction is a material transaction to issue component items from

inventory to work in process before you manufacture the assembly.
• Backflush transaction is a material transaction that automatically issues

component items into work in process from inventory when you move or
complete the assembly. A backflush transaction is also known as post-deduct or
pull.
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ReplenishReplenish

PushPush
IssueIssue

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory

Floor stockFloor stock
inventoryinventory

BulkBulk
SupplierSupplier
(outside(outside

processing)processing)
MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

Definitions (continued)
WIP Material Requirements

WIP material requirements describe the items and quantities needed to build an
assembly on a discrete job or repetitive schedule. Requirements in discrete jobs
or repetitive schedules come from component items defined on a bill of materials.
WIP issue transactions fulfill material requirements.

Distinguishing Between Types of Material Requirements
• Open requirements are WIP material requirements not yet transacted to a

discrete job or repetitive schedule. They equate to the component quantity
required less any quantity issued.

• Shortage is an open requirement with no inventory in the organization to cover
the requirement.

• Negative requirements are requirements that are supplied rather than consumed
by a discrete job or repetitive schedule, i.e. byproducts. You can define negative
requirements on your bills of material to support byproducts or other reusable
components. Negative material transactions fulfill negative material
requirements.

– You can define negative requirements for a nonstandard job used to
disassemble a Sentinel assembly, for example.

– Oracle Planning sees negative requirements as supply and plans requirements
accordingly.
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Based on bill

Name Description
Oracle Work in Process creates component
requirements with supply types equal to those on the
bill of material.

Assembly pull
Oracle Work in Process issues assembly pull
components to a job or schedule when you complete
assemblies into inventory.

Bulk Oracle Work in Process does not automatically
transact bulk components to the job or schedule.

Operation pull
Oracle Work in Process issues operation pull
components to a job or schedule when you complete
the operation in which the components are consumed.

Push
You issue push components to a job or schedule using
the WIP Material Transactions window in advance of
consumption.

Supplier A vendor supplies components directly to work in
process.

You can control how components are supplied to fulfill material requirements with
supply types. You can define component sourcing attributes at the item level and
override them in the bill of materials or in Oracle Work in Process.

Setting the Supply Type in the Item Master or Bill of Materials
• If an item is usually pushed from subinventory Raw Material Inventory, for

example, you can set the supply type to Push and the supply subinventory to Raw
Material Inventory in the item master.

• However, if an item is staged in subinventory Floor Stock on a production line,
and backflushing is done at assembly completion, you can set the supply type to
Assembly Pull and the supply subinventory to Floor Stock in the bill of materials
for the assemblies being built on that line.

• You can override the item master supply type when you assign the component to
a bill of materials.

• You can override the item master and the bill of materials supply type for all
components the bill in the Material Requirements window for discrete jobs and
repetitive schedules.

Setting the Supply Subinventory/Locator in the Item Master or Bill of
Materials

• You can specify the default WIP supply subinventory and locator in the item
master and optionally override those defaults in the bill of materials or in Work in
Process.

• You can also specify the Default Pull Supply Subinventory parameter and the
Default Pull Supply Locator parameter in the Work in Process Parameters
window.
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issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

You should consider how you want to push issue your material.
Business Needs

You need to be able to do the following things:
• Enter a single transaction to record the picking of all push components for the

entire job quantity or for a partial quantity
• Enter a single transaction to record the picking of all push components for a day

or several days of production on a repetitive schedule
• Enter a single transaction to record the picking of all push components for a

certain location on the shop floor
• Push issue components that are not on the original WIP bill—that is, that do not

fulfill a material requirement
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Material Requirements

100

Op Seq Qty

Operation Pull

Supply Type

Sentinel Base Assembly

Component

100Operation PullPCMCIA modem/fax
Motherboard
Hard drive—340 MB
3.5" disk drive
5.25" disk drive
Video card
Keyboard mouse card
SIMM—16 MB internal module
Power cord

100Operation Pull
100Operation Pull
100Operation Pull
100Operation Pull
100Operation Pull
100Operation Pull
100Operation Pull
200Assembly Pull

20
20
20
20
20
20
20
20
20
20

Dept

FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy

Example
Job Sentinel-F1 is defined to build 100 Sentinel Financial assemblies. The slide shows
the WIP bill of materials for the Sentinel Financial. The following two slides show
examples of material transactions that can be performed on job Sentinel-F1.
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Material Requirements

Op Seq QtySupply TypeComponentDept

Sound Board
Sentinel cover assembly
Standard screws
Sentinel documentation
Monitor—15" Super VGA
Packing material
External 101-key keyboard
O/S documentation set
UNIX/Windows 1-user pack
Motherboard—486DX2 w/PCI

100Operation Pull
100Operation Pull
600Operation Pull
100Operation Pull
100Assembly Pull
100Assembly Pull
100Assembly Pull
100Push
100Push
100Operation Pull

20
20
20
20
20
20
20
20
20
20

FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy
FinAssy

Example
Job Sentinel-F1 is defined to build 100 Sentinel Financial assemblies. The slide shows
the WIP bill of materials for the Sentinel Financial. The following two slides show
examples of material transactions that can be performed on job Sentinel-F1.
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Examples of Material Transactions

All material N/A

Op
Component Seq Dept Quantity
O/S doc set 20 FinAssy 100
UNIX user pack 20 FinAssy 100

Assembly
quantity Quantity = 5

Op
Component Seq Dept Quantity
O/S doc set 20 FinAssy 5
UNIX user pack 20 FinAssy 5

Specific
component

Issue 3 power
cords at
operation 10

N/A
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Examples of Material Transactions

Department Department =
FinAssy

Op
Component Seq Dept Quantity
O/S doc set 20 FinAssy 100
UNIX user pack 20 FinAssy 100

Operation Operation =
10 N/A

Operation Operation =
20

Op
Component Seq Dept Quantity
O/S doc set 20 FinAssy 100
UNIX user pack 20 FinAssy 100
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Use the WIP Material Transactions window to enter:
• Issue components from inventory to jobs and

repetitive schedules
• Return issued components from jobs and

schedules to inventory
• Replenish to stage components in advance of

backflushing

Use the WIP Material Transactions window to enter:
• Issue components from inventory to jobs and

repetitive schedules
• Return issued components from jobs and

schedules to inventory
• Replenish to stage components in advance of

backflushing

(N) Material Transactions—>WIP Material Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Material Control

../ > Component Issues and Returns

../ > Repetitive Component Issues and Returns

../ > WIP Material Transaction Types

../ > Issuing and Returning Specific Components

../ > Issuing and Returning All Push Components
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This demonstration covers issuing push components.This demonstration covers issuing push components.
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issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

You can initiate a backflush from several sources. You do not need to do an explicit
issue transaction if you use backflushing. You can automatically launch backflush
transactions when moving or completing assemblies.

Backflush Sources
• Move Transactions window
• Completion Transactions window
• Enter Receipts window in Oracle Purchasing (for outside processing)
• Oracle Inventory Material Transaction interface
• Open Move Transaction interface

Operation Pull
• Move transactions that complete an operation backflush all components with a

supply type of Operation Pull.
• The backflush occurs only at routing operations with a backflush type of Yes.

The backflush transaction backflushes all Operation Pull components at all
appropriate previous operations in the routing as well.

• Components with a supply type of Operation Pull defined for an operation with a
backflush type of No are backflushed after completing an operation with a
backflush type of Yes later in the routing.

Assembly Pull
WIP completion transactions backflush all components with a supply type of Assembly
Pull.
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Floor stockFloor stock
accountaccount SupplierSupplier
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issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

You can return both push and pull components to inventory, as needed. You can return
pull components with reverse backflushing.

Reasons to Return Material to Inventory
• You canceled the discrete job or repetitive schedule.
• You issued excess material that was not needed—for example, if your component

yield was better than expected.
• You need to correct issue transactions.
• You need to return a bad component for replacement.

Return Options
• Return all material.
• Return specific components.
• Return components from a specific department.
• Return an assembly quantity.
• Return components from a specific operation sequence.

Open Requirements
• Returning components increases the open requirements by reducing the quantity

issued to the job or schedule.
• The quantity of the subinventory is increased accordingly.
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ReplenishReplenish

Work in ProcessWork in Process
PushPush
issueissue

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory
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inventoryinventory
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SupplierSupplier
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MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

Oracle Manufacturing supports a variety of replenishment schemes. To decide how to
replenish, consider the following:

• The amount of floor space available for floor stock
• Frequency of replenishment
• Method of visual controls/physical Kanbans
• The physical characteristics of your components—for example, size, weight,

perishability
• Proximity of feeder lines to consuming lines
• The number of different jobs/repetitive assemblies in production concurrently
• Variability of your production rate
• Variability of your product mix
• Use of the Bulk supply type as an alternative

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Material Control > Supply Subinventory and Locator Replenishment

../ > Supply Subinventory and Locator Replenishment Options

../ > Replenishing Supply Subinventories and Locators

../ > Replenishing Higher Level Supply
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Why would you need to return material to inventory?Why would you need to return material to inventory?
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Why would you need to return material to inventory?

You might have overissued material, or you might
have scrapped assemblies along the way, thereby
eliminating the need for the total required quantity of
components.

Why would you need to return material to inventory?

You might have overissued material, or you might
have scrapped assemblies along the way, thereby
eliminating the need for the total required quantity of
components.
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Suppose you have a job with a negative requirement
on its bill. You included material cost in your cost
rollup, but you never returned the component to
inventory. How would this affect your costing
information for the job?

Suppose you have a job with a negative requirement
on its bill. You included material cost in your cost
rollup, but you never returned the component to
inventory. How would this affect your costing
information for the job?
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Suppose you have a job with a negative requirement
on its bill. You included material cost in your cost
rollup, but you never returned the component to
inventory. How would this affect your costing
information for the job?

Your job would show a negative variance.

Suppose you have a job with a negative requirement
on its bill. You included material cost in your cost
rollup, but you never returned the component to
inventory. How would this affect your costing
information for the job?

Your job would show a negative variance.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Work In Process Transactions Issues
Chapter 7 - Page 41

Practice 1-1 Overview

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 1-1 OverviewPractice 1-1 Overview

This practice covers issuing material to a job.This practice covers issuing material to a job.
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You must manually define a discrete job in the
Seattle organization to build 200 Sentinel Deluxe
assemblies recently ordered by a customer. After
releasing the job, you must ensure that the material
needed resides in inventory, and if it does, issue it to
the job.

You must manually define a discrete job in the
Seattle organization to build 200 Sentinel Deluxe
assemblies recently ordered by a customer. After
releasing the job, you must ensure that the material
needed resides in inventory, and if it does, issue it to
the job.

Practice 1-1
You must manually define a discrete job in the Seattle organization to build 200
Sentinel Deluxe assemblies recently ordered by a customer. After releasing the job, you
must ensure that the material needed resides in inventory, and if it does, issue it to the
job. You will also view your manufacturing activity using the Discrete Workstation.
1. Define a discrete job to satisfy the requirements described above. Assume that the
job must start today. Use the Discrete Jobs window to define the job.

• Assembly: Sentinel Deluxe AS18947
• Status: Released
• Quantity: 200
• Class: Discrete
• Start Date: Today’s date

2. Determine whether the required material is available in inventory. You can run a
pick list report or shortage report.
3. Issue all push material to the job. Use the WIP Material Transactions window to
issue push components to the job.

• Transaction Type: WIP Component Issue
• Transact: All Material

4. Ten of the power cords that you issued are defective. What should you do? You
should issue 10 more power cords. Use the WIP Material Transactions window.

• Transact: Specific Component
5. Go to the Discrete Workstation or Discrete Job form and view your job.
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Practice 1-1 Solution
Define a Discrete Job

Oracle WIP (N) Discrete—>Discrete Jobs
1. Navigate to the Discrete Jobs window and define a job using the following information:

• Assembly: Sentinel Deluxe AS18947
• Status: Released
• Start Quantity: 200

– Standard discrete jobs must have a start quantity greater than zero. When you enter
a start quantity for jobs with bills and routings, the component material
requirements, department schedules, resource load, and job start and end dates are
all determined automatically.

– For nonstandard jobs, if you enter a start quantity of 0 and specify a bill of material
reference, the corresponding bill is exploded but material requirements equal to
zero are created. To perform move and completion transactions for a nonstandard
job, the start quantity must be greater than zero.

• Class: Discrete
• Start Date: Today’s date

2. Enter the MRP net quantity.
– The MRP net quantity is the number of assemblies that MRP considers as supply

on the scheduled completion date.  For standard and nonstandard discrete jobs with
assemblies, the MRP net quantity is derived from the job start quantity. For
nonstandard discrete jobs without assemblies, the default is zero.

3. Save your work.
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Practice 1-1 Solution (continued)
Determining Availability of Required Material

Oracle WIP (N) Report—>Discrete Job Pick List Report
You can run the Discrete Job Pick List Report or the Discrete Job Shortage Report to
determine whether the required material is available in inventory.

• The Discrete Job Pick List Report lists open component requirements for jobs with
statuses of Unreleased, Released, Complete, and On Hold. You can use this report
when you pick material from stock to issue to discrete jobs. This report lists
component requirements in supply type order: push components first followed by
pull, bulk, and then vendor components. This report can be sorted by component,
date required, supply subinventory/locator, or WIP material transaction.

• If the report is sorted by component, requirements that are common across jobs are
consolidated. This can be particularly useful if you are replenishing backflush
subinventories that supply several jobs.
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Report Submission - Discrete Job Pick List Report
1. In the Submit Requests window, select Discrete Job Pick List Report in the Name
field.
Report Parameters
• Sort By (choose one of the following options):

• Component: Sort by component. Requirements are consolidated across jobs. Use
this option to help you replenish backflush subinventories that supply multiple
jobs. You can use the Subinventory Transfer form in Oracle Inventory to transfer
the consolidated quantity of each requirement from your warehouse to the
backflush subinventories that supply your jobs.

• Date required: Sort by requirement date.
• Supply subinventory, locator: Sort by supply subinventory and locator.
• WIP material transaction: Sort component requirements in WIP Material

Transaction order. The system lists components in the order presented in the WIP
Material Transactions window. This assists data entry when you use the pick list as
hard copy for issuing the components.

• Transactable Only: Select Yes or No to indicate whether to exclude discrete jobs with
statuses of Unreleased or On Hold.
• Jobs From/To: To restrict the report to a range of jobs, select a beginning and an
ending job.
• Start Dates From/To: To restrict the report to a date range, select a starting and an
ending date.
• Schedule Groups From/To: To restrict the report to a range of schedule groups, select
a beginning and an ending schedule group.
• Supply Type: Choose a supply type. The available options are Push, Pull, Bulk, and
Vendor.
• Supply Subinventory: Select the supply subinventory to include as available material
in the Discrete Job Pick List. If you do not enter a value, the system lists requirements
of any supply subinventory.
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Practice 1-1 Solution (continued)
Issuing Push Components

Oracle WIP (N) Material Transactions—>WIP Material Transactions
1. Use the WIP Material Transactions window to issue push components to the job.

• Transaction Type: WIP Component Issue
• Transact: All Material
Note: You may receive a Caution window with the message Quantity will drive

inventory negative, click OK.
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Practice 1-1 Solution (continued)
Issuing Documentation Sets

Oracle WIP (N) Material Transactions—>WIP Material Transactions
1. You should issue 10 more power cords, CM42047,  using the WIP Material
Transactions window.

• Transact: Specific Component
Note: You may receive a Caution window with the message Quantity will drive

inventory negative, click OK.
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Practice 1-1 Solution (continued)
Discrete Workstation

Oracle WIP (N) Discrete—>Discrete Workstation (B) Launch
1. Navigate to the Discrete Workstation Startup window and select Department:
ASSEMBLY and Resource: LBR-DTASSY.
2. Note your job in the immediate dispatch list.
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Rejected material
in Inventory

Rejected material
in Inventory

Rejected materialRejected material
Rejected

components in
Work in Process

Rejected
components in

Work in Process

Rejected
assemblies in

Work in Process

Rejected
assemblies in

Work in Process

You should review the following business considerations before you decide how to
implement Oracle Manufacturing to manage your rejected material.

Material Flow
• Keeping the good assemblies moving on the shop floor
• Recovering rejected material if possible

Anticipated Yield Loss
• Planning material loss
• Determining actual loss

Traceability
• Determining the causes for rejection
• Identifying responsibility

Transaction Volume
• A small number of rejections is handled differently than a large number of

rejections.
Cost Management

• High scrap costs represent opportunity for cost improvements.
• High-value items may need to be handled differently.
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Raw materialRaw material
inventoryinventory

InventoryInventory

MRBMRB
subinventorysubinventory

Issue to scrap accountIssue to scrap account

Scrap accountScrap account

TransferTransfer

DockDock

SupplierSupplier
warehousewarehouse

Return toReturn to
suppliersupplier

SupplierSupplier

Rejected Material in InventoryRejected Material in Inventory

Account Alias
Account alias is an easily recognized name or label representing an account charged on
miscellaneous transactions. Optionally you can view, report, and reserve against an
account alias.

Return to Supplier
Return to supplier is a transaction that allows you to return to the supplier items from
a fully or partially received purchase order and receive credit for them.
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Raw materialRaw material
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory

ReturnReturn
rejectedrejected

componentscomponents

Issue moreIssue more
componentscomponents

Rejected Components in WIPRejected Components in WIP

Component Yield
• Component yield is the amount of a component you require to build plus the

amount of the component you lose or waste while building an assembly.
• A yield factor of 100% indicates no loss in the manufacturing process.
• A yield factor of less than 100% indicates that less than 100% of the components

you issue survive the build process. Thus, the component usage quantity
increases.

• The cost rollup optionally includes the effect of component yield in the assembly
costs.

Account Alias
• Account alias is an easily recognized name or label representing an account

charged on miscellaneous transactions.
• Optionally you can view, report, and reserve against an account alias.
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Define transaction reasonsDefine transaction reasons
1

Option A
Subinventory

transfer

Option A
Subinventory

transfer

Option B
Miscellaneous

transaction

Option B
Miscellaneous

transaction
Option C

Account issue
Option C

Account issue

Define Reject
transaction type
Define Reject

transaction type

2

Define MRB subinventoryDefine MRB subinventory
3

Define Scrap accountDefine Scrap account

Transfer failed
components to

MRB

Transfer failed
components to

MRB

Perform Scrap
transaction
(to MRB)

Perform Scrap
transaction
(to MRB)

Issue failed
components to Scrap

account

Issue failed
components to Scrap

account

3

2

3 4

1 1

2

You can manage rejected material in inventory in several ways:
• Subinventory transfer
• Miscellaneous transaction
• Account issue
• Perform account alias issue
• Return to vendor
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Methods of Managing Rejected MaterialMethods of Managing Rejected Material

Define transaction reasonsDefine transaction reasons
1

Option D
Account

alias issue

Option D
Account

alias issue

Option E
Return to
vendor

Option E
Return to
vendor

Define scrap accountDefine scrap account

Issue failed
components to
account alias

Issue failed
components to
account alias

Return failed
components to

vendor

Return failed
components to

vendor

3 2

1

2

Define account aliasDefine account alias
3
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Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap unrecoverable
material

Scrap unrecoverable
material

TransferTransfer
rejectedrejected
materialmaterial
to MRBto MRB

Rework recoverableRework recoverable
materialsmaterials

InventoryInventory

Raw materialRaw material
inventoryinventory

MRBMRB
subinventorysubinventory

You can transfer rejected material to a nonnettable Material Review Board (MBR)
subinventory to possibly recover it later.

Performing a Transfer Between Subinventories
• After creating a nonnettable subinventory using the Subinventories window, you

can transfer the rejected material from the current subinventory to the MRB
subinventory.

• You can evaluate whether the rejected material can be recovered or whether it
should be scrapped.

Benefits of Option A
• Isolates questionable material
• Leaves the option to recover the material
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Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap unrecoverable
material

Scrap unrecoverable
material

TransferTransfer
rejectedrejected
materialmaterial
to MRBto MRB

Rework recoverableRework recoverable
materialsmaterials

InventoryInventory

Raw materialRaw material
inventoryinventory

MRBMRB
subinventorysubinventory

You can perform a user-defined reject transaction to transfer rejected material to a
nonnettable Material Review Board subinventory.

Performing a Miscellaneous Transaction
• You can define a Reject transaction type as a transfer between subinventories

transaction.
• Instead of using the Subinventory Transfer window, you can use the

Miscellaneous Transaction window to perform a user-defined transaction.
• You can evaluate whether the rejected material can be recovered or whether it

should be thrown away.
Benefits of Option B

• Isolates questionable material
• Leaves the option to recover the material
• Identifies transactions using the appropriate terminology
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Issuing Rejected Material to a Scrap AccountIssuing Rejected Material to a Scrap Account

Raw materialRaw material
inventoryinventory

InventoryInventory

MRBMRB
subinventorysubinventory

Scrap accountScrap account

Issue to scrap accountIssue to scrap account

Performing a Miscellaneous Transaction
• You can define Scrap accounts to which to issue rejected material.
• You can issue the rejected material from the MRB subinventory or from stores

after determining it was not recoverable.
Benefits of Option C

• Charges scrap costs to appropriate accounts
• Reduces inventory valuation and balances
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Issuing Rejected Material to an Account AliasIssuing Rejected Material to an Account Alias

Raw materialRaw material
inventoryinventory

InventoryInventory

MRBMRB
subinventorysubinventory

Scrap accountScrap account

Issue to scrap accountIssue to scrap account

Performing a Miscellaneous Transaction
• You can define account aliases to which to issue rejected material.
• You can issue the rejected material from the MRB subinventory or from raw

material inventory after determining it was not recoverable.
Benefits of Option D

• Charges scrap costs to appropriate accounts
• Reduces inventory valuation and balances
• No need to remember an account number to perform the transaction
• Runs cost reports by account alias
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Raw materialRaw material
inventoryinventory

InventoryInventory

DockDock

SupplierSupplier
warehousewarehouse

SupplierSupplier

Ship replacementShip replacement
merchandisemerchandise

AccountsAccounts
payablepayable

Send creditSend credit
invoiceinvoice

Performing a Return to Supplier Transaction
• You can use the Receiving Returns window to return any rejected material to the

appropriate supplier.
• The supplier may send a credit invoice or ship some replacement material.

Benefits of Option E
• There is no loss of material if the vendor provides replacement merchandise.
• There is no need to recover the material in-house.
• Credit may be issued by the vendor.
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• The planning process inflates the demand for a
component with a yield factor less than 1.

• New component usage quantity =
Component usage quantity / Yield factor

• Example:
Component usage quantity = 10
Yield factor = 0.9
New component usage quantity = 10 / 0.9 = 11.1

• The planning process inflates the demand for a
component with a yield factor less than 1.

• New component usage quantity =
Component usage quantity / Yield factor

• Example:
Component usage quantity = 10
Yield factor = 0.9
New component usage quantity = 10 / 0.9 = 11.1



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Work In Process Transactions Issues
Chapter 7 - Page 61

Planning Component Demand Example

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Planning Component Demand ExamplePlanning Component Demand Example

Envoy Plastic Cover Bill
Op Seq

20 Plastic Stock—Green

Component Qty Yield
0.04 0.97

20 Plastic Stock—Red 0.04 0.97
20 Resin 0.02 0.97

The planning process explodes through the bill of material to generate component
requirements. If there is demand for 1,000 Envoy Plastic Covers, the planning process
generates the following material requirements:
Plastic Stock—Green: (0.04 / 0.97) * 1,000 = 41.23
Plastic Stock—Red: (0.04 / 0.97) * 1,000 = 41.23
Resin: (0.02 / 0.97) * 1,000 = 20.61
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Methods for Managing Rejected
Components in WIP

Define transaction reasonsDefine transaction reasons
1

Option A
Issue more
components

Option A
Issue more
components

Option B
Return from WIP to

inventory

Option B
Return from WIP to

inventory

Issue components to
WIP

Issue components to
WIP

Return failed
components to MRB

Return failed
components to MRB

2 3

1

Define MRB
subinventory
Define MRB
subinventory

2

You can manage rejected components in two ways:
• Issue more components
• Return from WIP to inventory
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Raw materialRaw material
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory Issue moreIssue more
componentscomponents

Performing an Issue Transaction
• You can issue extra components to the discrete job using the WIP Material

Transactions window.
• You can use a reason code to identify the cause of the overissue.
• You can leave rejected components in the job.

Reviewing the Benefits of Option A
• Rejected components are easily traced by the system.

– The overissued quantity identifies the volume of rejected components.
– The material cost variance identifies the cost of rejected components.
– Reason codes identify the cause of the problem.

• No need to stop production; additional components are easy to issue.
• No transactions are needed to scrap rejected components; you can just physically

dispose of them.
• This option provides transaction history to help estimate component yield.

Note:This option does not work well for repetitive schedules, because any extra
material in the schedule would be rolled forward to the next schedule.
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MRBMRB
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory

ReturnReturn
rejectedrejected

componentscomponents

Performing a Return Transaction
• You can use the WIP Material Transactions window to return rejected

components from WIP to inventory.
• You should make sure the components are returned to a nonnettable subinventory

so they are not considered as supply by the planning processes.
• You can evaluate whether the components can be recovered.

Benefits of Option B
• Leaves the option to recover the rejected components.
• Isolates rejected components.
• Provides transaction history to help estimate component yield.

Notes
• If the raw material subinventory is close to your shop floor, you can directly

exchange a rejected component in WIP with a good component in inventory. You
should isolate the rejected component in the raw material subinventory and then
dispose of it as you would any other rejected component in inventory.

• You can execute both options A and B simultaneously—that is, issue more good
components and return rejected components to inventory.

• After returning the components to the MRB subinventory, you can also perform
an inventory transaction to issue the failed components to a scrap account.
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What are the methods to manage rejected material in
inventory?
What are the methods to manage rejected material in
inventory?
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What are the methods to manage rejected material in
inventory?

There are five ways you can manage rejected material
in inventory:

Subinventory transfer
Miscellaneous transaction
Account issue
Account alias issue
Return to vendor

What are the methods to manage rejected material in
inventory?

There are five ways you can manage rejected material
in inventory:

Subinventory transfer
Miscellaneous transaction
Account issue
Account alias issue
Return to vendor
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What are the methods to manage rejected
components in work in process?
What are the methods to manage rejected
components in work in process?
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What are the methods to manage rejected
components in work in process?

You can manage rejected components in two ways:

Issue more components
Return from WIP to inventory

What are the methods to manage rejected
components in work in process?

You can manage rejected components in two ways:

Issue more components
Return from WIP to inventory
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• Costing issue transactions: Accounting entries

• Costing return transactions: Accounting entries

• Costing issue transactions: Accounting entries

• Costing return transactions: Accounting entries

Account           Debit Credit
WIP accounting class valuation accounts           XX

Subinventory elemental accounts XX

Account           Debit Credit
WIP accounting class valuation accounts           XX

Subinventory elemental accounts XX

Account           Debit Credit
Subinventory elemental accounts           XX

WIP accounting class valuation accounts XX

Account           Debit Credit
Subinventory elemental accounts           XX

WIP accounting class valuation accounts XX
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• You can charge material to WIP at average cost.
• You can charge resources to WIP at actual or

average cost.
• You can define outside processing resources

under average costing.
• You can calculate the average cost of completed

assemblies in WIP.

• You can charge material to WIP at average cost.
• You can charge resources to WIP at actual or

average cost.
• You can define outside processing resources

under average costing.
• You can calculate the average cost of completed

assemblies in WIP.

Weighted Average Costing
With average costing capability in Work in Process, you can define your organization
as a standard cost organization or an average cost organization.

• You can issue items from inventory to jobs and return components from a job
back to inventory at the item’s current average cost.

• You can charge resources to WIP jobs either at actual rate or at an average rate.
How you define them is determined by the method you choose for charging labor
and nonlabor resources to WIP.

• You can define outside processing resources under average costing in the same
way you would in a standard cost organization.

• When you complete assemblies from WIP to a subinventory, they can be costed
in one of the following ways:

– A predefined cost in a user-designated cost type
– An algorithm based on actual job charges that calculate the unit cost to be

relieved from the job and charged to inventory for each unit completed
For more information, see Oracle Cost Management Release 11i.
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View Material Requirements
Windows/Reports Description

View requirements by component item

View Discrete Jobs View open requirements by job

View Repetitive Schedules View open requirements by repetitive
schedule

Discrete Job Data Report Report job information, including
material requirements

Repetitive Schedule Data
Report

Report schedule information, including
material requirements

Discrete Routing Sheet
Report routing information by job,
including material requirements at each
operation

You can view and report requirement information to control your work in process
material flow.

Material Reporting Common Elements
• Bulk and vendor item displays
• WIP supply subinventory and locator
• Alphanumeric ordering of items
• Quantity required, quantity issued, and quantity open
• Quantity on hand with nettable option
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Discrete Job Shortage Report

Windows/Reports Description

Report open requirements or shortages
by job

Repetitive Schedule Shortage
Report

Report open requirements or shortages
by repetitive assembly and line

Discrete Job Pick List Report Report requirements for a job, ordered
by supply type

Repetitive Pick List Report Report requirements for a repetitive
assembly, ordered by supply type

Repetitive Routing Sheet
Report routing information by schedule,
including material requirements at each
operation

Oracle Work in Process reports do not show WIP allocations or reservations—that is,
material is not allocated or reserved for use in a specific job or schedule ahead of use.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Work In Process Transactions Issues
Chapter 7 - Page 75

Viewing and Reporting Material Requirements

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Viewing and Reporting
Material Requirements
Viewing and Reporting
Material Requirements

WIP_CUR_NET_AVAILABLE_VIEW

View open requirements
whose start date is less than
or equal to the current
system date

WIP_CUR_SUB_LOC_NET_AVAIL_VIEW

View open requirements
whose start date is less than
or equal to the current
system date consolidated by
supply subinventory and
locator

WIP_NET_AVAILABLE_VIEW
View open requirements
regardless of the
requirement date

WIP_SUB_LOC_NET_AVAIL_VIEW

View open requirements
regardless of the
requirement date
consolidated by supply
subinventory and locator

The database business views shown in the slide provide additional information that is
useful for customized allocation and shortage reporting. They all show the quantities on
hand in nettable and nonnettable subinventories for each component.
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Use the Material Transactions window to:
• View detail associated with inventory transactions
• Search for transaction information by entering a

combination of search criteria.

Use the Material Transactions window to:
• View detail associated with inventory transactions
• Search for transaction information by entering a

combination of search criteria.

(Help) Oracle Manufacturing Applications > Oracle Inventory > Transactions >
Overview of Movement Statistics > Viewing Material Transactions

(N) Material Transactions—>View Material Transactions

If material transactions have not completed, the defined discrete jobs profile may be set
to concurrent and the batch process has not run. Contact the system administrator to
launch the Interface Manager for Material Transactions.
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InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources

WIP Transactions
With Oracle WIP transactions you can

• Track and report your inventory accurately.
• Maintain accurate supply and demand information.
• Track activity costs.
• Value work in process.

Transactions are driven by actions.
Examples

• Picking material from a pick list drives a material issue transaction in Oracle
Work in Process.

• Completing an assembly at an operation drives a move and possibly a backflush
transaction.

• Replenishing your subinventories drives a subinventory transfer transaction.
• Failing a test at an operation drives a scrap transaction.
• Shipping an assembly to an outside vendor drives a move transaction.
• Finishing an assembly drives a completion into inventory and possibly a

backflush transaction.
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Issuing Components in Work in ProcessIssuing Components in Work in Process

ReplenishReplenish

PushPush
issueissue

Work in Process

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory

Floor stockFloor stock
inventoryinventory

BulkBulk
SupplierSupplier
(outside(outside

processing)processing)
MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete
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in Inventory

Raw materialRaw material
inventoryinventory

InventoryInventory

MRBMRB
subinventorysubinventory

Issue to scrap accountIssue to scrap account

Scrap accountScrap account

TransferTransfer

DockDock

SupplierSupplier
warehousewarehouse
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Managing Rejected Components
in WIP

Raw materialRaw material
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

InventoryInventory

ReturnReturn
rejectedrejected

componentscomponents

Issue moreIssue more
componentscomponents
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Oracle
Work in
Process

OracleOracle
Order EntryOrder Entry

OracleOracle
QualityQuality

OracleOracle
ProjectsProjects

Oracle HumanOracle Human
ResourcesResources

Oracle CostOracle Cost
ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Planning/CapacityPlanning/Capacity

OracleOracle
InventoryInventory

OracleOracle
PurchasingPurchasing

Oracle Bills ofOracle Bills of
MaterialMaterial

Product Integration
Oracle Work in Process interacts with Oracle’s other applications products by sharing
common information.

• Oracle Inventory
– From: UOM, item information, and on-hand information
– To: WIP activity and ATP supply information

• Oracle Bills of Material
– From: Product structure information, routing information, and resource

information
• Oracle Engineering

– From: Engineering change information and product structure information
• Oracle Purchasing

– From: Receipts deliveries
– To: Subcontract requisitions

• Oracle Planning
– From: Planned jobs and schedules
– To: Open jobs, schedules, and repetitive assembly and line information

• Oracle Capacity
– To: Existing resource load
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Product Integration (continued)
• Oracle Cost Management

– From: Cost information
– To: Transaction costs

• Oracle Projects
– From: Project tasks and IDs
– To: Job cost information

• Oracle Quality
– To: Quality data

• Oracle Human Resources
– From: Employee information

• Oracle Order Entry
– From: Final assembly orders
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After completing this component, you should be able
to do the following:
• Move assemblies on the shop floor
• Track assembly movements on the shop floor
• Report shop floor activity
• Manage rejected assemblies in work in process
• Charge resources to jobs or schedules
• Monitor resource transaction activity

After completing this component, you should be able
to do the following:
• Move assemblies on the shop floor
• Track assembly movements on the shop floor
• Report shop floor activity
• Manage rejected assemblies in work in process
• Charge resources to jobs or schedules
• Monitor resource transaction activity
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• Overview
• Moving Assemblies
• Managing Rejecting Assemblies
• Charging Resources

• Overview
• Moving Assemblies
• Managing Rejecting Assemblies
• Charging Resources
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In this section you will cover the following:
• Work in process flow
• Repetitive flow
• WIP transactions
• Backflushing components
• Moving assemblies and charging resources
• Managing rejected assemblies
• WIP integration

In this section you will cover the following:
• Work in process flow
• Repetitive flow
• WIP transactions
• Backflushing components
• Moving assemblies and charging resources
• Managing rejected assemblies
• WIP integration
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Work in Process FlowWork in Process Flow

ReplenishReplenish

PushPush
issueissue

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory

Floor stockFloor stock
inventoryinventory

BulkBulk
SupplierSupplier
(outside(outside

processing)processing)
MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

Definitions
• Issue transaction is a material transaction to issue component items from

inventory to work in process.
• Replenishment transaction is a material transaction to stage components

in advance of backflushing.
• Return transaction is a material transaction to return components from

WIP back to inventory. Return transactions increase WIP material
requirements, inventory balances, and valuation, and decrease WIP
valuation.

Distinguishing Between Types of Material Transactions
• Material issue transactions fulfill WIP material requirements on jobs or

schedules.
– Issue transactions reduce inventory balances and valuation.
– Issue transactions incur WIP costs and increase WIP valuation.

• You can use supply types to control how components are supplied to fulfill
material requirements.

• Push issue transaction is a material transaction to issue component items
from inventory to work in process before you manufacture the assembly.
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Work in Process Flow  (continued)
• Backflush transaction is a material transaction that automatically issues

component items into work in process from inventory when you move or
complete the assembly. A backflush transaction is also known as post–
deduct or pull.

WIP Material Requirements
WIP material requirements describe the items and quantities needed to
build an assembly on a discrete job or repetitive schedule. Requirements in
discrete jobs or repetitive schedules come from component items defined
on a bill of materials. WIP issue transactions fulfill material requirements.
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charge resourcescharge resources

Finished goods
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Customer

Issue material
• Raw material
• Components
• Subassemblies

Stockroom

PlanPlanner

Begin
production
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InventoryInventory
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Scrap rejected
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IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

WIP Transactions
With Oracle WIP transactions, you can:

• Track and report your inventory accurately.
• Maintain accurate supply and demand information.
• Track activity costs.
• Value work in process.

Transactions are driven by actions.
Examples

• Picking material from a picklist drives a material issue transaction in Oracle
Work in Process.

• Completing an assembly at an operation drives a move and possibly a
backflush transaction.

• Replenishing your subinventories drives a subinventory transfer transaction.
• Failing a test at an operation drives a scrap transaction.
• Receiving an assembly back from an outside vendor drives a move

transaction.
• Finishing an assembly drives a completion into inventory and possibly a

backflush transaction and job completion.
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ReplenishReplenish
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issueissue
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Assembly pullAssembly pull
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CompleteComplete

Backflushing Components
You can initiate a backflush from several sources. You do not need to do an
explicit issue transaction if you use backflushing. You can automatically launch
backflush transactions when moving or completing assemblies.

Backflush Sources
• Move Transactions window
• Completion Transactions window
• Enter Receipts window in Oracle Purchasing (for outside processing)
• Oracle Inventory Material Transaction interface
• Open Move Transaction interface

Operation Pull
• Move transactions that complete an operation backflush all components

with a supply type of Operation Pull.
• The backflush occurs only at routing operations with a backflush type of

Yes. The backflush transaction backflushes all Operation Pull components
at all appropriate previous operations in the routing as well.

• Components with a supply type of Operation Pull defined for an operation
with a backflush type of No are backflushed after completing an operation
with a backflush type of Yes later in the routing.

Assembly Pull
WIP completion transactions backflush all components with a supply type of
Assembly Pull.
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MachineMachine
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WIP MoveWIP Move

MachineMachine
ItemItem

ManualManual

SetupSetup
LotLot

WIP MoveWIP Move

MachineMachine
ItemItem

WIP MoveWIP Move
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ItemItem
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ItemItem
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Move fromMove from
10—Queue to10—Queue to
30—To Move30—To Move

WorkerWorker
ItemItem

ManualManual

MachineMachine
ItemItem

WIP MoveWIP Move

Moving Assemblies and Charging Resources
Move and Resource Transactions

• Move transactions move assemblies from any operation on the routing to
any other operation. Moves normally follow the sequence as defined by
the routing.

• Backward move is used to correct a mistake or to perform additional
work at a previous operation. Backward moves uncharge everything that
was charged by the forward move.

• Resource is a thing of value, except material and cash, that is required to
manufacture, cost, and schedule products. Resources include people, tools,
machines, services purchased from a vendor, and physical space.

• Resource basis is the basis for resource usage quantity that indicates
whether that quantity is required per item or per lot.

• Lot-based resources are resources whose usage quantity represents the
amount you require per job or schedule. For example, a lot-based resource
could be the amount of time required to set up a machine at an operation to
build the assemblies on a job or painting or drying, where time is constant
regardless of the job or schedule quantity.

• Item-based resources are resources whose usage quantity represents the
amount you require per assembly you make. For example, an item-based
resource could be the amount of time required to process each assembly at
an operation for the job.
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Moving Assemblies and Charging Resources
(continued)

• Resource transaction is a transaction in which you automatically or
manually charge resource costs to a discrete job or repetitive schedule.
Transacting a resource is synonymous with charging a resource.
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Rework3
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Material  review
board subinventory

Complete rejectedComplete rejected
assemblies to MRBassemblies to MRB

Complete goodComplete good
assembliesassemblies

Rework in aRework in a
nonstandardnonstandard

jobjob

Managing Rejected Assemblies
Definitions

• Reject is an intraoperation step in an operation at which you record
assemblies that require rework or need to be scrapped.

• Scrap is an intraoperation step at which you move assemblies that cannot
be reworked or completed.

• Scrap account is an account that you use to charge scrap transactions.
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OracleOracle
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OracleOracle
InventoryInventory

Complete finishedComplete finished
and rejectedand rejected
assembliesassemblies

IssueIssue
materialmaterial

Return finishedReturn finished
assembliesassemblies

Return rejectedReturn rejected
componentscomponents

WIP Integration to Oracle Inventory
Material Transactions Use Inventory Controls

Item Status
The item being transacted must be transactable in Oracle Inventory.
Subinventories and Locators
You can use the subinventories and locators and any transaction default values
defined in Oracle Inventory.
Lot Control

• Oracle Work in Process supports lot control for all material transactions.
• You can use the same entry window for issues, backflushes, and

completions.
• You can enter lot numbers for items under lot control when performing

issues, returns, and completions.
• You can use the lot number assigned upon receipt of an item into inventory

when issuing that item to work in process.
Serial Number Control

• Oracle Work in Process supports serial number control for all material
transactions.

• You can use the same entry window for issues, backflushes, and
completions.
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WIP Integration to Oracle Inventory (continued)
• When performing issues, returns, and completions, you can enter serial

numbers for items under serial number control.
• When issuing that item to work in process, you can use the predefined or

dynamically created serial numbers assigned upon receipt of an item into
inventory.

Revisions
• You can issue, return, or complete components under revision quantity

control.
• Transaction quantities are tracked by revision.

Issuing Material
An issue transaction is a material transaction to issue component items from
inventory to work in process.

• Material issue transactions fulfill WIP material requirements on jobs or
schedules.

• Issue transactions reduce inventory balances and valuation.
• Issue transactions incur WIP costs and increase WIP valuation.
• You can use supply types to control how components are supplied to fulfill

material requirements.
• A push issue transaction is a material transaction to issue component items

from inventory to work in process before you manufacture the assembly.
• A backflush transaction is a material transaction that automatically issues

component items into work in process from inventory when you move or
complete the assembly. A backflush transaction is also known as post-
deduct or pull.
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WIP Integration to Oracle Cost Management
Costing Transactions

• Issue and return transactions affect your work in process and inventory
valuations.

• Issue transactions increase your work in process valuation and decrease
your inventory valuation.

• Return transactions increase your inventory valuation and decrease your
work in process valuation.

• Move transactions can automatically launch backflush transactions and
charge resources and overheads.

• Backflush material transactions increase your work in process valuation
and decrease you inventory valuation.

• Resource charges increase your work in process valuation.
• Overhead charges increase your work in process valuation.
• You can cost resource transactions at either standard or actual.
• Completion transactions affect your work in process and inventory

valuations.
• Completion transactions decrease your work in process valuation and

increase your inventory valuation.
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WIP Integration to Oracle Planning
Requirements
The planning process inflates the demand for a component with a yield factor of
less than 1 to compensate for the expected component rejection in WIP.
New Component Usage Quantity = Component Usage Quantity / Yield
Factor
The planning process creates additional demand for an item to compensate for
the expected assembly shrinkage loss and maintain supply.
Supply Quantity = (MRP Net Quantity - Quantity Completed - Quantity
Scrapped) * (1 - Shrinkage Rate) 
Net Requirement = Original Demand - Supply Quantity From the Job
Shrinkage Demand = Demand * 1 / (1 - Shrinkage Rate)
Total Demand = Manual (Original) Demand + Discrete Job Shrinkage +
Planned Order Shrinkage
Discrete Job Shrinkage = MRP Net Quantity - Supply Quantity from the
Job
Planned Order Shrinkage = Shrinkage Demand - Net Requirement
Total Supply = Discrete Job Quantity + Planned Order Quantity
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WIP Integration to Oracle Quality
• Collecting transactional data when doing move transactions.
• Writing context information for reference collection elements to the quality

data repository.
Collection Elements

Before you can collect data with Oracle Quality, you must first set up your data
collection structure. The basic building block of this structure is the collection
element, which is used in both the specification and the collection plan.
Collection elements define the characteristics of the product or process for
which you are collecting, analyzing, and reporting data. For each collection
element, you can specify a list of acceptable values or specification limits, such
as target value and upper and lower limits.

Specifications
Specifications describe the requirements of a product. You can define
specification limits for key characteristics of the product that you produce.

Collection Plans
Collection plans are similar to test or inspection plans. Collection plans specify
the collection elements to use in collecting data. Collection plans specify when
and how to collect the data as well as the actions to take based on the data
collected.
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WIP Integration to Oracle Flow Manufacturing
Flow Manufacturing is a manufacturing approach with the objective of building
the highest quality product in the shortest possible time at the lowest cost.
Production is recorded with the Work Order-less Completion transaction against
flow schedules created with the Line Scheduling Workbench. Completions can
be either unscheduled or scheduled against a flow schedule. The system
backflushes all components and performs resource and overhead transactions
upon recording completion of the finished product. Additionally, Oracle Flow
Manufacturing allows assembly completions to be recorded without having to
create work order, a job or repetitive schedule, or a flow schedule.
Work order-less completions in WIP and Flow do the following:

• Backflush pull and push components
• Charge resources and overhead based on the flow routing

You do not need to use Flow Manufacturing to do work order-less completions.
They can be completed in Work in Process.
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WIP Integration to Oracle Project Manufacturing
Project WIP Jobs
You can create WIP jobs (work orders) with project/task references. Both
standard and non-standard WIP jobs are supported. Standard Project WIP jobs
can be created automatically and released from the Planner Workbench.
Performing move and resource transactions in Project Manufacturing is similar
to doing moves and resources in discrete WIP jobs.
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In this section you will cover the following:
• Intraoperation and interoperation moves
• Operation completions and uncompletions
• Reverse backflush transactions
• Performing, viewing, and pending move transactions
• Overcompletions
• Assignment of shop floor statuses and move

restrictions
• Discrete workstation
• Shop floor activity reports
• Costing move transactions

In this section you will cover the following:
• Intraoperation and interoperation moves
• Operation completions and uncompletions
• Reverse backflush transactions
• Performing, viewing, and pending move transactions
• Overcompletions
• Assignment of shop floor statuses and move

restrictions
• Discrete workstation
• Shop floor activity reports
• Costing move transactions
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Moving Assemblies
Moving Assemblies from Any Operation on the Routing to Any Other
Operation
Moves normally follow the sequence as defined by the routing. For example, you
can perform backward moves to correct a mistake or to perform additional work at
a previous operation.
Backward moves uncharge everything that was charged by the forward move.
Adding Operations to WIP Routings
You can add an operation during a move transaction using the Move Transactions
window only.
You can verify that the Enable Adding Operation flag is set to Yes in the Work in
Process Parameters window.
For example, you can add an operation to perform sample testing if the routing does
not already have it.
Move Transaction Concepts
Move Transactions can initiate other transactions in Oracle Work in Process:

• Backflush issue transactions for components with supply type Operation Pull
• Automatic resource transactions for resources with autocharge type WIP

Move
• Overhead transactions for overheads with basis type Item or Lot

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop Floor
Control > Move Transactions
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Seq 30

Intraoperation Moves
Intraoperation moves are assembly moves within an operation. Intraoperation
steps are phases within an operation used to track assembly locations in detail.
The steps are Queue, Run, To Move, Reject, and Scrap.
Intraoperation steps are not related to resource information or scheduling. For
example, if you want to schedule queue time, you must define a queue resource
in Oracle Bills of Material.

Enable Steps
You can use the WIP Parameters window to specify which intraoperation steps
you want to use. For example, if you want to keep track of the phases of your
assemblies at each operation very closely, you would enable all intraoperation
steps.
The Queue intraoperation step must be enabled.

Move Assemblies to Enabled Steps
A pull manufacturer would probably enable the Run and To Move
intraoperation steps. Assemblies wait in the To Move intraoperation step of the
previous operation before they are pulled to the Run step of the next operation.
A push manufacturer would probably enable the Queue and Run intraoperation
steps. Items wait in the Queue intraoperation step of the operation before they
are pushed to the Run intraoperation step of the operation.
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Intraoperation Moves (continued)
Automatic Transactions Timing

The automatic transactions that can result from a move transaction must take
place at one specific event point for each operation.  This ensures that
transactions are handled consistently and are not duplicated.
The event point at which the automatic transactions take place is called the
operation completion.
Operation completions occur when quantities move into to move, reject, or
scrap.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions > Intraoperation Moves
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Interoperation Moves
Interoperation moves are assembly moves from one operation to another in a
routing.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions > Interoperation Moves
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Which intraoperation steps might you want to enable
if you have a just-in-time production environment?
Which intraoperation steps might you want to enable
if you have a just-in-time production environment?
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Which intraoperation steps might you want to enable
if you have a just-in-time production environment?

You would probably enable only Run and To Move to
model your environment.

Which intraoperation steps might you want to enable
if you have a just-in-time production environment?

You would probably enable only Run and To Move to
model your environment.
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Operation Completion
The slide shows the operation completion for Operation Sequence 10.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions > Operation Completion Moves
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Operation Completion
The slide shows the operation completion for Operation Sequences 10 and 20.
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Operation Completion: Example 1Operation Completion: Example 1

10 Queue—>10 Run

Move Transaction Operations Completed

1010 Queue—>10 To Move

1010 Queue—>20 Queue

10, 2010 Queue—>20 Scrap

20, 30, 4010 Queue—>50 Queue

40, 5030 Reject—>50 To Move

50 Reject—>50 Scrap

Operation Completion: Example 1
The routing consists of operation sequences 10, 20, 30, 40, and 50.
Assume that all operations have Autocharge selected.

Notes
With the autocharge flag you can control operation completions and associated
automatic transactions.
Count point determines the default for the next operation when you do a move
transaction.
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Operation Completion: Example 2Operation Completion: Example 2

10 Queue—>10 Run

Move Transaction Operations Completed

10, 2010 Queue—>10 To Move

1010 Queue—>30 Queue

10, 2010 Queue—>20 Scrap

3010 To Move—>40 Queue

10, 30, 40, 5010 Queue—>50 To Move

30, 40, 5030 Queue—>50 Scrap

Operation Completion: Example 2
The routing consists of operation sequences 10, 20, 30, 40, and 50.
The count point types are

• Op seq 10: Count Point selected, Autocharge cleared.
• Op seq 20: Count Point cleared, Autocharge cleared.
• Op seq 30: Count Point cleared, Autocharge selected.
• Op seq 40: Count Point selected, Autocharge selected.
• Op seq 50: Count Point selected, Autocharge selected.
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Operation Completion: Example 3Operation Completion: Example 3

10 No
A
B
C

Push
Operation pull
Assembly pull

20 Yes D
E

Operation pull
Assembly pull

30 No F
G

Operation pull
Assembly pull

40 Yes H Operation pull

Op Seq Backflush Flag Component Supply Type

Operation Completion: Example 3
Assume that all operations have Autocharge selected.
With backflush flag you can control when you want to process your backflush
transactions.
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Operation Completion: Example 3Operation Completion: Example 3

Yes—Components B and D10 Queue—>20 To Move

Move Transactions Backflushing Now?

10 Queue—>30 To Move

10 Queue—>40 To Move

20 Queue—>30 To Move

20 Queue—>40 To Move

20 To Move—>30 To Move

20 To Move—>40 Queue

30 Queue—>40 To Move

Yes—Components B and D

Yes—Components B, D, F, and H

Yes—Components B and D

Yes—Components B, D, F, and H

No

No

Yes—Components F and H



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 38

Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

Why should the backflush flag of the last operation
on a routing always be set to Yes?
Why should the backflush flag of the last operation
on a routing always be set to Yes?
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Review Question SolutionReview Question Solution

Why should the backflush flag of the last operation
on a routing always be set to Yes?

Because otherwise some of the components at that
operation and at previous operations would not get
backflushed.

Why should the backflush flag of the last operation
on a routing always be set to Yes?

Because otherwise some of the components at that
operation and at previous operations would not get
backflushed.
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Operation UncompletionOperation Uncompletion

Queue Run To  Move ScrapReject

Op
Seq 20

Queue Run To  Move ScrapReject

Op
Seq 10

Operation Uncompletion
Backward Move
A backward move into or past the To Move step of an operation constitutes an
operation uncompletion for that operation.
You can uncomplete an operation by reversing any of the moves that constitute
operation completion.
Oracle Work in Process reverses any automatic transaction that took place upon
completion of an operation when that operation is uncompleted.
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Reverse Backflush TransactionsReverse Backflush Transactions

SupplySupply
subinventorysubinventory

CompletionCompletion
subinventorysubinventory

InventoryInventory

Op seq 10Op seq 10

Work in ProcessWork in Process

Op seq 20Op seq 20

Reverse backflush Return from
inventory

Operation uncompletion
(backward move)

Backflush Transactions
When an assembly is completed at an operation, Oracle Work in Process
automatically backflushes any Operation Pull components associated with it.
When an operation is uncompleted, Oracle Work in Process automatically
reverses any backflushing transactions that have taken place during the forward
move.

Resource Charging
Upon operation completion, Oracle Work in Process automatically charges WIP
move resources associated with that operation.
For WIP move resources with a basis of Item, Oracle Work in Process
automatically charges them upon completion of each assembly at the operation.
For WIP move resources with a basis of Lot, Oracle Work in Process
automatically charges them upon completion of the first assembly at the
operation.
On uncompletion, Oracle Work in Process automatically reverses WIP move
resource charges (because these are the only resources that Oracle Work in
Process automatically charges on forward moves).
Automatic resource charges for Lot-based resources are reversed when all
assemblies have been uncompleted at the operation.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions > Move Completion/Return Transactions
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Move TransactionsMove Transactions

InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources

Move Transactions
Where Can You Perform Move Transactions?
Move Transactions window

• You can move assemblies between and within the operations on a routing.
• Oracle Work in Process validates the transaction information online.

Open Move Transaction Interface
• You can insert move transactions into the Move Transaction Interface table.
• Oracle Work in Process validates and then processes the transactions.
• Failed transactions are marked with an appropriate error code.
• You can view, update, and resubmit the information in the Pending Move

Transactions window.
Receipts form in Oracle Purchasing (for outside processing)

• You can automatically move assemblies from an outside processing operation
to the next operation in the routing as you receive the outside processed
assembly back from the vendor.

Discrete Workstation
• You can move quantities within an operation.
• You can also access the move transaction window to perform moves between

operations.
(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop Floor
Control > Move Transactions > Move Transaction Options
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Performing Move TransactionsPerforming Move Transactions

Use the Move Transactions window to:
• Perform move transactions for discrete jobs and

repetitive schedules with routings
• Perform move transactions for non-standard

discrete jobs that have assemblies and routing
references

Use the Move Transactions window to:
• Perform move transactions for discrete jobs and

repetitive schedules with routings
• Perform move transactions for non-standard

discrete jobs that have assemblies and routing
references

Oracle WIP (N) Move Transaction > Move Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions

../ > Performing Move Transactions

../ > Operation Pull Backflush Transactions

../ > Backflushing Pull Components

../ > Move Completions/Return Rules

../ > Performing Move Completions/Return Transactions
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Viewing Move TransactionsViewing Move Transactions

Use the Find Move Transactions window to:
• View move transactions for an individual job or

repetitive schedule

Use the Find Move Transactions window to:
• View move transactions for an individual job or

repetitive schedule

Oracle WIP (N) Move Transaction > View Move Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions

../ > Viewing Move Transactions
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Pending Move TransactionsPending Move Transactions

Use the Find Pending Move Transactions window to:
• View move transactions awaiting processing
• Update, delete, and resubmit move transactions

that have failed validation or processing

Use the Find Pending Move Transactions window to:
• View move transactions awaiting processing
• Update, delete, and resubmit move transactions

that have failed validation or processing

Oracle WIP (N) Move Transaction > Pending Move Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions

../ > Processing Pending Move Transactions

../ > Finding Pending Move Transactions
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OvercompletionsOvercompletions

• Can overmove or overcomplete within tolerance
• Move and complete more assemblies than at

operation

• Can overmove or overcomplete within tolerance
• Move and complete more assemblies than at

operation

JobJob quantityquantity = 5050

MoveMove 
5050

Operation 1Operation 1 Operation 2Operation 2

MoveMove 
5050

MoveMove 
5757

Operation 3Operation 3 Operation 4Operation 4

OverOver
movemove

5757

OvercompletionOvercompletion tolerance = 30tolerance = 30 unitsunits

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Material Control > Assembly Over-Completions and Over-Moves
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DemonstrationDemonstration

This demonstration covers overcompletions.This demonstration covers overcompletions.
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True or False

• You can overcomplete assemblies to inventory
from jobs and schedules per established tolerance
limits without changing the job start quantity.

• You cannot move more assemblies than are
available at a routing operation.

True or False

• You can overcomplete assemblies to inventory
from jobs and schedules per established tolerance
limits without changing the job start quantity.

• You cannot move more assemblies than are
available at a routing operation.

Review QuestionsReview Questions
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True or False

• You can overcomplete assemblies to inventory
from jobs and schedules per established tolerance
limits without changing the job start quantity.
True

• You cannot move more assemblies than are
available at a routing operation.
False

True or False

• You can overcomplete assemblies to inventory
from jobs and schedules per established tolerance
limits without changing the job start quantity.
True

• You cannot move more assemblies than are
available at a routing operation.
False

Review Questions AnswersReview Questions Answers



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 50

Assignment of Shop Floor Statuses

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Assignment of Shop Floor StatusesAssignment of Shop Floor Statuses

Use the Assign Shop Floor Statuses window to:
• Assign shop floor statuses to operations steps for

individual jobs or for an assembly and line
combination

Use the Assign Shop Floor Statuses window to:
• Assign shop floor statuses to operations steps for

individual jobs or for an assembly and line
combination

(N) Move Transaction > Shop Floor Statuses > Assign Shop Floor Statuses

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions

../ > Shop Floor Statuses

../ > Assigning and Viewing Shop Floor Statuses
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Example of Move RestrictionExample of Move Restriction

autocharge 10
direct 20
autocharge 30
autocharge 40

Queue

N

Run

N

To Move

N

Scrap

N

Reject

1
2

3

54 6 7
7

Example of Move Restriction
Given the routing shown in the slide, in which a label of N indicates a No Move
shop floor status; a label of autocharge indicates an operation that is Yes—
Autocharge or No—Autocharge, and a label of direct indicates an operation that
is No—Direct Charge.

1. You can move from 10 Queue to 30 Queue because the No Move
status at 20 To Move is on a direct operation.

2. You cannot move from 10 Queue to 20 Scrap because there is a No
Move status at 20 To Move.

3. You can move from 10 Queue to 30 Reject because the No Move
status at 30 Scrap is not considered.

4. You cannot move from 40 To Move to 40 Queue because of the No
Move status at 40 Run.

5. You cannot move from 10 Queue to 40 To Move because of the No
Move status at 40 Run, and you cannot move-complete from 10
Queue because of that same status; however, you can complete from
40 To Move.

6. You can move from 10 Queue to 40 Run because you can move into
an operation and step with a No Move status.

7. The No Move statuses at 30 Scrap and 40 Reject are of no
consequence unless you move into them. In that case, you cannot
move out once you move in until you have either disabled the status
or deleted it.
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Example of Move Restriction (continued)
Oracle Work in Process provides an option that prevents you from performing
move transactions over operations and intraoperation steps that have No Move
statuses, depending on the autocharge types of the operations.
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Discrete WorkstationDiscrete Workstation

• Provides a basic shop floor execution bench and
shows operators the information they need to do
their jobs on the shop floor

• Provides a basic shop floor execution bench and
shows operators the information they need to do
their jobs on the shop floor

Production Control Board
You can now graphically view and perform manufacturing activities on the shop
floor using the discrete workstation. The graphical interface of the workstation
enables employees to quickly and easily obtain information critical to
supporting business decisions and controlling daily shop floor activities. This
feature provides you with the flexibility to record your activities and view status
and production performance information, while maintaining security to protect
sensitive data.
Using the Discrete Workstation, production operators working on discrete jobs
can quickly and easily obtain frequently-used information (such as performance
measurements, component, and resource requirements), and perform common
shop floor transactions, without having to return to the Work in Process menu.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 54

Discrete Workstation

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Discrete WorkstationDiscrete Workstation

Use the Discrete Workstation window to:
• Graphically view and perform manufacturing

activities on the shop floor

Use the Discrete Workstation window to:
• Graphically view and perform manufacturing

activities on the shop floor

(N) Discrete > Discrete Workstation (B) Launch
Discrete Workstation Display

You can launch the workstation by selecting a department or department and
resource. On the left pane, the list of job operations is those assigned to the
department or department and resource combination that you selected.
The workstation interface displays information on graphs and tables for fast
access and easy readability. You can monitor the utilization, efficiency,
productivity, and load on a resource from all departments in a table and graph
format.

Dispatch Lists
The Immediate Dispatch List includes those job operations, assigned to the
department and resource that currently have quantity in queue, run, or to move
intraoperation steps. The job status must be released or hold. (Hold jobs are red
in color.)
The Upstream Dispatch List includes job operations that are directly preceding
an operation assigned to the department and resource, and there is quantity in
that operation. The upstream dispatch list includes jobs that will be in the
Immediate Dispatch List very soon.
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Discrete Workstation (continued)
(Help) Oracle Manufacturing Applications > Oracle Work in Process > Discrete
Manufacturing > Discrete Workstation > Discrete Workstation Window

../ > Viewing the Tree

../ > Discrete Workstation Menus

../ > Discrete Workstation Toolbar

../ > Launching the Workstation

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Discrete
Manufacturing > Discrete Workstation > Discrete Workstation Transactions
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DemonstrationDemonstration

This demonstration covers the discrete workstation.This demonstration covers the discrete workstation.
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True or False

• Using the Discrete Workstation, production
operators working on discrete jobs can quickly
and easily obtain frequently used information
(such as performance measurements, component,
and resource requirements), and perform common
shop floor transactions, without having to return
to the Work in Process menu.

True or False

• Using the Discrete Workstation, production
operators working on discrete jobs can quickly
and easily obtain frequently used information
(such as performance measurements, component,
and resource requirements), and perform common
shop floor transactions, without having to return
to the Work in Process menu.

Review QuestionReview Question
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True or False

• Using the Discrete Workstation, production
operators working on discrete jobs can quickly
and easily obtain frequently used information
(such as performance measurements, component,
and resource requirements), and perform common
shop floor transactions, without having to return
to the Work in Process menu.
True

True or False

• Using the Discrete Workstation, production
operators working on discrete jobs can quickly
and easily obtain frequently used information
(such as performance measurements, component,
and resource requirements), and perform common
shop floor transactions, without having to return
to the Work in Process menu.
True

Review Question AnswerReview Question Answer
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Shop Floor Activity ReportsShop Floor Activity Reports

Report

Move Transaction
Review move transactions for a specific
job or schedule or range of jobs or
schedules.

Function

Discrete Dispatch Prioritize work in each department.

Repetitive Line Prioritize work on a line.

WIP Location Locate assemblies currently in work in
process.

Job/Repetitive Schedule
Data

View comprehensive job or schedule
information, including work that remains
to be done.

Discrete Job Listing See which jobs to release and start work
on.

Shop Floor Activity Reports
Prioritizing Shop Floor Activity
You can prioritize your shop floor activity to meet customer demands by using
the reports described in the slide. You can use the View Move Transactions
window to review move transactions online.
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Costing Move Transactions:
Accounting Entries

Costing Move Transactions:
Accounting Entries

Backflush material transactions:

Resource transactions:

Backflush material transactions:

Resource transactions:

Account    Debit Credit
WIP accounting class valuation accounts    XX

Inventory valuation accounts XX

Account    Debit Credit
WIP accounting class valuation accounts    XX

Inventory valuation accounts XX

Account    Debit Credit
WIP accounting class resource valuation account    XX

Resource absorption account XX

Account    Debit Credit
WIP accounting class resource valuation account    XX

Resource absorption account XX

Account    Debit Credit
WIP accounting class overhead account    XX

Overhead absorption account XX

Account    Debit Credit
WIP accounting class overhead account    XX

Overhead absorption account XX

Costing Backflush Material Transactions
Move transactions can automatically launch backflush transactions and charge
resources and overheads.
Backflush material transactions increase your work in process valuation and
decrease your inventory valuation. The accounting entries for backflush
material transactions are shown on the slide.

Costing Move-Based Resource Transactions
Resource charges increase your work in process valuation. The accounting
entries for resource transactions are shown on the slide.

Costing Overhead Charges
Overhead charges increase your work in process valuation. The accounting
entries for resource transactions are shown on the slide.
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Costing Move Transactions
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Costing Move TransactionsCosting Move Transactions

Costing Backward Move Transactions
Charges

Backflush material
charges Reversed.

Reversed?

Resource charges WIP Move resource charges only are
reversed.

Overhead charges
Reversed if default basis is Item.
Reversed if default basis is Lot only if the
move results in zero net assemblies
completed in the operation.
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Overhead ChargingOverhead Charging

Fixed amount per item
Move-based
overhead charging

Item

Lot

Resource-based
overhead charging

Resource units Fixed amount for each
resource unit charged

Resource value Percentage of the resource
value

Fixed amount for first unit
completed

Charging Method Default Basis Overhead Charge

Move-Based Overheads
Upon completion of an operation, Oracle Work in Process automatically
charges move-based overheads at that operation. Move-based overheads are
overheads that have a default basis of Item or Lot.
Upon uncompletion, overhead charges are reversed. For Lot-based overheads,
charges are reversed when all assemblies have been uncompleted at the
operation.

Resource-Based Overheads
If the operation completion move resulted in automatic resource charges for
WIP Move resources, and these resources have associated overheads, the
overheads will be charged when the resource is charged. Therefore, a move
transaction that completes an operation can result indirectly in resource-based
overhead charges.
Resource-based overhead charges are reversed when the resource transaction is
reversed.
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Review QuestionReview Question

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

A) What kinds of cost variances would you expect to
see?

B) What kinds of material planning problems might you
anticipate?

C) How could you adjust your requirements to alleviate
some of those problems?

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

A) What kinds of cost variances would you expect to
see?

B) What kinds of material planning problems might you
anticipate?

C) How could you adjust your requirements to alleviate
some of those problems?
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Review Question SolutionReview Question Solution

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

A) What kinds of cost variances would you expect to
see?

Unless you manually transacted all assemblies
through the No operation, or you reworked all of your
assemblies, you would see a favorable material cost
variance on the job.

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

A) What kinds of cost variances would you expect to
see?

Unless you manually transacted all assemblies
through the No operation, or you reworked all of your
assemblies, you would see a favorable material cost
variance on the job.
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Review Question SolutionReview Question Solution

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

B) What kinds of material planning problems might
you anticipate?

You would overplan the material; that is, you would
have planned enough material for all of the
assemblies to go through rework, but most likely not
all of them will.

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

B) What kinds of material planning problems might
you anticipate?

You would overplan the material; that is, you would
have planned enough material for all of the
assemblies to go through rework, but most likely not
all of them will.
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Review Question SolutionReview Question Solution

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

C) How could you adjust your requirements to
alleviate some of those problems?

You could adjust your usage rate to reflect the
percentage of assemblies that you anticipate having to
rework. For example, if each assembly that is
reworked used 1 of a component, and you expect to
rework 30% of all assemblies, you could set the usage
rate to 0.3.

Suppose that an operation for a discrete job has
Autocharge set to No.  It is used for rework, which
requires extra components, so the operation has
material requirements associated with it.

C) How could you adjust your requirements to
alleviate some of those problems?

You could adjust your usage rate to reflect the
percentage of assemblies that you anticipate having to
rework. For example, if each assembly that is
reworked used 1 of a component, and you expect to
rework 30% of all assemblies, you could set the usage
rate to 0.3.
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SummarySummary

InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources

Summary
Moving Assemblies
• There are two kinds of moves: intraoperation and interoperation.
• Move transactions can create backflush transactions, resource charges, and
overhead charges.
• To create such automatic transactions, a move transaction must complete one
or more operations.
• Automatic transactions are reversed when an operation is uncompleted.
• You can use one of four data-entry methods to enter moves: the Move
Transaction window, the Open Move Transaction Interface table, the Receipts
window in Oracle Purchasing or the Discrete Workstation.
• You can perform overmove transactions.
• You can view shop floor activity in a variety of windows and reports using
Oracle Work in Process.
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In this exercise you will define a discrete job, issue
material to the job, and move assemblies from Queue
to Move.

In this exercise you will define a discrete job, issue
material to the job, and move assemblies from Queue
to Move.

Practice 1-1
In this exercise you will define a discrete job, issue material to the job, and
move assemblies from Queue to Move.
1. Define a discrete job. Use the Discrete Jobs window to define the job.

• Organization: M1 Seattle Manufacturing
• Assembly: Sentinel Deluxe AS18947
• Status: Released
• Quantity: 200
• Class: Discrete
• Start Date: Today’s date

2. Issue all push material to the job. Use the WIP Material Transactions window
to issue push components to the job.

• Transaction Type: WIP Component Issue
• Transact: All Material

3. Because Vision is a pull manufacturer, assemblies usually wait in the To
Move intraoperation step of the previous operation before they are pulled to the
Run step of the next operation. Perform move transactions that illustrate this
type of scenario.
4. When you move assemblies to a Reject intraoperation step, you prevent them
from being moved until they have been inspected. How do you implement such
a scenario?
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Practice 1-1 Overview (continued)
5. Five assemblies need to be rejected at the first operation. Move them to the
appropriate operation/step. What do you need to do to move them out of that
operation/step after they have been inspected?
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Practice 1-1 Solution
Define a discrete job. Use the Discrete Jobs window to define the job.

Oracle WIP (N) Discrete—>Discrete Jobs
1. Navigate to the Discrete Jobs window and define a job using the following
information:

• Organization: M1 Seattle Manufacturing
• Assembly: Sentinel Deluxe AS18947
• Status: Released
• Start Quantity: 200
• Class: Discrete
• Start Date: Today’s date

2. Save your work.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 71

Practice 1-1 Solution

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 1-1 SolutionPractice 1-1 Solution

Practice 1-1 Solution (continued)
Issue all push material to the job. Use the WIP Material Transactions window to
issue push components to the job.

• Transaction Type: WIP Component Issue
• Transact: All Material

Oracle WIP (N) Material Transactions—>WIP Material Transactions
1. Use the WIP Material Transactions window to issue push components to the
job.

• Transaction Type: WIP Component Issue
• Transact: All Material

Note: You may receive a Caution window with the message Quantity will drive
inventory negative, click OK.
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Practice 1-1 Solution (continued)
Because Vision is a pull manufacturer, assemblies usually wait in the To Move
intraoperation step of the previous operation before they are pulled to the Run
step of the next operation. Perform move transactions that illustrate this type of
scenario.

Oracle WIP (N) Move Transactions—>Move Transactions
1. Use the Move Transactions window.  Move 200 assemblies from Queue to
To Move.
2. Save your work.
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Practice 1-1 Solution (continued)
When you move assemblies to a Reject intraoperation step, you prevent them
from being moved until they have been inspected. How do you implement such
a scenario?

Shop Floor Statuses
Oracle WIP (N) Move Transactions—>Shop Floor Statuses—>Shop Floor
Statuses
Oracle WIP (N) Move Transactions—>Shop Floor Statuses—>Assign Shop
Floor Statuses

You define a shop floor status that disallows moves (Shop Floor Statuses
window) and you attach it to the Reject intraoperation step of each operation
(Assign Shop Floor Statuses window).
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Practice 1-1 Solution (continued)
Five assemblies need to be rejected at the first operation. Move them to the
appropriate operation/step. What do you need to do to move them out of that
operation/step after they have been inspected?

Oracle WIP (N) Move Transactions—>Move Transactions
Use the Move Transactions window. Move five assemblies from Move to
Reject at the first operation.
To move them out of that step, you must remove the Shop Floor status that you
previously created and attached to that step.
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Managing Rejected AssembliesManaging Rejected Assemblies
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In this section you will cover the following:
• Rejected assemblies in WIP
• Methods of managing rejected assemblies

– Move rejected assemblies to reject
– Scrap rejected assemblies
– Add a rework operation
– Rework inline
– Use a nonstandard job to rework assemblies

In this section you will cover the following:
• Rejected assemblies in WIP
• Methods of managing rejected assemblies

– Move rejected assemblies to reject
– Scrap rejected assemblies
– Add a rework operation
– Rework inline
– Use a nonstandard job to rework assemblies
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Rejected Assemblies in WIPRejected Assemblies in WIP

Work in ProcessWork in Process

InventoryInventory

Finished goods
inventory

Op1
Op seq 10Op seq 10

Op2
Op seq 30Op seq 30

Rework
Op seq 20Op seq 20

Reject or scrapReject or scrap Inline reworkInline rework Reject or scrapReject or scrap

Rework2
Op seq 20Op seq 20

Rework1
Op seq 10Op seq 10

Rework3
Op seq 30Op seq 30

Move assemblies from operation to operation

Material  review
board subinventory

Complete rejectedComplete rejected
assemblies to MRBassemblies to MRB

Complete goodComplete good
assembliesassemblies

Rework in aRework in a
nonstandardnonstandard

jobjob

Rejected Assemblies in WIP
Definitions

• Reject is an intraoperation step in an operation at which you record
assemblies that require rework or need to be scrapped.

• Scrap is an intraoperation step at which you move assemblies that cannot
be reworked or completed.

• Scrap account is an account that you use to charge scrap transactions.
• Shorthand alias is a user-defined code or character string that represents a

complete or partial flexfield value.
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Define transaction reasonsDefine transaction reasons

Option A
Move rejected assemblies to Reject

Option A
Move rejected assemblies to Reject

Option B
Scrap rejected assemblies

Option B
Scrap rejected assemblies

Move rejected assemblies to ScrapMove rejected assemblies to Scrap

Enable scrap intraoperation stepEnable scrap intraoperation step

Enable mandatory scrap flagEnable mandatory scrap flag

Define scrap accountDefine scrap account

Define shorthand aliasDefine shorthand alias

Move rejected assemblies to RejectMove rejected assemblies to Reject

Enable reject intraoperation stepEnable reject intraoperation step

1

6

2

3

4

5

1

3

2

Methods of Managing Rejected Assemblies
There are five ways you can manage rejected assemblies in Oracle Work in
Process.

• Move rejected assemblies to Reject.
• Scrap rejected assemblies.
• Add rework operation.
• Inline rework.
• Rework in a nonstandard job.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 79

Methods of Managing Rejected Assemblies

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Methods of Managing Rejected AssembliesMethods of Managing Rejected Assemblies

Define transaction reasonsDefine transaction reasons

Option C
Add rework operation

Option C
Add rework operation

Option E
Rework in a nonstandard

job

Option E
Rework in a nonstandard

job

Rework in a nonstandard
job

Rework in a nonstandard
job

Define MRB
subinventory
Define MRB

subinventory

Complete rejected
assemblies to MRB
Complete rejected
assemblies to MRB

Define nonstandard
discrete job

Define nonstandard
discrete job

Move rejected
assemblies to Rework

Operation

Move rejected
assemblies to Rework

Operation

Add rework operation to
WIP routing

Add rework operation to
WIP routing

Option D
Rework inline

Option D
Rework inline

Move rejected
assemblies to Rework

Operation

Move rejected
assemblies to Rework

Operation

Define standard
operation

Define standard
operation

Include rework operation
in routing

Include rework operation
in routing

1

2

3

53 4

2

3

4

2

11
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Option A: Move Rejected Assemblies
to Reject

Option A: Move Rejected Assemblies
to Reject

Queue Run To  Move ScrapReject

Op
seq 20

Queue Run To  Move ScrapReject

Op
seq 10

Move failedMove failed
assembliesassemblies

to Rejectto Reject

Move goodMove good
assemblies toassemblies to
next operationnext operation

Moving Rejected Assemblies
You can move rejected assemblies to the Reject intraoperation step to possibly
rework them at that operation or later move them to Scrap.

Using the Move Transaction Window
You can move rejected assemblies to the Reject intraoperation step of the
operation they are currently in.
You can evaluate whether the assemblies can be reworked.
If they can be reworked, you can move them back to the Queue or Run
intraoperation step. Otherwise, you can move them to Scrap (see Option B).

Benefits of Option A
• Isolates questionable assemblies.
• Works well if there is space near the work center to temporarily store the

questionable assemblies (same operation, same department).
• You have the option to scrap or recover the questionable assemblies.
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Option B: Scrap Rejected AssembliesOption B: Scrap Rejected Assemblies

Queue Run To  Move ScrapReject

Op
seq 20

Queue Run To  Move ScrapReject

Op
seq 10

Move goodMove good
assemblies toassemblies to
next operationnext operation

Move failedMove failed
assembliesassemblies

to Scrapto Scrap

Scrapping Rejected Assemblies
You can move assemblies that cannot be recovered to the Scrap intraoperation step.

Using the Move Transaction Window
You can move rejected assemblies to the Scrap intraoperation step of the operation
they are currently in.
Depending on the value of the Mandatory Scrap flag, you may have to enter a
Scrap account during the move transaction.
You can enter a Scrap account that removes the scrap costs from the job
immediately. Otherwise, the scrap costs stay in the job until it is closed.

Benefits of Option B
• Isolates material.
• Deducts from MRP supply on standard discrete jobs.
• Offers the option to write off scrap immediately instead of waiting for the

job close (standard discrete and nonstandard asset jobs) or period close
(repetitive and nonstandard expense jobs).

• Offers the option to undo the transaction later if necessary.
(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Shop Floor Management

../ > Assembly Scrap

../ > Scrap Assemblies
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When scrapping an assembly, backflush assembly
pull components from the current or a previous
operation.

When scrapping an assembly, backflush assembly
pull components from the current or a previous
operation.
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True or False

• When you scrap assemblies on a discrete job, all
assembly pull components required at or before
the operation in which the scrap occurred are not
fully costed.

• Prior to release 11i , the system relieved inventory
only for the quantity that completed into inventory,
and did not take scrapped assemblies into
account.

True or False

• When you scrap assemblies on a discrete job, all
assembly pull components required at or before
the operation in which the scrap occurred are not
fully costed.

• Prior to release 11i , the system relieved inventory
only for the quantity that completed into inventory,
and did not take scrapped assemblies into
account.

Review QuestionsReview Questions
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True or False

• When you scrap assemblies on a discrete job, all
assembly pull components required at or before
the operation in which the scrap occurred are not
fully costed.
False

• Prior to release 11i , the system relieved inventory
only for the quantity that completed into inventory,
and did not take scrapped assemblies into
account.
True

True or False

• When you scrap assemblies on a discrete job, all
assembly pull components required at or before
the operation in which the scrap occurred are not
fully costed.
False

• Prior to release 11i , the system relieved inventory
only for the quantity that completed into inventory,
and did not take scrapped assemblies into
account.
True

Review Questions AnswersReview Questions Answers
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Queue Run To  Move ScrapReject

Op
seq 20

Queue Run ScrapReject

Queue To  Move ScrapReject

Op
seq 10

To  Move

Move unrecoverableMove unrecoverable
assemblies to scrapassemblies to scrap

Move goodMove good
assemblies toassemblies to
next operationnext operation

Move rejected assembliesMove rejected assemblies
to rework operationto rework operation

Run

Rework operation
Op seq 15

Move goodMove good
assemblies toassemblies to
next operationnext operation

Reworking Rejected Assemblies
You can rework rejected assemblies directly in the job by adding a rework
operation in the WIP routing.

Adding a Rework Operation
You can use the Operations window or the Move Transactions window to add
the rework operation (the Enable Adding Operation flag must be set to Yes to
add the operation in the Move Transactions window).
The rework operation should have a clear Count Point check box because you
only want to record operation completions for the assemblies that actually move
in and out of the operation. The resources may also have an autocharge type of
Manual because the number of resource units you charge may vary with each
assembly.

Moving to the Rework Operation
• You can move the rejected assemblies to the rework operation to fix them.
• You can move assemblies that could not be reworked to Scrap.
• You can move assemblies that were successfully reworked to the next

operation.
Benefits of Option C

• You can use predefined rework operations for repeatable rework activities.
• You can add the rework operation when necessary.
• You can easily charge incremental material, resource, and overhead costs

at rework operation.
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Option C: Add a Rework Operation (continued)
• This option works well to locate rejected assemblies if the rework area is

not near the work center where the rejection occurs.
• The good assemblies do not need to be transacted through the rework

operation because the Count Point check box is clear.
Note

Use Option D for repetitive schedules, because operations cannot be added to
repetitive routings.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Shop Floor Management

../ > Rework Production
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Queue Run To  Move ScrapReject

Op
seq 20

Queue Run ScrapReject

Rework operation
Op seq 15

Queue Run To  Move ScrapReject

Op
seq 10

Move goodMove good
assemblies toassemblies to
next operationnext operation

To  Move

Move rejected assembliesMove rejected assemblies
to rework operationto rework operation

Move unrecoverableMove unrecoverable
assemblies to Scrapassemblies to Scrap

Move goodMove good
assemblies toassemblies to
next operationnext operation

Reworking Rejected Assemblies
You can use a routing with a rework operation and rework rejected assemblies
directly in the job or repetitive schedule.

Assigning a Rework Operation to the Routing
If you expect a number of assemblies to be rejected during the manufacturing
process, you can attach a rework operation when defining the routing.
The rework operation should be a standard operation with a clear Count Point
check box and the resources charge type should be Manual.

Moving to the Rework Operation
• You can move the rejected assemblies to the rework operation to fix them.
• You can move assemblies that could not be reworked to Scrap.
• You can move assemblies that were successfully reworked to the next

operation.
Benefits of Option D

• This option allows process engineers to predefine and production staff to
use the rework operation on the routing when rework is anticipated.

• Rework can be performed on a repetitive production line (Option C applies
only to discrete jobs, because operations cannot be added to a repetitive
routing).

• You can easily charge incremental material, resource, and overhead costs
at rework operation.
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Option D: Rework Inline (continued)
• This option works well to locate rejected assemblies if the rework area is

not near the work center where the rejection occurs.
• Good assemblies do not need to be transacted through the rework

operation, because the Count Point check box is clear.
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Option E: Use a Nonstandard Job
to Rework Assemblies

Option E: Use a Nonstandard Job
to Rework Assemblies

Op seq 10Op seq 10
Rework1Rework1

Material reviewMaterial review
board subinventoryboard subinventory

Finished goodsFinished goods
inventoryinventory

InventoryInventory

Work in ProcessWork in Process

Op seq 20Op seq 20
 Rework2 Rework2

Op seq 30Op seq 30
 Rework3 Rework3

Move assemblies from operation to operationMove assemblies from operation to operation

Complete finished assemblies
into inventory

Complete finished assemblies
into inventory

Issue failed assemblies
to nonstandard job

Issue failed assemblies
to nonstandard job

Using a Nonstandard Job to Rework Assemblies
You can rework rejected assemblies currently in an MRB subinventory using a
nonstandard job.

Completing Rejected Assemblies
You can complete rejected assemblies from the current job to an MRB
subinventory.
Optionally you can store the assemblies in that subinventory until you are ready
to rework them.

Defining a Nonstandard Job
• You can define a nonstandard job for the number of assemblies to be

reworked.
• You can select an asset type nonstandard accounting class because the job

is building up assets.
• You can enter the quantity that the planning process should expect as

supply in the MRP Net Quantity field.
(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Shop Floor Management

../ > Rework Production
(Help) Oracle Manufacturing Applications > Oracle Work in Process > Non-
Standard Discrete Job > Business Scenarios > Rework Assemblies
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What are the methods to manage rejected assemblies
in work in process?
What are the methods to manage rejected assemblies
in work in process?
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What are the methods to manage rejected
assemblies in work in process?

There are five ways you can manage rejected
assemblies in Oracle Work in process:
• Move rejected assemblies to Reject
• Scrap rejected assemblies
• Add rework operation
• Inline rework
• Rework in a nonstandard job

What are the methods to manage rejected
assemblies in work in process?

There are five ways you can manage rejected
assemblies in Oracle Work in process:
• Move rejected assemblies to Reject
• Scrap rejected assemblies
• Add rework operation
• Inline rework
• Rework in a nonstandard job
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You can manage rejected assemblies in Oracle Work
in Process in five ways:
• Move rejected assemblies to Reject
• Scrap rejected assemblies
• Add rework operation
• Rework inline
• Rework in a nonstandard job

Choose the method that best meets your business
needs.

You can manage rejected assemblies in Oracle Work
in Process in five ways:
• Move rejected assemblies to Reject
• Scrap rejected assemblies
• Add rework operation
• Rework inline
• Rework in a nonstandard job

Choose the method that best meets your business
needs.
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in this exercise you will create a job and perform a
scrap transaction.
in this exercise you will create a job and perform a
scrap transaction.

Practice 1-2
1. Create a job for a quantity of 10 for assembly AS62445, the Envoy Upgrade
Pack.
2. Verify in the Material Requirements window that the CM22683 component
on the work-in-process BOM has a supply type of assembly pull, which is
created from the original BOM.
3. Move half of the quantity to the scrap step of operation 20. Use an existing
alias such as SCRAP ADJ for the account number.
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Practice 1-2 Solution
Discrete Jobs
Create a standard job for a quantity of 10 for assembly AS62445, the Envoy
Upgrade Pack.

Work in Process (N) Discrete —> Discrete Jobs
1. Create a standard job for a quantity of 10 for assembly AS62445. Make sure
the job status is Released.
2. Save your work.
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Practice 1-2 Solution (continued)
Material Requirements
Verify in the Material Requirements window that the CM22683 component on
the work-in-process BOM has a supply type of assembly pull, which is created
from the original BOM.

Work in Process (N) Job/Schedule Details—>Material Requirements
1. Type in the job number and click Find.
2. Go to the Supply tab and verify that the Envoy Upgrade Manual, item
number CM22683, has a supply type of Assembly Pull.
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Practice 1-2 Solution (continued)
Move Transactions
Move half of the quantity to the scrap step of operation 20. Use an existing alias
such as SCRAP ADJ for the account number.

Work in Process (N) Move Transactions—>Move Transactions
1. Move 5 Envoy Upgrade Packs to seq 20, step Scrap.
2. Save your work.
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Charging ResourcesCharging Resources
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In this section you will cover the following:
• Data entry mechanisms
• Manually charging resources
• Charging resources with move transactions
• Automatically charging resources - backflushing
• Discrete workstation
• Viewing and pending resource transactions
• Processing resource requirements
• Charging multiple schedules and repetitive allocations
• Costing resource charges
• Resource transactions activity reports

In this section you will cover the following:
• Data entry mechanisms
• Manually charging resources
• Charging resources with move transactions
• Automatically charging resources - backflushing
• Discrete workstation
• Viewing and pending resource transactions
• Processing resource requirements
• Charging multiple schedules and repetitive allocations
• Costing resource charges
• Resource transactions activity reports
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Moving Assemblies
and Charging Resources

Moving Assemblies
and Charging Resources

MachineMachine
ItemItem

WIP MoveWIP Move

MachineMachine
ItemItem

ManualManual

SetupSetup
LotLot

WIP MoveWIP Move

MachineMachine
ItemItem

WIP MoveWIP Move

WorkerWorker
ItemItem

ManualManual

WorkerWorker
ItemItem

ManualManual

Operation 10Operation 10

Operation 20Operation 20

Operation 30Operation 30

Move fromMove from
10—Queue to10—Queue to
30—To Move30—To Move

WorkerWorker
ItemItem

ManualManual

MachineMachine
ItemItem

WIP MoveWIP Move

Concepts in Resource Transactions
Move Transaction

Resources are automatically charged during move transactions.
Resource

A resource is a thing of value, except material and cash, that is required to
manufacture, cost, and schedule products. Resources include people, tools,
machines, services purchased from a vendor, and physical space.

Resource Transaction
A resource transaction is a transaction in which you automatically or manually
charge resource costs to a discrete job or repetitive schedule. Transacting a
resource is synonymous with charging a resource.

Resource Basis
Resource basis is the basis for resource usage quantity that indicates whether
that quantity is required per item or per lot.

Lot-Based Resources
Lot-based resources are resources whose usage quantity represents the amount
you require per job or schedule.
For example, a lot-based resource could be the amount of time required to set up
a machine at an operation to build the assemblies on a job, where time is
constant regardless of the job or schedule quantity.

Item-Based Resources
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Item-based resources are resources whose usage quantity represents the amount
you require per assembly you make.
For example, an item-based resource could be the amount of time required to
process each assembly at an operation for the job.

Resource Units Applied
Resource units applied is a quantity you charge to a discrete job or repetitive
schedule for work performed by a resource. The quantity is expressed in the unit
of measure of the resource.
For example, if the unit of measure of a resource is hours and the resource
works 120 hours, you apply 120 units to the discrete job or repetitive schedule.

Autocharge
Autocharge is a method of automatically charging a resource to a discrete job or
repetitive schedule.
This is implemented in Oracle Work in Process through use of the autocharge
type associated with each resource.

WIP Move Resource
A WIP move resource is a resource that is automatically charged to a discrete
job or repetitive schedule by a move transaction that completes an operation.
The autocharge type for this type of resource is WIP Move.

Manual Resource
A manual resource is a resource that you manually charge to a discrete job or
repetitive schedule.
The autocharge type for this type of resource is Manual.

Activity
An activity is an action or task you perform in a business that uses a resource or
incurs cost.
When resources are charged, Oracle Work in Process records the activity
associated with that resource in the routing.
You can use activities to categorize the costs of certain manufacturing functions
such as setup or teardown.

Efficiency
Efficiency is a productivity measure that focuses on actual performance against
a standard. Expressed by percentage, efficiency is calculated by dividing the
actual resource time charged to a task by the standard resource requirements for
the same task.

Efficiency Variance
Efficiency variance is a quantity variance defined as the difference between the
amount of a resource (typically in hours) required at standard and the actual
amount you use to manufacture an assembly.
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Moving Assemblies and Charging Resources
Charging Overheads

You can charge resource-based overheads automatically as you charge a
resource.
You can define overheads to be charged based on resource units or resource
value of the resource with which overhead is associated.
Oracle Work in Process automatically charges appropriate overhead costs as
you charge resources.
Oracle Work in Process reverses overhead charges when you reverse associated
resource charges.

Note:
You should remember that the overheads could also be tied directly to the move
transactions. Such overheads have basis type Item or Lot instead of resource
units or resource value.
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Data-Entry MechanismsData-Entry Mechanisms

• Move Transactions window
• Resource Transactions window
• Open Resource Transaction Interface
• Receipts window in Oracle Purchasing
• Discrete workstation

• Move Transactions window
• Resource Transactions window
• Open Resource Transaction Interface
• Receipts window in Oracle Purchasing
• Discrete workstation

Where You Can Perform Resource Transactions
You can perform resource transactions using the most convenient data-entry
mechanism.

• From the Move Transaction window
– You can charge resources automatically or manually.
– Oracle Work in Process optionally validates the transaction

information online.
• From the Resource Transactions window

– You can charge resources manually.
– Oracle Work in Process optionally validates the transaction

information online.
• Open Resource Transaction Interface

– You can insert resource transactions into the Open Resource
Transaction Interface table.

– Oracle Work in Process validates and then processes the transactions.
– Failed transactions are marked with an appropriate error code.
– You can view, update, and resubmit the information in the Update

WIP Transaction Interface window.
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Data-Entry Mechanisms (continued)
• Receipts window in Oracle Purchasing (for outside processing)

– You can automatically charge outside resources for an outside
operation as you receive the outside processed assembly back from the
vendor.

• Discrete Workstation
– You can enter time on the Discrete Workstation for a resource.
– You can enter direct labor time using an actual labor rate.
– You can enter down to the minute as opposed to the hour with the

resource form.
– The Time Charges tab is chosen.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 104
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Manually Charging ResourcesManually Charging Resources

You can manually charge resources to a discrete job
or repetitive assembly and line with or without an
associated move transaction.
• Manually charging resources without a move
• Manually charging resources with a move
• Manually reversing resource charges

You can manually charge resources to a discrete job
or repetitive assembly and line with or without an
associated move transaction.
• Manually charging resources without a move
• Manually charging resources with a move
• Manually reversing resource charges

Manually Charging Resources with a Move
• You can perform the move transaction.
• You can charge resources with an autocharge type of Manual assigned to the
operations completed during the move (Oracle Work in Process displays those
resources automatically).
• If the standard rate flag for a manual resource is No, and the resource is of type
Person, you can charge the resource at the employee labor rate instead of the
standard rate by specifying an employee identifier.
• This transaction is done from the Move Transactions window by choosing the
Resources button.

Manually Charging Resources without a Move
You can charge any resource assigned to an operation in a job or schedule.
You can charge any resource not previously assigned to an operation in a job or
schedule. The resource must be defined for the department associated with the
operation. It can have autocharge type Manual or WIP move.
This transaction is done by navigating to the Resource Transactions window.

Manually Reversing Resource Charges
You can manually reverse resource charges at any time by specifying negative
resource units applied.
This transaction is done by navigating to the Resource Transactions window.
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Charge Resources Manually
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Charge Resources ManuallyCharge Resources Manually

Use the Resource Transactions window to:
• Charge resources to discrete jobs and repetitive

schedules that have statuses of Released or
Complete

Use the Resource Transactions window to:
• Charge resources to discrete jobs and repetitive

schedules that have statuses of Released or
Complete

Charge Resources Manually
Resources are charged based on how they are defined at the operation they are
assigned.

Oracle WIP (N) Resource Transactions > Resource Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Resource
Management > Resource Transactions > Charging Resources Manually
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Example of Manual ResourcesExample of Manual Resources

Routing Summary

Resource Autocharge Standard
Rate

RES1 WIP Move Yes

RES2

RES3

RES4

Manual No

WIP Move Yes

WIP Move Yes

RES5 Manual Yes

RES6 WIP Move Yes

Op
Seq

10

20

30

40

50 RES7

Count Point
Type

Yes—autocharge

Yes—autocharge

No—direct charge

No—autocharge

Yes—autocharge Manual Yes

Manual Resources
If the Manual Resources Exist check box is selected, the Move Transactions
window queries manual resource charges associated with the operation you are
completing to make data entry easier when you choose the Resources button.
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Resource Charging ExamplesResource Charging Examples

20 Queue—>20 To Move

Move Transaction Manual Resources Displayed

RES210 Queue—>40 To Move

40 To Move—>50 To Move

RES510 To Move—>30 To Move

40 To Move—>20 Queue

RES7
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Review QuestionReview Question

How can you reverse manual resource charges?How can you reverse manual resource charges?
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Review Question Solution
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Review Question SolutionReview Question Solution

How can you reverse manual resource charges?

You can manually charge the same resource to the
job or schedule and enter a negative value in the
Units Applied field.

How can you reverse manual resource charges?

You can manually charge the same resource to the
job or schedule and enter a negative value in the
Units Applied field.
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Charging Resources with Move Transactions
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Charging Resources with Move
Transactions

Charging Resources with Move
Transactions

Use the Move Transactions window to:
• Charge manual resources with a move
• Add and charge resources not already associated

with a job or repetitive schedule

Use the Move Transactions window to:
• Charge manual resources with a move
• Add and charge resources not already associated

with a job or repetitive schedule

Oracle WIP (N) Move Transaction > Move Transactions (B) Resources

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Resource
Management > Resource Transactions > Charging Resources with Move
Transactions
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Example of WIP Move ResourcesExample of WIP Move Resources

Routing Summary

Resource Autocharge Standard
Rate

RES1 WIP Move Yes

RES2

RES3

RES4

Manual No

WIP Move Yes

WIP Move Yes

RES5 Manual Yes

RES6 WIP Move Yes

Op
Seq

10

20

30

40

50 RES7

Count Point
Type

Yes—autocharge

Yes—autocharge

No—direct charge

No—autocharge

Yes—autocharge Manual Yes
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Example of Resource ChargingExample of Resource Charging

10 Queue—>10 Run

Move Transaction Resources Charged Automatically

RES1, RES3, RES4, RES610 Queue—>40 To Move

40 To Move—>50 To Move

RES3, RES4, RES610 To Move—>50 Queue

RES6, RES3, RES4 (unchanged)40 To Move—>20 Queue
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DemonstrationDemonstration

This demonstration covers manually charging
resources.
This demonstration covers manually charging
resources.
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Review QuestionReview Question

How can you reverse WIP move resource charges?How can you reverse WIP move resource charges?
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Review Question SolutionReview Question Solution

How can you reverse WIP move resource charges?

• You can manually charge the same resource to the
job or schedule and enter a negative value in the
Units Applied field.

• You can perform a backward move: Oracle Work in
Process automatically reverses the WIP move
resource charges.

How can you reverse WIP move resource charges?

• You can manually charge the same resource to the
job or schedule and enter a negative value in the
Units Applied field.

• You can perform a backward move: Oracle Work in
Process automatically reverses the WIP move
resource charges.
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Review Question
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Review QuestionReview Question

Why would you want to charge resources that are not
assigned to an operation on a routing?
Why would you want to charge resources that are not
assigned to an operation on a routing?
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Review Question SolutionReview Question Solution

Why would you want to charge resources that are not
assigned to an operation on a routing?

You might need to charge an unexpected resource to
a job or schedule, such as a temporary worker that
you hired for an overtime shift. Or you might have
received an additional machine that you want to use
to speed up the manufacturing process.

Why would you want to charge resources that are not
assigned to an operation on a routing?

You might need to charge an unexpected resource to
a job or schedule, such as a temporary worker that
you hired for an overtime shift. Or you might have
received an additional machine that you want to use
to speed up the manufacturing process.
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Automatic Resource TransactionsAutomatic Resource Transactions

• Automatically charging resources at standard rate
• Completing an operation and automatically

charging resources
• Reversing resource charges

• Automatically charging resources at standard rate
• Completing an operation and automatically

charging resources
• Reversing resource charges

Automatically Charging Resources at Standard Rate
You u can automatically charge resources at their standard rate to a discrete job
or repetitive assembly and line while performing a move transaction.
• Completing an operation and automatically charging resources
• Reversing resource charges

Completing an Operation and Automatically Charging Resources
Oracle Work in Process charges all resources with an autocharge type of WIP
move at their standard rate.
WIP move resources with a basis type of Item are charged upon completion of
each assembly at the operation the resource is tied to.
WIP move resources with a basis type of Lot are charged upon completion of
the first assembly at the operation the resource is tied to.

Reversing Resource Charges
If you perform an uncompletion, Oracle Work in Process automatically reverses
any resource charges associated with the completion for WIP move resources.
If a WIP move resource has a basis type of Lot, Oracle Work in Process
reverses the resource charges only if you uncomplete all assemblies at the
operation.
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Work in ProcessWork in Process

BackflushingBackflushing

ReplenishReplenish

PushPush
issueissue

Jobs and schedules

Floor stockFloor stock
accountaccount SupplierSupplier

warehousewarehouse

Finished goodsFinished goods
subinventorysubinventory

Raw materialRaw material
subinventorysubinventory

Floor stockFloor stock
inventoryinventory

BulkBulk
SupplierSupplier
(outside(outside

processing)processing)
MiscellaneousMiscellaneous

issueissue

Operation pullOperation pull
backflushbackflush

Assembly pullAssembly pull
backflushbackflush

CompleteComplete

Backflushing Components
You can initiate a backflush from several sources. You can automatically launch
backflush transactions when moving or completing assemblies.

Backflush Sources
• Move Transactions window
• Completion Transactions window
• Enter Receipts window in Oracle Purchasing (for outside processing)
• Oracle Inventory Material Transaction interface
• Open Move Transaction interface
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Discrete WorkstationDiscrete Workstation

Use the Discrete Workstation window to:
• Graphically view and perform manufacturing

activities on the shop floor

Use the Discrete Workstation window to:
• Graphically view and perform manufacturing

activities on the shop floor

(N) Discrete > Discrete Workstation (B) Launch
Discrete Workstation Display

You can launch the workstation by selecting a department or department and
resource. On the left pane, the list of job operations is those assigned to the
department or department and resource combination that you selected.
The workstation interface displays information on graphs and tables for fast
access and easy readability. You can monitor the utilization, efficiency,
productivity, and load on a resource from all departments in a table and graph
format.

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Discrete
Manufacturing > Discrete Workstation > Discrete Workstation Transactions >
Charge Resources
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Viewing Resource TransactionsViewing Resource Transactions

Use the View Resource Transactions window to:
• Find and view resource transactions for an

individual job or a repetitive line and assembly
• View resource transactions across jobs and

schedules

Use the View Resource Transactions window to:
• Find and view resource transactions for an

individual job or a repetitive line and assembly
• View resource transactions across jobs and

schedules

Oracle WIP (N) Resource Transactions > View Resource Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Resource
Management > Resource Transactions > Viewing Resource Transactions
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Pending Resource RequirementsPending Resource Requirements

Use the View Pending Resource Transactions
window to:
• Find pending resource transactions for an

individual job or schedule name

Use the View Pending Resource Transactions
window to:
• Find pending resource transactions for an

individual job or schedule name

Oracle WIP (N) Resource Transactions > Pending Resource Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Resource
Management > Resource Transactions > Finding Pending Resource Transactions
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Processing Resource RequirementsProcessing Resource Requirements

Use the Pending Resource Transactions window to:
• View, update, delete, and resubmit resource

transactions that have failed validation

Use the Pending Resource Transactions window to:
• View, update, delete, and resubmit resource

transactions that have failed validation

Oracle WIP (N) Resource Transactions > Pending Resource Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Resource
Management > Resource Transactions > Processing Pending Resource
Transactions
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Charging Multiple SchedulesCharging Multiple Schedules

Transact 300 assemblies

Transaction Allocate to 
Schedule 2

Allocate to 
Schedule 1

300 0

Transact 200 assemblies 100 100

Transact 100 assemblies 0 100

Example of Repetitive AllocationExample of Repetitive Allocation

Charging Multiple Schedules
Flow charging is a repetitive transaction method in which you charge material,
move, resource, and overhead transactions to a specific assembly on a line rather
than a specific repetitive schedule.
If more than one schedule has a status that allows charges, you can perform
transactions against the consolidated sum of all the schedules.
For example, if there are three schedules for 100 units each with status Released for
the same assembly and line combination, you could move up to 300 units with one
transaction.

Advantages of Flow Charging
Flow charging means that shop floor data entry can be performed by charging
against the assembly and line. The person who enters shop floor data does not need
to be able to identify which schedule an assembly belongs to.
Flow charging means that you can batch all your transactions against an assembly
on a line and then enter all of them in one transaction. For example, if you run three
schedules per day building the same assembly on the same line, you can enter all
your transactions against the assembly and line at the end of the day without
worrying about which schedule was building the assemblies.
Flow charging supports the idea of a schedule being less of an individual entity
than a discrete job is. As long as two schedules build the same assembly on the
same line, Oracle Work in Process does not distinguish between them for
transaction purposes.
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Charging Multiple Schedules (continued)
Note: Many Oracle Work in Process repetitive reports also consolidates
quantities across schedules for the same assembly on the same line.
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Repetitive AllocationsRepetitive Allocations

Schedule 1
Total qty = 400

Schedule 2
Total qty = 200

1 2 3 4 5 6 7 8 9 10 11 12 13 Days

100

50

Units/day

Repetitive Allocation
Repetitive allocation is a system technique for applying transaction quantities
and costs across several repetitive schedules that are building the same
repetitive assembly on the same line.
The repetitive allocation algorithm allows Oracle Work in Process to allocate
the transactions that were flow charged to particular schedules.
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Analyzing Repetitive CostsAnalyzing Repetitive Costs

Absorption accountsAbsorption accounts

Inventory
elemental
accounts

Inventory
elemental
accounts

WIP
variance
accounts

WIP
variance
accounts

Work in Process
valuation accounts
Work in Process

valuation accounts

Nonstandard asset job

Nonstandard expense job

Repetitive schedule

Standard discrete job

ResourceResource
chargescharges

OverheadOverhead
chargescharges

Standard cost
adjustment account

Standard cost
adjustment account Scrap accountScrap account

CostCost
updateupdate
transactiontransaction

AssemblyAssembly
scrapscrap
transactiontransaction

MaterialMaterial
transactionstransactions JobJob

closeclose

Period closePeriod close

Assembly completion transactionsAssembly completion transactions

WIP CostingWIP Costing

Flow Charging
When you enter repetitive transactions, you charge the repetitive assembly and
line rather than a specific job. Therefore you can also see repetitive costs
consolidated across all schedules for an assembly on a line.

Period Costing
• You can use the Inventory Accounting Period window in Oracle Inventory

to close a period and perform period costing for your repetitive production.
• Period costs for an assembly are calculated by totaling the charges made

during the period and dividing that number by the number of assemblies
completed in the period.

• The difference between the period cost and the standard cost is called a
variance.

• Oracle Work in Process writes variances to the variance accounts
associated with the WIP accounting classes assigned to the assembly/line
combination for which a repetitive schedule was defined.

• You can use the parameter Recognize Repetitive Variances to control
whether your variances at period end are based only on completed and
canceled schedules or on all schedules.
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Costing Resource Charges
at Resource Standard

Costing Resource Charges
at Resource Standard

– Resource charges increase your work in process valuation. The
accounting entries for resource transactions are:

– The accounting entries for negative manual resource
transactions and backward moves for WIP move resources are:

– Resource charges increase your work in process valuation. The
accounting entries for resource transactions are:

– The accounting entries for negative manual resource
transactions and backward moves for WIP move resources are:

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource absorption account XX

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource absorption account XX

Account                  Debit Credit
Resource absorption account                 XX

WIP accounting class resource valuation account XX

Account                  Debit Credit
Resource absorption account                 XX

WIP accounting class resource valuation account XX

Cost Resource Transactions
You can cost resource transactions at standard, average, or actual.
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Costing Labor Charges at ActualCosting Labor Charges at Actual

The accounting entries at transaction time are:The accounting entries at transaction time are:

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource absorption account XX

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource absorption account XX

Costing Labor Charges at Actual
For labor charges using an actual or employee rate for a resource with the
Standard Rate check box clear, the job or schedule is debited at the actual or
employee rate. The employee rate used needs to be set up at the organization
level.
The absorption account is credited at the same rate. The variance between actual
and standard is captured at the time of accounting close.
The accounting entries at transaction time are shown on the slide.
If you enter an actual rate for a resource with the Standard Rate check box
selected, Oracle Work in Process charges the job or repetitive schedule at
standard. It also charges the variance account of the resource for the difference
between the standard and the actual at transaction time.
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Costing Resource Transactions
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Costing Resource TransactionsCosting Resource Transactions

If the actual rate is greater than the standard rate, the
accounting entries are:

If the actual rate is less than the standard rate, the
accounting entries are:

If the actual rate is greater than the standard rate, the
accounting entries are:

If the actual rate is less than the standard rate, the
accounting entries are:

Account                  Debit Credit
WIP accounting class resource valuation account           XX
Resource rate variance account                 XX

Resource absorption account XX

Account                  Debit Credit
WIP accounting class resource valuation account           XX
Resource rate variance account                 XX

Resource absorption account XX

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource rate variance account XX
Resource absorption account XX

Account                  Debit Credit
WIP accounting class resource valuation account           XX

Resource rate variance account XX
Resource absorption account XX
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Weighted Average CostingWeighted Average Costing

• You can charge material to WIP at average cost.
• You can charge resources to WIP at actual or

average cost.
• You can define outside processing resources

under average costing.
• You can calculate the average cost of completed

assemblies in WIP.

• You can charge material to WIP at average cost.
• You can charge resources to WIP at actual or

average cost.
• You can define outside processing resources

under average costing.
• You can calculate the average cost of completed

assemblies in WIP.

Weighted Average Costing
• You can issue items from inventory to jobs and return components from a

job back to inventory at the item’s current average cost.
• You can charge resources to WIP jobs either at actual rate or at an average

rate. How you define them is determined by the method you choose for
charging labor and nonlabor resources to WIP.

• You can define outside processing resources under average costing in the
same way you would in a standard cost organization.

• When you complete assemblies from WIP to a subinventory, they can be
costed in one of the following ways:

– A predefined cost in a user-designated cost type
– An algorithm based on actual job charges that calculates the unit cost

to be relieved from the job and charged to inventory for each unit
completed

For more information, see Oracle Cost Management Release 11i.
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Resource Transactions
Activity Windows

Resource Transactions
Activity Windows

Window

Operations
Use this window to add, change, or delete
resource requirements on a job or
schedule.

Description

View Resource
Requirements

Use this window to review resource
transactions online.
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Resource Transactions
Activity Reports

Resource Transactions
Activity Reports

Report Description

Resource Transaction
Review resource transactions for a
specific job or schedule or a range of jobs
or schedules.

Resource Performance Review resource efficiency by resource or
department.

WIP Account Distribution
Review the resource and overhead
transactions against an account charged
by job or schedule.

WIP Account Summary List the account summary of resource
and overhead transactions.
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Resource Transactions Activity Reports
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Resource Transactions
Activity Reports

Resource Transactions
Activity Reports

Report Description

WIP Offsetting Account List the resource and overhead
transactions for a specific account.

Discrete Job Value
Review the status of resource and
resource-based overhead charges for a
job.

Repetitive Value
Review the status of resource and
resource-based overhead charges for an
assembly on a line during an accounting
period.
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SummarySummary

• You can let Oracle Work in Process charge
resources automatically based on moves, or you
can manually charge resources with or without a
move.

• You can use one of four data-entry methods to
charge resources: the Material Transactions
window, the Resource Transactions window, the
Open Resource Transaction Interface table, or the
Receipts window in Oracle Purchasing.

• You can charge resources at standard, at average,
at an employee rate, or (through the open
interface) at actual.

• You can monitor resource transactions activity
with a variety of windows and reports.

• You can let Oracle Work in Process charge
resources automatically based on moves, or you
can manually charge resources with or without a
move.

• You can use one of four data-entry methods to
charge resources: the Material Transactions
window, the Resource Transactions window, the
Open Resource Transaction Interface table, or the
Receipts window in Oracle Purchasing.

• You can charge resources at standard, at average,
at an employee rate, or (through the open
interface) at actual.

• You can monitor resource transactions activity
with a variety of windows and reports.
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Practice 1-3 OverviewPractice 1-3 Overview

In this exercise you will create a discrete job, move
assemblies and charge resources.
In this exercise you will create a discrete job, move
assemblies and charge resources.

Practice 1-3
1. Create a new job for a quantity of 100 for assembly AS54888, the Sentinel
Standard Desktop.
2. Move 100 assemblies from Queue to To move.
3. Manually charge resources with the move. Charge 5 hours to Ms. Catherine
Baker.
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Practice 1-3 SolutionPractice 1-3 Solution

Practice 1-3 Solution
Create a new job for a quantity of 100 for assembly AS54888, the Sentinel
Standard Desktop.

Oracle WIP (N) Discrete—>Discrete Jobs
1. Navigate to the Discrete Jobs window and define a standard job for 100
assemblies of AS54888. The status of the job should be released.
2. Save your work.
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Practice 1-3 Solution (continued)
Move 100 assemblies from Queue to To move.

Work in Process (N) Move Transactions—>Move Transactions
1. Move 100 assemblies from Operation Seq 10 Queue to Operation Seq 20 To
move.
2. Do not save your work yet.  Click on the Resources button to do step 3 of the
practice.
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Practice 1-3 Solution (continued)
Manually charge resources with the move. Charge 5 hours to Ms. Catherine
Baker.

Work in Process (N) Move Transactions—>Move Transactions (B) Resources
1. Charge 5 hrs to Ms Catherine Baker (employee ID is 40) at Operation Seq 10.
2. Save your work.
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WIP TransactionsWIP Transactions

InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources
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Moving Assemblies and Charging
Resources

Moving Assemblies and Charging
Resources

MachineMachine
ItemItem

WIP MoveWIP Move

MachineMachine
ItemItem

ManualManual

SetupSetup
LotLot

WIP MoveWIP Move

MachineMachine
ItemItem

WIP MoveWIP Move

WorkerWorker
ItemItem

ManualManual

WorkerWorker
ItemItem

ManualManual

Operation 10Operation 10

Operation 20Operation 20

Operation 30Operation 30

Move fromMove from
10—Queue to10—Queue to
30—To Move30—To Move

WorkerWorker
ItemItem

ManualManual

MachineMachine
ItemItem

WIP MoveWIP Move



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle Work in Process Transactions - Moves and Resources
Chapter 8 - Page 143

Managing Rejected Assemblies

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Managing Rejected AssembliesManaging Rejected Assemblies

Work in ProcessWork in Process

InventoryInventory

Finished goods
inventory

Op1Op1
Op seq 10Op seq 10

Op2Op2
Op seq 30Op seq 30

ReworkRework
Op seq 20Op seq 20

Reject or scrapReject or scrap Inline reworkInline rework Reject or scrapReject or scrap

Rework2Rework2
Op seq 20Op seq 20

Rework1Rework1
Op seq 10Op seq 10

Rework3Rework3
Op seq 30Op seq 30

Move assemblies from operation to operation

Material  review
board subinventory

Complete rejectedComplete rejected
assemblies to MRBassemblies to MRB

Complete goodComplete good
assembliesassemblies

Rework in aRework in a
nonstandardnonstandard

jobjob
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Product IntegrationProduct Integration

Oracle
Work in
Process

OracleOracle
Order EntryOrder Entry

OracleOracle
QualityQuality

OracleOracle
ProjectsProjects

Oracle HumanOracle Human
ResourcesResources

Oracle CostOracle Cost
ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Planning/CapacityPlanning/Capacity

OracleOracle
InventoryInventory

OracleOracle
PurchasingPurchasing

Oracle Bills ofOracle Bills of
MaterialMaterial

Product Integration
Oracle Work in Process interacts with Oracle’s other applications products by
sharing common information.

• Oracle Inventory
– From: UOM, item information, and on-hand information
– To: WIP activity and ATP supply information

• Oracle Bills of Material
– From: Product structure information, routing information, and resource

information
• Oracle Engineering

– From: Engineering change information and product structure
information

• Oracle Purchasing
– From: Receipts deliveries
– To: Subcontract requisitions

• Oracle Planning
– From: Planned jobs and schedules
– To: Open jobs, schedules, and repetitive assembly and line information

• Oracle Capacity
– To: Existing resource load
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Product IntegrationProduct Integration

Oracle
Work in
Process

OracleOracle
Order EntryOrder Entry

OracleOracle
QualityQuality

OracleOracle
ProjectsProjects

Oracle HumanOracle Human
ResourcesResources

Oracle CostOracle Cost
ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
PurchasingPurchasing

Oracle Bills ofOracle Bills of
MaterialMaterial

OracleOracle
Planning/CapacityPlanning/Capacity

Product Integration (continued)
• Oracle Cost Management

– From: Cost information
– To: Transaction costs

• Oracle Projects
– From: Project tasks and IDs
– To: Job cost information

• Oracle Quality
– To: Quality data

• Oracle Human Resources
– From: Employee information

• Oracle Order Entry
– From: Final assembly orders
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In this component, you should have learned how to:
• Move assemblies on the shop floor
• Track assembly movements on the shop floor
• Report shop floor activity
• Manage rejected assemblies in work in process
• Charge resources to jobs or schedules
• Monitor resource transaction activity

In this component, you should have learned how to:
• Move assemblies on the shop floor
• Track assembly movements on the shop floor
• Report shop floor activity
• Manage rejected assemblies in work in process
• Charge resources to jobs or schedules
• Monitor resource transaction activity
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Completing Jobs and Repetitive Schedules

Completing Jobs and Repetitive
Schedules

Completing Jobs and Repetitive
Schedules
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After completing this course, you should be able to
do the following:
• Describe basic completion transaction concepts
• Perform completion transactions
• Overcomplete discrete jobs and repetitive

schedules
• Perform workorder-less completions
• Return assemblies from inventory to WIP
• Explain completion transactions using

manufacturing average costing

After completing this course, you should be able to
do the following:
• Describe basic completion transaction concepts
• Perform completion transactions
• Overcomplete discrete jobs and repetitive

schedules
• Perform workorder-less completions
• Return assemblies from inventory to WIP
• Explain completion transactions using

manufacturing average costing
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• Identify set up steps for workflow alerts and
intelligent messaging

• Explain integration with Oracle Quantity
• Explain rollforward
• Close discrete jobs
• Purge jobs and schedules

• Identify set up steps for workflow alerts and
intelligent messaging

• Explain integration with Oracle Quantity
• Explain rollforward
• Close discrete jobs
• Purge jobs and schedules
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• Lesson 1: Overview
• Lesson 2: Performing Completion Transactions
• Lesson 3: Performing Workorder-less Completions
• Lesson 4: Intelligent Messaging and Quality

Integration
• Lesson 5: Performing Completion Transactions for

Repetitive Jobs
• Lesson 6: Closing and Purging Jobs and

Schedules
• Lesson 7: Summary

• Lesson 1: Overview
•• Lesson 2: Performing Completion TransactionsLesson 2: Performing Completion Transactions
•• Lesson 3: PerformingLesson 3: Performing Workorder Workorder-less Completions-less Completions
•• Lesson 4: Intelligent Messaging and QualityLesson 4: Intelligent Messaging and Quality

IntegrationIntegration
•• Lesson 5: Performing Completion Transactions forLesson 5: Performing Completion Transactions for

Repetitive JobsRepetitive Jobs
•• Lesson 6: Closing and Purging Jobs andLesson 6: Closing and Purging Jobs and

SchedulesSchedules
•• Lesson 7: SummaryLesson 7: Summary
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InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move assemblies on
the shop floor and 
charge resources

Move assemblies on
the shop floor and 
charge resources

Completing JobsCompleting Jobs

Definitions
•  Assembly completion transaction is a material transaction in which you receive
assemblies into inventory from a job or repetitive assembly/line upon completion of the
manufacture of the assembly.
•  Completion subinventory is an inventory location at the end of your production line or
shop floor routing where you receive completed assemblies from work in process. This is
often the supply subinventory for subassemblies or finished goods inventories for final
assemblies.
•  Completion locator is an inventory location in a completion subinventory where you
receive completed assemblies from work in process.
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CompletionsCompletions

Completing assemblies means receiving them
from Work in Process into Inventory.

Completing assemblies means receiving them
from Work in Process into Inventory.

CompleteComplete

Finished goodsFinished goods
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

Completion Transaction Process
•  The finished assemblies are received into inventory, either to be used as subassemblies
or to be shipped as finished goods.
•  All Assembly Pull material attached on the bill is backflushed.
•  The quantity in the To Move step of the last operation is decreased, if there is a routing.
•  The Quantity Complete on the job or repetitive schedule is increased.
•  If the quantity completed equals the total quantity for a schedule, and there are other
active schedules following it on the assembly/line, the schedule’s status is changed to
Complete—No Charges. If the schedule is the last active schedule, its status is changed to
Complete.
•  Job and repetitive schedule statuses are automatically updated to Complete when the
total number of assemblies completed and scrapped on a job or repetitive schedule is
greater than or equal to the required quantity.  Previously, the job would not change
status to “Complete” when there was a scrap quantity and you finished the remainder.
• Quantity completed + Quantity scrapped > New Job Start Quantity
• Note: The new job start quantity takes into account the quantity overcomputed on a
workorder or schedule.
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Returning assemblies means moving them back
from inventory to Work in Process.

Returning assemblies means moving them back
from inventory to Work in Process.

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

ReturnReturn

Finished goodsFinished goods
inventoryinventory

Return from Inventory Transaction Process
•  The finished assemblies are returned from inventory to work in process.
•  All backflush transactions that took place during the corresponding completion
transaction are reversed.
•  The Quantity Complete is reduced.
•  The quantity in the To Move step of the last operation in the routing is increased
(assuming there is a routing).
•  A discrete job’s status is changed back to Released.
•  Repetitive schedule statuses are only changed back to Released from Complete, never
from Complete—No Charges.
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• Lesson 1: Overview
• Lesson 2: Performing Completion Transactions
• Lesson 3: Performing Workorder-less Completions
• Lesson 4: Intelligent Messaging and Quality

Integration
• Lesson 5: Performing Completion Transactions for

Repetitive Jobs
• Lesson 6: Closing and Purging Jobs and

Schedules
• Lesson 7: Summary

•• Lesson 1: OverviewLesson 1: Overview
•• Lesson 2:Lesson 2:  Performing Completion Transactions
•• Lesson 3: PerformingLesson 3: Performing Workorder Workorder-less Completions-less Completions
•• Lesson 4: Intelligent Messaging and QualityLesson 4: Intelligent Messaging and Quality

IntegrationIntegration
•• Lesson 5: Performing Completion Transactions forLesson 5: Performing Completion Transactions for

Repetitive JobsRepetitive Jobs
•• Lesson 6: Closing and Purging Jobs andLesson 6: Closing and Purging Jobs and

SchedulesSchedules
•• Lesson 7: SummaryLesson 7: Summary
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Using completion transactions, you can:
• complete assemblies from discrete jobs and

repetitive schedules into inventory
• return completed assemblies from inventory to

jobs and repetitive schedules
• complete a greater quantity than the job or

schedule start quantity (over-complete) into
inventory

• return more assemblies than were completed on
repetitive schedules and non-standard discrete
jobs

Using completion transactions, you can:
• complete assemblies from discrete jobs and

repetitive schedules into inventory
• return completed assemblies from inventory to

jobs and repetitive schedules
• complete a greater quantity than the job or

schedule start quantity (over-complete) into
inventory

• return more assemblies than were completed on
repetitive schedules and non-standard discrete
jobs

Business BenefitsBusiness Benefits
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Use the Completion Transactions window to:
• complete assemblies from jobs and repetitive

schedules into inventory
• return completed assemblies from inventory to

jobs and repetitive schedules
• over-complete assemblies

Use the Completion Transactions window to:
• complete assemblies from jobs and repetitive

schedules into inventory
• return completed assemblies from inventory to

jobs and repetitive schedules
• over-complete assemblies

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Discrete Manufacturing > Completing Discrete Jobs

... > Repetitive Manufacturing > Completing Repetitive Schedules
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WIP Assembly CompletionWIP Assembly Completion

Use the WIP Assembly Completion window to enter:
• subinventory/Locator
• unit of Measure
• quantity

Use the WIP Assembly Completion window to enter:
• subinventory/Locator
• unit of Measure
• quantity

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions (B) Continue

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions (B) Continue

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Material Control

... > Assembly Completions and Returns

... > Completing and Returning Assemblies
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Lot and Serial NumbersLot and Serial Numbers

Use the Lot and Serial Number Entry window to enter:
• a new or existing lot number
• one or range of serial numbers for each item or lot

quantity
• lot expiration

Use the Lot and Serial Number Entry window to enter:
• a new or existing lot number
• one or range of serial numbers for each item or lot

quantity
• lot expiration

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions (B) Continue (B)
Lot/Serial

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Completion Transactions (B) Continue (B)
Lot/Serial

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Material Control

... > Assembly Completions and Returns

... > Completing and Returning Assemblies
Serial Number Genealogy
Use the material transaction history to view the attributes of your lots or the composition
for a job or lot.  These can also be viewed graphically.
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Use the Move Transaction window to receive
assemblies from Work in Process into inventory.
Use the Move Transaction window to receive
assemblies from Work in Process into inventory.

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

Rules of the Easy Completion Transaction
•  Assemblies are completed into the default completion subinventory or locator for the
job, assembly, or line.  Therefore, there must be a completion subinventory or locator
default for the job or assembly/line.
•  Assemblies under serial number control cannot be completed this way.
•  Assemblies under lot control can be completed only if the discrete job lot is specified in
the job header.
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This practice covers performing an easy completion.This practice covers performing an easy completion.

Scenario
Your customer has called and requires 100 of the final assembly sent immediately.
Create the work order using the easy completion and verify the following:
•  the requirements for the phantom resources have been created
•  the requirements for the sub-assembly have also been created
•  the functionality of shortage messaging has been invoked
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Oracle Applications Logon
The following is specific information to access Vision for manufacturing:
1. Enter a url that is given to you by the instructor
2. Enter User Name: mfg
3. Enter Password: welcome
4. Click Connect
5. Select Responsibility: Manufacturing and Distribution Manager
6. Click OK
7. Select the M1 Seattle manufacturing organization in which to do all of the practices.

(N) Other—>Change Organization (M) M1 Seattle Manufacturing (B) OK
8. Create an item XX-final assembly, where XX are your initials. Enter a description.
Apply the Finished Good Item template. Enable your item in the M1and M3
organizations. Set Overcompletion Tolerance Type to Percent and set Overcompletion
Tolerance Value to 20 (This should allow you to over-receive and over-move 20% more
units per job/schedule).  Save your work.
9. Create 3 items XX-buy part1, XX-buy part2, XX-buy part3. Enter a description. Apply
the Purchased Item template. Set the Supply Type for item 1 = Push, item 2 = Operation
Pull, and item 3 = Assembly Pull. Set Overcompletion Tolerance Type to Percent and set
Overcompletion Tolerance Value to 20 for each item. Enable in organizations M1 and
M3. Save each record.
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10. Create 2 items XX-sub assembly and XX-phantom assembly. Enter a description for
these components. Apply the Finished Good Item template. Set the Supply Type for sub-
assembly = Operation Pull and phantom = Phantom. Set Overcompletion Tolerance Type
to Percent and set Overcompletion Tolerance Value to 20. Enable in M1and M3. Save
each record.
11. Create 3 resources used to process the assemblies:  XX-res1, XX-res2, and XX-res3.
Enter descriptions. Type is Machine for resource 1 and Person for resources 2 and 3.
UOM is HR for all resources. Charge type is WIP MOVE.  Basis = Item, Costed and
Standard Rate should be enabled.  Select an Absorption and Variance account (should be
the same for each resource).  Select Rates button.  Select a Cost Type (should be the same
for each resource). For the Resource Unit Cost enter $10, $5, and $20 respectively. Save
each record.
12. Create 3 departments for each resource XX-dept1, XX-dept2, and XX-dept3. Enter
department descriptions. In the Main tabbed region, link the appropriate resource to each
department (example: XX-res1 to XX-dept1). Enable Available 24 hours. In the Units
column, enter 1. Save each record.
13. Create 2 more resources and departments for your phantom. Resource 1 will be Type
= Person and resource 2 Type = machine. Resource Unit Cost for resource 1 = $25 and
resource 2 = $15.  Enter the rest of the information the same as in step 11.
14. Create 4 operations to be used in all the routings:
– XX-d1: Dept=XX-dept1
– Option dependent (cleared), Count Point (enabled), Autocharge (enabled)
– In Operation Resources, Resource=XX-res1
– UOM=HR
– Basis=Item
– Usage =5
– In Scheduled tabbed page, Scheduled = Yes
– In Costing tabbed page, Charge Type = WIP Move, Standard Rate is enabled
– XX-d2: Dept=XX-dept2
– Option dependent (cleared), Count Point (enabled), Autocharge (enabled)
– In Operation Resources, Resource=XX-res2
– UOM=HR
– Basis=Item
– Usage=5
– In Scheduled tabbed page, Scheduled = Yes
– In Costing tabbed page, Charge Type = WIP Move, Standard Rate is enabled
– XX-d3: Dept=XX-dept3
– Option dependent (cleared), Count Point (enabled), Autocharge (enabled)
– In Operation Resources, Resource=XX-res3
– UOM=HR
– Basis=Item
– Usage=5
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– In Scheduled tabbed page, Scheduled = Yes
– In Costing tabbed page, Charge Type = WIP Move, Standard Rate is enabled.
– XX-p1: Dept=XX-phandept
– Option dependent (cleared), Count Point (enabled), Autocharge (enabled)
– In Operation Resources, Sequence = 10, Resource=XX-phanres1
– UOM=HR
– Basis=Item
– Usage=10
– In Scheduled tabbed page, Scheduled = Yes
– In Costing tabbed page, Charge Type = WIP Move, Standard Rate is enabled
– In Operation Resources, Sequence = 20, Resource=XX-phanres2
– UOM=HR
– Basis=Item
– Usage=10
– In Scheduled tabbed page, Scheduled = Yes
– In Costing tabbed page, Charge Type = manual, Standard Rate is enabled
15. Create 3 routings for the sub-assembly, final-assembly and phantom:
– Item = XX-sub assembly
– Sequence 10, Code XX-d1, Referenced enabled
– Sequence 20, Code XX-d2, Referenced enabled
– Using Routing Details button and specify FGI as the completion subinventory
– Item = XX-phantom assembly
– Sequence 10, Code XX-p1, Referenced enabled
– Sequence 15, Code XX-p2, Referenced enabled
– Using Routing Details button and specify FGI as the completion subinventory
– Item = XX-final assembly
– Sequence 10, Code XX-d1, Referenced enabled
– Sequence 20, Code XX-d2, Referenced enabled
– Sequence 30, Code XX-d3, Referenced enabled
– Using Routing Details button and specify FGI as the completion subinventory
16. Create the bills of material (revision A) for each item:
– Item = XX-sub assembly
– Item sequence 10, Operation sequence 01, Component = XX-buy part1, Quantity = 2
– In the Material Control tabbed page, Supply Type = Push,
Supply Sub-inventory = Stores
– Item = XX-phantom assembly
– Item sequence 10, Operation sequence 10, Component = XX-buy part2, Quantity = 5
– In the Material Control tabbed page, Supply Type = Operation Pull,
Supply Sub-inventory = Stores
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– Item sequence 10, Operation sequence 15, Component = XX-buy part3, Quantity = 5
– In the Material Control tabbed page, Supply Type = Assembly Pull,
Supply Sub-inventory = Stores

– Item = XX-final assembly
– Item sequence 10, Operation sequence 10, Component = XX-sub assembly,
Quantity = 1
– In the Material Control tabbed page, Supply Type = Operation Pull,
Supply Sub-inventory = Stores
– Item sequence 10, Operation sequence 20, Component = XX-phantom assembly,
Quantity = 1
– In the Material Control tabbed page, Supply Type = Phantom,
Supply Sub-inventory = Stores
17. Define a discrete job to satisfy a customer order of 100 assemblies required. Assume
that the job must start today.

• Use the Discrete Jobs window to define the job
Oracle WIP (N) Discrete—>Discrete Jobs

• Type: Standard
• Assembly: XX-final assembly
• Class: Discrete
• Status: Released
• Firm (cleared)
• Start Quantity: 100, MRP Net Quantity: 100
• Start Date: Today’s date

18. Verify that requirements for the phantom have been created:
Oracle WIP (N) Discrete —>View Discrete Jobs
• Search for the job for the final assembly
• Select the Operations button
• Select the Resources button
• Select the Quantities tabbed page
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19. Create a work order for the sub-assembly:
• Use the Discrete Jobs window to define the job

Oracle WIP (N) Discrete—>Discrete Jobs
• Type: Standard
• Assembly: XX-sub assembly
• Class: Discrete
• Status: Released
• Firm (cleared)
• Start Quantity: 100, MRP Net Quantity: 100
• Start Date: Today’s date

20. View potential shortages:
• You can run a pick list report or shortage report.

Oracle WIP (N) Report
Oracle Inventory (N) On hand, Availability—>View Potential Shortages

21. Perform an easy completion on 1/2 of the quantity on the work order for the sub-
assembly:

• Use the Move Transactions window to complete a job
Oracle WIP (N) Move Transactions—>Move Transactions

• Job: your job for the sub-assembly
• Transaction Type = Complete
• From Operation Sequence 10, Step = Queue
• Quantity = 50.
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Overcompleting Jobs and SchedulesOvercompleting Jobs and Schedules

CompleteComplete

Finished goodsFinished goods
inventoryinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

OvercompletionsOvercompletions

Overcompletions
You can over-complete assemblies to inventory from jobs and schedules per established
tolerance limits without changing the job start quantity. You also can move more
assemblies than are available at a routing operation.
For example, if 50 intermediate assemblies move into an operation and that operation
yields 57 assemblies, you may move 57 units into the next operation.
Note: The extra quantity must be within overcompletion tolerance.
Overcompletions on Jobs
You can overcomplete a quantity of assemblies greater than the job quantity.
Discrete Job without a Routing
You can complete any quantity from a discrete job to inventory.
Overcompletions on Schedules
You can overcomplete the quantity of assemblies scheduled on a production line.
Repetitive Schedule without a Routing
You can complete any quantity from the schedules for the assembly/line combination to
inventory.
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OvercompletionsOvercompletions

You can:
• overcomplete either within tolerance or limits
• move and complete more assemblies than at

operation

You can:
• overcomplete either within tolerance or limits
• move and complete more assemblies than at

operation

JobJob quantityquantity == 5050

MoveMove 
5050

Operation 1Operation 1 Operation 2Operation 2

MoveMove 
5050

MoveMove 
5757

Operation 3Operation 3 Operation 4Operation 4

OverOver
movemove

5757

OvercompletionOvercompletion tolerance = 30tolerance = 30 unitsunits

WIP Explodes BOM and Routing for Job Requirements
WIP creates the requirements for operation pull and assembly pull components for the
additional assemblies by exploding the bill of materials. WIP creates the requirements for
resources by exploding the routing. For the completions:
•  Operation pull and assembly pull components will be backflushed automatically.
•  Move transactions will charge resources automatically.
•  Push components and manual resources will be issued manually.
• The job start quantity remains the same. The completion quantity reflects the
overcompletions.  It doesn’t matter when the overcompletion happens within the routing
because the system acts as though the start quantity is higher.
• Default Overcompletion Tolerance %
• A hierarchy is used to establish tolerances based on settings at different levels:
•  Organization level tolerances

Set in WIP parameters, are considered if no other tolerances are set at the item level or
at the discrete job level.

•  Item level tolerances
Set in the Inventory Item Attributes form by organization, are considered for
overcompletions, indicating tolerance type and tolerance value. If no item level
tolerances are established, organization level tolerances in WIP parameters are
considered.

•  Discrete job level
Set in the Discrete Job form in the More page.
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Overcompletion CheckboxOvercompletion Checkbox

Use the Move Transactions or Completions window
and select the Overcompletions checkbox to
complete more quantities than the available quantity.

Use the Move Transactions or Completions window
and select the Overcompletions checkbox to
complete more quantities than the available quantity.

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

or
(N) Manufacturing & Distribution Manager > WIP > Material

Transactions > Completion Transactions (B) Continue

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

or
(N) Manufacturing & Distribution Manager > WIP > Material

Transactions > Completion Transactions (B) Continue

Overcompletion Checkbox
You no longer need to change the job start quantity to complete more than the available
quantity in to move. Any extra quantities will be moved through each operation.
You select the overcompletion checkbox in the Move Transactions window or in the
Completions window.
•  In the Completions window, you must have quantity in the to move of the last operation
in order to do an overcompletion.
•  In the Move Transactions window, you can complete from any operation.
• The amount you can overcomplete is subject to tolerances defined at the organization
level, item level, or job/schedule level. You can select an overcompletion tolerance by
percent or amount.
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Overcompletion SetupOvercompletion Setup

Use the Work in Process Parameters: Other window
to enter the default overcompletion tolerance percent.
Use the Work in Process Parameters: Other window
to enter the default overcompletion tolerance percent.

(N) Manufacturing & Distribution Manager > WIP > Setup >
Parameters (T) Other

(N) Manufacturing & Distribution Manager > WIP > Setup >
Parameters (T) Other

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Setting Up > Defining WIP Parameters
Default Overcompletion Tolerance % (continued)
The WIP parameter is used to default tolerance. If tolerance value is not set up at item
level or at the job/schedule level, this parameter will be used to determine the tolerance
level.
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Overcompletions Tolerance at the Item
Level

Overcompletions Tolerance at the Item
Level

Use the Master Item window to enter an
overcompletion tolerance for a specific item.
Use the Master Item window to enter an
overcompletion tolerance for a specific item.

(N) Manufacturing & Distribution Manager > Inventory > Items >
Organization Items (T) WIP

(N) Manufacturing & Distribution Manager > Inventory > Items >
Organization Items (T) WIP

(Help) Oracle Manufacturing Applications > Oracle Inventory > Items >
Updating Organization Level Items
Default Overcompletion Tolerance % (continued)
On the Inventory Item Attributes form in the work in process page, you can set an
overcompletion tolerance for a specific item. You can either set up a tolerance percentage
or amount. The item tolerance overrides the WIP parameter tolerance.
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Overcompletions Tolerance at the Job
Level

Overcompletions Tolerance at the Job
Level

Use the Discrete Jobs or Repetitive Line/Assembly
Association window to enter an overcompletion
tolerance percentage or amount for a job.

Use the Discrete Jobs or Repetitive Line/Assembly
Association window to enter an overcompletion
tolerance percentage or amount for a job.

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Discrete Jobs (T) More

or
(N) Manufacturing & Distribution Manager > WIP > Repetitive >

Associate Lines and Assemblies

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Discrete Jobs (T) More

or
(N) Manufacturing & Distribution Manager > WIP > Repetitive >

Associate Lines and Assemblies

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Discrete Manufacturing > Defining Discrete Jobs Manually
Default Overcompletion Tolerance % (continued)
On the job or schedule, you can either set up a tolerance percentage or amount. The job
or schedule overcompletion tolerance overrides the item and organization tolerance.
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A hierarchy is used to establish tolerances based on
settings at different levels.  In which order (from
lowest to highest) do they go?
1. Item level, Organization level, Discrete job level
2. Discrete job level, Organization level, Item level
3. Discrete job level, Item level, Organization level
4. Organization level, Item level, Discrete job level
5. Organization level, Discrete job level, Item level

A hierarchy is used to establish tolerances based on
settings at different levels.  In which order (from
lowest to highest) do they go?
1. Item level, Organization level, Discrete job level
2. Discrete job level, Organization level, Item level
3. Discrete job level, Item level, Organization level
4. Organization level, Item level, Discrete job level
5. Organization level, Discrete job level, Item level

Review QuestionReview Question
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A hierarchy is used to establish tolerances based on
settings at different levels.  In which order (from
lowest to highest) do they go?
1. Item level, Organization level, Discrete job level
2. Discrete job level, Organization level, Item level
3. Discrete job level, Item level, Organization level
4. Organization level, Item level, Discrete job level
5. Organization level, Discrete job level, Item level

A hierarchy is used to establish tolerances based on
settings at different levels.  In which order (from
lowest to highest) do they go?
1. Item level, Organization level, Discrete job level1. Item level, Organization level, Discrete job level
2. Discrete job level, Organization level, Item level2. Discrete job level, Organization level, Item level
3. Discrete job level, Item level, Organization level3. Discrete job level, Item level, Organization level
4. Organization level, Item level, Discrete job level
5. Organization level, Discrete job level, Item level5. Organization level, Discrete job level, Item level

Review SolutionReview Solution
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AgendaAgenda

• Lesson 1: Overview
• Lesson 2: Performing Completion Transactions
• Lesson 3: Performing Workorder-less Completions
• Lesson 4: Intelligent Messaging and Quality

Integration
• Lesson 5: Performing Completion Transactions for

Repetitive Jobs
• Lesson 6: Closing and Purging Jobs and

Schedules
• Lesson 7: Summary

•• Lesson 1: OverviewLesson 1: Overview
•• Lesson 2: Performing Completion TransactionsLesson 2: Performing Completion Transactions
•• Lesson 3:Lesson 3:  Performing Workorder-less Completions
•• Lesson 4: Intelligent Messaging and QualityLesson 4: Intelligent Messaging and Quality

IntegrationIntegration
•• Lesson 5: Performing Completion Transactions forLesson 5: Performing Completion Transactions for

Repetitive JobsRepetitive Jobs
•• Lesson 6: Closing and Purging Jobs andLesson 6: Closing and Purging Jobs and

SchedulesSchedules
•• Lesson 7: SummaryLesson 7: Summary
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Business BenefitsBusiness Benefits

Using workorder-less completions, you can:
• complete assemblies without having to create a

job or schedule
• do several tasks in one step at completion
• substitute components
• support lot and serial number control
• cost transactions using standard and average

costing

Using workorder-less completions, you can:
• complete assemblies without having to create a

job or schedule
• do several tasks in one step at completion
• substitute components
• support lot and serial number control
• cost transactions using standard and average

costing

Business Benefits
Workorder-less completions support flow manufacturing, standard costing, and
manufacturing average costing. Using workorder-less completions, you can:
•  Complete assemblies without having to create a job or schedule
•  Do all of the following in one step at completion:

• Backflush pull and push components
• Charge WIP move resources and overhead based on the routing
• Complete assemblies to a designated completion subinventory/locator

No move transactions are required since the workorder-less completion backflushes
and charges resources at completion versus at each operation

•  Substitute components
Add, delete, and substitute components that are not normally associated with the
assembly you are building

•  Support lot and serial number control
• Backflushing
• Completing

•  Cost completion transactions
• Standard
• Average
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Workorder-less CompletionsWorkorder-less Completions

Use the Work Order-less Completions window to:
• complete and return unscheduled assemblies to

and from Inventory
• scrap assemblies from and return scrapped

assemblies to any operation
• reserve assemblies completed from Flow

schedules to ATO sales order
• add, delete, and change bill of material

components
• specify lot, serial, and lot and serial information

for assemblies and components.

Use the Work Order-less Completions window to:
• complete and return unscheduled assemblies to

and from Inventory
• scrap assemblies from and return scrapped

assemblies to any operation
• reserve assemblies completed from Flow

schedules to ATO sales order
• add, delete, and change bill of material

components
• specify lot, serial, and lot and serial information

for assemblies and components.
(N) Manufacturing & Distribution Manager > WIP > Material

Transactions > Workorder-less Completion Transactions
(N) Manufacturing & Distribution Manager > WIP > Material

Transactions > Workorder-less Completion Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Flow
Manufacturing > Work Order-less Completions
Performing Workorder-less Completion Transactions
•  You can complete assemblies using the Workorder-less Completions window without
having to create a job or repetitive schedule.
•  Assembly Pull, Operation Pull, and Push components are automatically backflushed
when you complete assemblies in this window.
•  Lots for backflush components under lot number control can be identified manually or
automatically depending on how the WIP Backflush Lot Selection Method parameter is
set.
•  For backflush components under serial or lot and serial control, you can manually
identify which lots or serial numbers to backflush using the Lot/Serial action in the
Components window.
•  If you return assemblies using this window, you must always identify the lot, serial, and
lot or serial numbers of the components being returned to inventory.
Caution: Assembly Pull, Operation Pull, and Push components are automatically
backflushed. Bulk and supplier components are not backflushed. The bills for Phantoms
are exploded and the Phantom components are backflushed. The system backflushes
these components from the supply subinventory/locator assigned to the components on
the bill of materials or the one that the user specified in the window. If no supply
subinventory/locator is assigned to the bill components, the system pulls components
from the supply subinventory/locator defined for the item. If no item supply
subinventory/locator is defined at the item level, items are pulled from the default supply
subinventory/locator as determined by the Supply Subinventory and Supply Locator
parameters.
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Components on a Workorder-less
Completion

Components on a Workorder-less
Completion

Use the Components window to add, delete, change
components or specify component lot/serial
information

Use the Components window to add, delete, change
components or specify component lot/serial
information

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Workorder-less Completion Transactions
(B) Components

(N) Manufacturing & Distribution Manager > WIP > Material
Transactions > Workorder-less Completion Transactions
(B) Components

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Flow
Manufacturing > Performing Work Order-less Completions
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Returning Assemblies from Inventory to
WIP

Returning Assemblies from Inventory to
WIP

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

BuildBuild

ReturnReturn

Finished goodsFinished goods
inventoryinventory

Returns to WIPReturns to WIP

Return Completed Assemblies
You can return completed assemblies to work in process using the Completion
Transactions window as well as the Move Transactions window.
Reasons to Return Assemblies to Work in Process
•  You want to perform additional processing.
•  You found a quality problem.
•  You mistakenly completed unfinished assemblies to inventory.
•  You are performing a disassembly using a nonstandard job.
• Return Characteristics
•  You can return assemblies from inventory to work in process by selecting Return as the
transaction type.
•  You can return as many assemblies as needed.
•  Any assembly pull components that were backflushed upon completion are
unbackflushed; that is, they are returned to inventory when you return the assembly to
work in process.
• Note
• For repetitive production, Oracle Work in Process allocates returns to active schedules
on a last-in-first-out basis.
• For standard discrete jobs, you can never return more assemblies than you completed.
• You can return more assemblies than you completed for nonstandard discrete jobs
without a routing, as in the case of disassembly.



Copyright © Oracle Corporation, 2000. All rights reserved.

Completing Jobs and Repetitive Schedules
Chapter 9 - Page 34

Move Transactions for Return Assemblies

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Move Transactions for Return
Assemblies

Move Transactions for Return
Assemblies

Use the Move Transactions window to return
assemblies to the shop floor.
Use the Move Transactions window to return
assemblies to the shop floor.

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

(N) Manufacturing & Distribution Manager > WIP > Move
Transactions > Move Transactions

(Help) Oracle Manufacturing Applications > Oracle Work in Process > Shop
Floor Control > Move Transactions >Performing Move Transactions
Move Transactions
You can return assemblies to the shop floor and simultaneously move them to a specific
operation using the Move Transactions window.
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Costing Completion Transactions:
Accounting Entries

Costing Completion Transactions:
Accounting Entries

• The accounting entries for assembly completion
transactions are:

• The accounting entries for earning assembly
material overhead on completions are:

• The accounting entries for assembly completion
transactions are:

• The accounting entries for earning assembly
material overhead on completions are:

Account             Debit Credit
Subinventory elemental accounts             XX

WIP accounting class valuation accounts XX

Account             Debit Credit
Subinventory elemental accounts             XX

WIP accounting class valuation accounts XX

Account                         Debit  Credit
Subinventory material overhead account                     XX

Inventory material overhead absorption account         XX

Account                         Debit  Credit
Subinventory material overhead account                     XX

Inventory material overhead absorption account         XX

Costing Assembly Completion Transactions
Completion transactions affect your work in process and inventory valuations.
Completion transactions decrease your work in process valuation and increase your
inventory valuation. The accounting entries for assembly completion transactions are
shown on the slide.
Earning Assembly Material Overhead on Completion
You can assign overheads based on the total value of an item. You can earn these
overheads as you complete assemblies into inventory. The accounting entries are shown
on the slide.
Note: Applicable to both standard and average costing.
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Manufacturing Average CostingManufacturing Average Costing

You can cost items at a weighted average perpetual
cost.
• Completions are valued using the sum of the

actual costs of resources and materials issued to
a job

• Partial completions are valued using the
appropriate proportional sum of actual resource
and materials issued to a job

You can cost items at a weighted average perpetual
cost.
• Completions are valued using the sum of the

actual costs of resources and materials issued to
a job

• Partial completions are valued using the
appropriate proportional sum of actual resource
and materials issued to a job
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Manufacturing Average Costing
(continued)

Manufacturing Average Costing
(continued)

• Final completions are valued using the total net
value in a job

• The unit cost of a completion is computed
elementally

– Material
– Material and overhead
– Resource
– Overhead
– Outside processing

• Final completions are valued using the total net
value in a job

• The unit cost of a completion is computed
elementally

– Material
– Material and overhead
– Resource
– Overhead
– Outside processing
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Practice 2 OverviewPractice 2 Overview

In this practice you will perform a workorder-less
completion.
In this practice you will perform a workorder-less
completion.

Scenario
Create a workorder-less completion for the final assembly.  You should see a request for
quality results.
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Practice 2 SolutionPractice 2 Solution

Workorder-less Completion
1. Navigate to the Workorder-less Completions window to complete a final assembly.

Oracle WIP (N) Material Transactions—>Workorder-less Completions
2. Assembly: XX-final assembly
    Schedule: you decide
    Quantity: you decide
    Save your work.  Upon save you should receive a message that says you must enter
mandatory quality results.
    Select the Blue Ribbon on the tool bar.
    Enter the quality results.  Select OK.
Note:  Depending on the action you chose, you may see a message.
3. Verify that the phantom routing was exploded correctly and the WIP move resources
in the phantom routing were charged to the schedule.

Oracle Cost (N) View Transactions—>WIP Distributions
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Repetitive JobsRepetitive Jobs
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Workflow Alerts and Intelligent
Messaging

Workflow Alerts and Intelligent
Messaging

Notify users of shortages during WIP completion and
component return transactions
Notify users of shortages during WIP completion and
component return transactions

Complete quantityComplete quantity

ShortageShortage
notificationnotification
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Shortage MessagesShortage Messages

Begin PO receipt

Waiting
WIP job/
schedule

Material 
shortage

Raw in process

Direct
receiving

Bulk

Receive into bulk
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Material ShortagesMaterial Shortages

Use the Find Potential Shortages window to view
potential inventory shortages within Work in Process
(WIP).

Use the Find Potential Shortages window to view
potential inventory shortages within Work in Process
(WIP).

(N) Manufacturing & Distribution Manager > Inventory > On-hand,
Availability > View Potential Shortages

(Help) Oracle Manufacturing Applications > Oracle Inventory > Items > On-
hand and Availability
Material Shortages
View material shortages directly from all of the forms that have been enabled to alert
users of material shortages, bringing up the View Potential Shortages form.
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Material Shortage Parameter SetupMaterial Shortage Parameter Setup

Use the Organization Item window to identify which
items will have the Check Material Shortage attribute
enabled.

Use the Organization Item window to identify which
items will have the Check Material Shortage attribute
enabled.

(N) Manufacturing & Distribution Manager > Inventory > Items >
Organization Items

(N) Manufacturing & Distribution Manager > Inventory > Items >
Organization Items

Technical Note
This setup is at the item level.
Implementation Considerations for Shortage Messages
•  Determine which items should have shortage checks
•  Determine shortage parameters
•  Which type of WIP jobs to check for shortages
•  What location to check for shortages
•  Who should be notified
• Other Setup Required for Material Shortage Feature
•  On the Setup Transaction Types form, you must choose the type of message (online or
workflow notification), and you must select the transaction types to trigger the shortage
check.
•  On the Inventory Item Attributes form, you must check the material shortages check
box for those items that you want included in the material to be checked for shortages at
the organization level of the item.
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 Shortage Message Configuration Shortage Message Configuration

What is needed to configure shortage messages?
• Define demand sources and individuals notified in

Shortage Parameters for Inventory Organization.
• Set item to be shortage message enabled.
• Set Transaction Type to be shortage message-

enabled.
• Optionally, assign planners and buyers to items.

What is needed to configure shortage messages?
• Define demand sources and individuals notified in

Shortage Parameters for Inventory Organization.
• Set item to be shortage message enabled.
• Set Transaction Type to be shortage message-

enabled.
• Optionally, assign planners and buyers to items.
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True or False

• Users performing WIP completion and component
return transactions can be sent a message
indicating that, for the item being moved into
inventory, a shortage exists in an inventory
location or on a sales order or manufacturing
order.

True or False

• Users performing WIP completion and component
return transactions can be sent a message
indicating that, for the item being moved into
inventory, a shortage exists in an inventory
location or on a sales order or manufacturing
order.

Review QuestionReview Question
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True or False

• Users performing WIP completion and component
return transactions can be sent a message
indicating that, for the item being moved into
inventory, a shortage exists in an inventory
location or on a sales order or manufacturing
order.

Answer:
True

True or False

• Users performing WIP completion and component
return transactions can be sent a message
indicating that, for the item being moved into
inventory, a shortage exists in an inventory
location or on a sales order or manufacturing
order.

Answer:
True

Review SolutionReview Solution
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Integration with Oracle QualityIntegration with Oracle Quality

• Completion transaction integration
• Workorder-less completion integration
• Completion transaction integration
• Workorder-less completion integration

InventoryInventory

CompleteComplete
assemblyassembly

Oracle Quality Integration
You can collect quality data while performing a completion transaction or a work
orderless completion in Oracle WIP. You can collect data as you complete, return, or
scrap assemblies on discrete jobs, repetitive schedules, or work orderless flow schedules.
Quality Collection Criteria in Oracle Quality
You set measures for quality data collection in Oracle Quality.
What Oracle Quality does is driven by the form.  Prompts to collect quality data are form
specific and are only invoked when in the completion window.
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True or False

• You can collect quality data while performing a
completion transaction or a workorder-less
completion in Oracle WIP.

True or False

• You can collect quality data while performing a
completion transaction or a workorder-less
completion in Oracle WIP.

Review QuestionReview Question
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True or False

• You can collect quality data while performing a
completion transaction or a workorder-less
completion in Oracle WIP.

Answer:
True

True or False

• You can collect quality data while performing a
completion transaction or a workorder-less
completion in Oracle WIP.

Answer:
True

Review SolutionReview Solution
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Ship finished goods

Ship goods

Complete finished
assemblies

Create repetitive
schedules

Planner plans production

Shop floorShop floor
Move assemblies andMove assemblies and

charge resourcescharge resources

Finished goods
subinventory

Customer

Issue material
• Raw material
• Components
• Subassemblies

Stockroom

PlanPlanner

Begin
production



Copyright © Oracle Corporation, 2000. All rights reserved.

Completing Jobs and Repetitive Schedules
Chapter 9 - Page 53

Completion Transactions for Repetitive Schedules

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Completion Transactions for Repetitive
Schedules

Completion Transactions for Repetitive
Schedules

You can roll forward excess components on a
schedule to a subsequent schedule.
You can roll forward excess components on a
schedule to a subsequent schedule.

S1
Total quantity =

400

S2
Total quantity =

200

1 2 3 4 5 6 7 8 9 10 11 12 13 Days

100

50

Units/day RollforwardRollforward Example Example

Rollforward Rules
•  When all assemblies of a schedule are completed, Oracle Work in Process checks the
schedule for any excess components resulting from overissue of material requirements.
•  If the subsequent schedule is released, or if it is unreleased and falls into the autorelease
time fence, Oracle Work in Process rolls the excess material charges forward to that
schedule.
•  If there is no subsequent schedule to autorelease, Oracle Work in Process does not roll
the excess material charges forward.
Overissue Examples
•  Push a quantity greater than the quantity required based on the total quantity on the
assembly times (the component usage divided by the component yield), because you
issue in daily or weekly buckets, and not by exact schedule quantity.
•  Reduce the schedule quantity on a schedule after you already issued all the components
to meet the material requirements. For example:

Prior schedule quantity = 1,000  Component usage/component yield = 2/1 = 2
Prior required quantity = 1,000 * 2 = 2,000
New schedule quantity = 800  New required quantity = 1,600

•  Issue additional components on the fly without ever creating corresponding material
requirements. For example:

Quantity required = 0  Quantity issued = 10
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Rollforward Example

Component Required
Qty for S1

COMP1 800

Qty Issued
to S1

850

Required
Qty for S2

400

Qty Rolled
Forward to S2

50

COMP2 400 400 200 0

COMP3 400 420 N/A 20

Examples
•  Both S1 and S2 are released.
•  Oracle Work in Process rolls forward the extra 50 COMP1 issued to S1 to S2 because
COMP1 is a requirement for S2 and S2 is released.
•  Oracle Work in Process also rolls forward the extra 20 COMP3 issued to S1 to S2 and
creates a requirement for COMP3 on the S2 schedule with a quantity required of 0.
• Note: You also have the option of rolling forward issued material if you are canceling a
schedule.
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With Oracle Work in Process, you can streamline your
repetitive production by automatically releasing the
next schedule when one schedule is completed.
• You may want to continue running your line and

building your repetitive assembly if another
schedule is defined for the assembly on that line.

• If the schedule is defined but unreleased, the
completion of the preceding schedule can serve
as a signal to automatically release the next
unreleased schedule.

With Oracle Work in Process, you can streamline your
repetitive production by automatically releasing the
next schedule when one schedule is completed.
• You may want to continue running your line and

building your repetitive assembly if another
schedule is defined for the assembly on that line.

• If the schedule is defined but unreleased, the
completion of the preceding schedule can serve
as a signal to automatically release the next
unreleased schedule.
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Stop repetitive schedules and
analyze repetitive costs

Stop repetitive schedules

Analyze repetitive costs
B

ENDEND

5

A

Status Change
You can stop a repetitive schedule to indicate that the schedule has reached its expected
production.
•  A schedule automatically stops when the number of assemblies completed in a WIP
completion transaction equals the number of assemblies planned. The status of the
schedule changes to Complete—No Charges if there is a subsequent schedule on the
same line for the same assembly, or to complete if it is the last schedule.
•  You can stop a schedule at any time manually by switching its status to Canceled.
•  Unlike discrete jobs, repetitive schedules cannot be closed.
•  You can change the status of a complete schedule to Canceled or Complete—No
Charges to prevent any accidental charges to a schedule that is no longer needed.
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Discrete Life CycleDiscrete Life Cycle

Set up discrete manufacturingSet up discrete manufacturing
1

Define discrete jobsDefine discrete jobs
2

Update discrete jobsUpdate discrete jobs
3

Build discrete jobsBuild discrete jobs
4

Close discrete jobsClose discrete jobs
5

What Happens When You Close a Job
You can close discrete jobs that need to be closed so that the system can calculate final
costs and variances automatically. During the close process, the job status becomes
Pending Close. When the job close process succeeds, further activity on the job is
prevented and the status of the job becomes Closed—No Charges.
The system removes any remaining costs from the job by creating journal entries that
charge remaining job costs to the variance accounts.
Assuming a positive balance in the job at the end of the close, here are the accounting
entries for a job close:

Account Debit Credit
WIP accounting class variance accounts   XX 
WIP accounting class valuation accounts    XX 

The remaining balance in the job is zero.

What Should You Do Before Closing a Job?
You should verify that all transactions were performed correctly using the Discrete Job
Value report (because Oracle Work in Process cannot close a job with pending
transactions).  View the transactions from the Discrete Jobs window.
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Absorption accountsAbsorption accounts

Inventory
elemental
accounts

Inventory
elemental
accounts

WIP
variance
accounts

WIP
variance
accounts

Work in Process
valuation accounts
Work in Process

valuation accounts

Nonstandard asset job

Nonstandard expense job

Repetitive schedule

Standard discrete job

ResourceResource
chargescharges

OverheadOverhead
chargescharges

Standard cost
adjustment account

Standard cost
adjustment account Scrap accountScrap account

CostCost
updateupdate
transactiontransaction

AssemblyAssembly
scrapscrap
transactiontransaction

MaterialMaterial
transactionstransactions JobJob

closeclose

Period closePeriod close

Assembly Completion TransactionsAssembly Completion Transactions

What Happens after You Close a Job?
You can still view job information in the View Discrete Jobs window and Discrete Jobs
window.
Can the Status of a Closed Job Be Changed?
•  To be able to unclose jobs, the Close Discrete Jobs function security parameter must be
set to Y.
•  Only jobs closed in error should be unclosed, and you should do this immediately after
the close using the Close Discrete Jobs window.
•  If assembly costs are rolled up between the time you close and unclose a job, your costs
may be incorrect because the unclose process does not revalue the job.
•  You cannot unclose a job that is linked to a sales order.
•  You cannot unclose a job that was closed in an accounting job that is no longer open.
• What Happens If the Job Close Process Fails?
• The job is assigned a status of Failed Close.  You can examine jobs that could not be
closed using the concurrent request log file.  You can resubmit jobs that could not be
closed.
• Flow Charging
• When you enter repetitive transactions, you charge the repetitive assembly and line
rather than a specific job. Therefore you can also see repetitive costs consolidated across
all schedules for an assembly on a line.
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Period Costing
•  You can use the Inventory Accounting Period window in Oracle Inventory to close a
period and perform period costing for your repetitive production.
•  Period costs for an assembly are calculated by totaling the charges made during the
period and dividing that number by the number of assemblies completed in the period.
•  The difference between the period cost and the standard cost is called a variance.
•  Oracle Work in Process writes variances to the variance accounts associated with the
WIP accounting classes assigned to the assembly/line combination for which a repetitive
schedule was defined.
•  You can use the parameter Recognize Repetitive Variances to control whether your
variances at period end are based only on completed and canceled schedules or on all
schedules.



Copyright © Oracle Corporation, 2000. All rights reserved.

Completing Jobs and Repetitive Schedules
Chapter 9 - Page 61

Close Discrete Job Form

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Close Discrete Job FormClose Discrete Job Form

Use the Close Discrete Jobs Summary window to:
• close discrete jobs
• resubmit jobs that failed to close
• unclose Jobs

Use the Close Discrete Jobs Summary window to:
• close discrete jobs
• resubmit jobs that failed to close
• unclose Jobs

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Close Discrete Jobs > Close Discrete Jobs (Form)

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Close Discrete Jobs > Close Discrete Jobs (Form)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Discrete Manufacturing > Discrete Job Close >Closing Discrete Jobs
Technical Note
Closing a discrete job is an accounting close. It is independent of the manufacturing close
(completed all transactions against the job), but once the accounting close is done, you
can no longer perform transactions against the job.
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Close Discrete Jobs
Standard Request Submission (SRS)

Use the Close Discrete Jobs window to enter the
parameters to close a single job or a range of jobs.
Use the Close Discrete Jobs window to enter the
parameters to close a single job or a range of jobs.

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Close Discrete Jobs > Close Discrete Jobs (SRS)

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Close Discrete Jobs > Close Discrete Jobs (SRS)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Reports and Processes > Closing Jobs Using Submit Requests
Window Characteristics
•  You use the same window to close both standard and nonstandard discrete jobs.
•  You can enter selection criteria to close several jobs at the same time. For example, you
can choose to close all complete jobs by entering that status in the Status field.
•  You can specify a submission date and time in the Run Option region. For example, you
might want to run this process during off hours to prevent the additional computing load
from slowing down your system.
•  It is good practice to review jobs that are to be closed before closing them using the
View Discrete Jobs window or discrete job reports.
• Note
• The window launches a concurrent process that optionally purges all details and move
and resource transactions for closed jobs.
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Use the Purge Discrete Jobs Summary window to
select which closed jobs or information from closed
jobs will be purged.

Use the Purge Discrete Jobs Summary window to
select which closed jobs or information from closed
jobs will be purged.

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Purge Discrete Jobs > Purge Discrete Jobs (Form)

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Purge Discrete Jobs > Purge Discrete Jobs (Form)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Discrete Manufacturing > Discrete Job Purge > Purging Discrete Jobs

... > Purging Jobs and Schedules

... > Specifying Purge Options

... > Processing Pending Jobs and Schedules

... > Standard versus Non-Standard Discrete Jobs
Purge Discrete Jobs Summary
You can purge discrete jobs using the SRS window or the Purge Discrete Jobs window.
You have the following reporting options when you purge from the Purge Discrete Jobs
window:
•  Full: Provides a detailed report
•  Summary: Provides a summarized report
•  Exception: Reports only exceptions that are raised as a result of the purge operation
•  None: Listing only the purge options selected
• You can choose the following purge options:
•  Report Only
•  Purge and Report
•  Purge Only
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Use the Purge Repetitive Schedules Summary
window to select which schedules or information
from the schedules will be purged.

Use the Purge Repetitive Schedules Summary
window to select which schedules or information
from the schedules will be purged.

(N) Manufacturing & Distribution Manager > WIP > Repetitive >
Purge Repetitive Schedules > Purge Schedules (Form)

(N) Manufacturing & Distribution Manager > WIP > Repetitive >
Purge Repetitive Schedules > Purge Schedules (Form)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Repetitive Manufacturing > Repetitive Schedule Purge > Purging Repetitive
Schedules

... > Purging Jobs and Schedules

... > Specifying Purge Options

... > Processing Pending Jobs and Schedules
Purge Repetitive Schedules Summary
You can purge repetitive schedules using the SRS window or the Purge Repetitive
Schedules window. When you purge from the Purge Repetitive Schedules window, you
have the following reporting options:
•  Full: Provides a detailed report
•  Summary: Provides a summarized report
•  Exception: Reports only exceptions that are raised as a result of the purge operation
•  None: Lists only the purge options selected
• You can choose the following purge options:
•  Report Only
•  Purge and Report
•  Purge Only
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Purging Jobs and Schedules
 Standard Request Submission (SRS)

Use the Purge Jobs and Schedules window to submit
the request to purge the information selected in the
Purge Discrete Jobs window.

Use the Purge Jobs and Schedules window to submit
the request to purge the information selected in the
Purge Discrete Jobs window.

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Purge Discrete Jobs > Purge Discrete Jobs (SRS)

(N) Manufacturing & Distribution Manager > WIP > Discrete >
Purge Discrete Jobs > Purge Discrete Jobs (SRS)

(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Reports and Processes > Purging Jobs and Schedules
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InventoryInventory

Raw materialRaw material
inventoryinventory

Finished goodsFinished goods
subinventorysubinventory

Work in ProcessWork in Process

Jobs andJobs and
schedulesschedules

Scrap rejected
assemblies

Scrap rejected
assemblies

IssueIssue
materialmaterial

CompleteComplete
finishedfinished

assembliesassemblies Move Assemblies on
the shop floor and 
charge resources

Move Assemblies on
the shop floor and 
charge resources

Completing JobsCompleting Jobs

Completing Assemblies
•  You can use one of four data-entry methods to complete assemblies to inventory or
return assemblies to WIP: the Completion Transactions window, the Move Transactions
window, the Material Transaction Interface table, or the Workorder-less Completions
window.
•  Assembly pull component backflushes are initiated by WIP completion transactions.
•  You can roll forward extra material from one schedule to the next upon completion.
•  You can overcomplete discrete jobs or repetitive schedules.
•  You can return completed assemblies to work in process using the Completion
Transactions window.
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What are some reasons Oracle Work in Process
would prevent you from performing a
completion transaction?

What are some reasons Oracle Work in Process
would prevent you from performing a
completion transaction?
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What are some reasons Oracle Work in Process
would prevent you from performing a
completion transaction?

– There is no available quantity in the To Move
step of the last operation in the routing.

– There is a shop floor status preventing
movement from the To Move step of the last
operation in the routing.

– The job/schedule status prevents transactions.
– The item is not transactable.

What are some reasons Oracle Work in ProcessWhat are some reasons Oracle Work in Process
would prevent you from performing awould prevent you from performing a
completion transaction?completion transaction?

– There is no available quantity in the To Move
step of the last operation in the routing.

– There is a shop floor status preventing
movement from the To Move step of the last
operation in the routing.

– The job/schedule status prevents transactions.
– The item is not transactable.
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After completing this course you should be able to do
the following:
• Describe the difference between Outside

Processing and Manufacturing Collaboration
• Explain why Manufacturing Collaboration is a

business solution
• Identify the key integration points
• Execute the setup steps for Manufacturing

Collaboration

After completing this course you should be able to do
the following:
• Describe the difference between Outside

Processing and Manufacturing Collaboration
• Explain why Manufacturing Collaboration is a

business solution
• Identify the key integration points
• Execute the setup steps for Manufacturing

Collaboration
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Manufacturing Collaboration

• Using Manufacturing Collaboration
• Identifying how Manufacturing Collaboration is

accomplished
• Identifying key integration points
• Setting up Manufacturing Collaboration
• Automating Manufacturing Collaboration
• Demonstrating Manufacturing Collaboration
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ReceiveReceive

assembliesassemblies

texttext

ShipShip
assembliesassemblies

ChargeCharge
outsideoutside
resourceresource

RequisitionRequisition
outsideoutside

processing itemprocessing item

Move toMove to
queuequeue
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queuequeue

Supplier
warehouse

Auto-Auto-
requisitionrequisition

PurchasePurchase
receiptreceipt

Op seq 20Op seq 20 Op seq 30Op seq 30 Op seq 40Op seq 40

Receive outsideReceive outside
processing itemprocessing itemor PO releaseor PO release

Define PODefine PO

Physical flowPhysical flow Transaction flowTransaction flow
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Outside Processing is performing work on a discrete
job or repetitive schedule using resources provided
by a supplier.

Outside Processing is performing work on a discrete
job or repetitive schedule using resources provided
by a supplier.

Manufacturer Supplier

Oracle Purchasing
You can purchase and receive items through the use of requisitions and purchase
orders.
Oracle Work in Process
•  You can manage the assembly flow.
•  You can schedule, transact, and cost resources.
•  You can control supplier-supplied components.
• In advance of your day-to-day outside processing execution, you should take the
following steps:
•  Determine the need for outside service during production or process design
•  Identify and qualify specific suppliers
•  Create relationships and contracts with selected suppliers
•  Identify and create blanket purchase orders to handle contract volume by using
Oracle Purchasing
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Manufacturing Collaboration OverviewManufacturing Collaboration Overview
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Manufacturing Collaboration is the business
of coordinating production and scheduling between
manufacturer and outside processing suppliers.

Manufacturing Collaboration is the business
of coordinating production and scheduling between
manufacturer and outside processing suppliers.

Manufacturer

Supplier

Supplier

Overview
Manufacturing Collaboration is an approach to manufacturing that provides:

• improved and automated communication
• the linking activities between work orders and purchase orders
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Reasons why a manufacturer may outsource part of
their production:

• the supplier can complete the process more
efficiently

• the supplier can complete the process at a lower
cost

• production is outsourced when additional capacity
is needed (seasonal demand)

Reasons why a manufacturer may outsource part of
their production:

• the supplier can complete the process more
efficiently

• the supplier can complete the process at a lower
cost

• production is outsourced when additional capacity
is needed (seasonal demand)
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• Resource on routing represents supplier’s
resource

• Outside processing item on purchase order
represents supplier contribution

• The outside processing item is linked to the
resource on the routing so that a one-to-one
relationship exists

• Resource on routing represents supplier’s
resource

• Outside processing item on purchase order
represents supplier contribution

• The outside processing item is linked to the
resource on the routing so that a one-to-one
relationship exists
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Collaboration
is more than

Outside Processing...

Manufacturing CollaborationManufacturing Collaboration
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business solution!

Manufacturing
Collaboration

is a
business solution!

Business SolutionBusiness Solution

Outside Processing Enhancements
The outside processing enhancements listed below are designed to improve
usability and save time:
•  Automatic completions
•  Create requisition options
•  Item revision
•  Need-by-date
•  Web supplier integration



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 13

Describing the Differences

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Describing the DifferencesDescribing the Differences

• Integration with the internet supplier portal
– makes it easier to collaborate with your

supplier
– provides suppliers with greater access to

information that affects them
• Automated notifications using workflow reduces

the need to make calls or use a fax

• Integration with the internet supplier portal
– makes it easier to collaborate with your

supplier
– provides suppliers with greater access to

information that affects them
• Automated notifications using workflow reduces

the need to make calls or use a fax
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How is Manufacturing Collaboration accomplished?
• Integration between Work in Process and

Purchasing
• Leveraging the strengths of workflow and the

internet supplier portal

How is Manufacturing Collaboration accomplished?
• Integration between Work in Process and

Purchasing
• Leveraging the strengths of workflow and the

internet supplier portal

PO

ISP WF

WIP

Integration Flow
a)  Manufacturer creates a work order in WIP.  This launches Requisition Import
in Purchasing.
b) A purchase order needs to be created and approved if a there is not an approved
blanket po.  The movement of the assemblies into the queue step of the outside
processing operation starts an ASN  to the supplier.  When the supplier is finished
with the work, the Internet Supplier Portal is used by the Supplier to create and
submit an ASN or ASBN
c)  The ASN creates the logical receipt of the assemblies and moves the
assemblies to the next operation if there are two or more sequential outside
processing operations in the routing
d)  The ASN also launches the WIP: Shipping and Receiving Intermediate
workflow which allows the Buyer, Production Manager and the Second Supplier
to communicate about the quantity of assemblies shipped and received as well as
their condition upon receipt
e)  The process continues until the ASN is submitted at the final outside
processing operation.  The receipt of the assemblies will create both the delivery
into wip and the subsequent movement of the assemblies into a sub-inventory if a
sub-inventory is defined at the routing or job level.
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ExampleExample

Op

10

20

Resource

supplier #1

supplier #2

Dept

out1

out2

WIP routing is as follows:WIP routing is as follows:
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Example (continued)Example (continued)

Time to execute - manufacturing site
• Create work order in a status of released
• Requisition import is executed and requisition is

created; blanket release created in a status of
approved

• Component parts issued to wip and physically
shipped to supplier #1

Time to execute - manufacturing site
• Create work order in a status of released
• Requisition import is executed and requisition is

created; blanket release created in a status of
approved

• Component parts issued to wip and physically
shipped to supplier #1

POWIP Supplier #1
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Example (continued)Example (continued)

Supplier #1 completes operation 10Supplier #1 completes operation 10

WIPSupplier #1
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Example (continued)Example (continued)

Back to the manufacturer
• Buyer responds to the notification
• Notification is sent tot the second supplier

– Second supplier responds as to how many
were received

– Response is sent to buyer with the quantity
received

Back to the manufacturer
• Buyer responds to the notification
• Notification is sent tot the second supplier

– Second supplier responds as to how many
were received

– Response is sent to buyer with the quantity
received

Buyer
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Example (continued)Example (continued)

Suppler #2 finishes the process
• Supplier #2 creates an ASN or ASBN; ASN creation

notification is sent to buyer
• Supplier #2 physically ships the assemblies back

to the manufacturer
• Optionally, quality data can be entered

Suppler #2 finishes the process
• Supplier #2 creates an ASN or ASBN; ASN creation

notification is sent to buyer
• Supplier #2 physically ships the assemblies back

to the manufacturer
• Optionally, quality data can be entered

WIP
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Example (continued)Example (continued)

Back to the manufacturer
• Buyer receives ASN Creation Notification

– Receiving Transaction Processor is run
– Receiver receives the assemblies
– Delivery on system is to wip job

• Work order continues

Back to the manufacturer
• Buyer receives ASN Creation Notification

– Receiving Transaction Processor is run
– Receiver receives the assemblies
– Delivery on system is to wip job

• Work order continues
WIP
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Example (continued)Example (continued)

Back to the manufacturer (continued)
• Work order is completed, reviewed, and closed
• Invoice is created and processed in AP

Back to the manufacturer (continued)
• Work order is completed, reviewed, and closed
• Invoice is created and processed in AP
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Internet Supplier PortalInternet Supplier Portal

What information is available?
• Purchase order
• Receipt
• Invoice
• Quality data
• Component information on a job

What information is available?
• Purchase order
• Receipt
• Invoice
• Quality data
• Component information on a job
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Additional Capabilities of WorkflowAdditional Capabilities of Workflow

• Supplier can update capacity information
– workflow notification sent to buyer
– used in the sourcing process

• Supplier can update promise date on PO
– workflow notification sent to buyer
– buyer must accept

• Manufacturer can change the need by date on PO
– workflow notification sent to buyer and

supplier
– if supplier accepts change; PO is updated

• Supplier can update capacity information
– workflow notification sent to buyer
– used in the sourcing process

• Supplier can update promise date on PO
– workflow notification sent to buyer
– buyer must accept

• Manufacturer can change the need by date on PO
– workflow notification sent to buyer and

supplier
– if supplier accepts change; PO is updated
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Review QuestionReview Question

The Internet Supplier Portal gives the supplier
instant access to information in the manufacturers
system.  Which of the following can not be viewed
through the portal?
A. Purchase order
B. Quality data
C. Quantity delivered
D. Resources used in the job

The Internet Supplier Portal gives the supplier
instant access to information in the manufacturers
system.  Which of the following can not be viewed
through the portal?
A. Purchase order
B. Quality data
C. Quantity delivered
D. Resources used in the job
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Answer to Review QuestionAnswer to Review Question

The Internet Supplier Portal gives the supplier
instant access to information in the manufacturers
system.  Which of the following can not be viewed
through the portal?
A. Purchase order
B. Quality data
C. Quantity delivered
D. Resources used in the job

The Internet Supplier Portal gives the supplier
instant access to information in the manufacturers
system.  Which of the following can not be viewed
through the portal?
A. Purchase order
B. Quality data
C. Quantity delivered
D. Resources used in the job
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Review QuestionReview Question

How is the need-by-date for a purchase requisition at
an OSP operation determined?
A. Start date of the current operation
B. Start date of the next operation
C. Start date of the job
D. Start time of previous operation plus OSP resource

lead time

How is the need-by-date for a purchase requisition at
an OSP operation determined?
A. Start date of the current operation
B. Start date of the next operation
C. Start date of the job
D. Start time of previous operation plus OSP resource

lead time
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Answer to Review QuestionAnswer to Review Question

How is the need-by-date for a purchase requisition at
an OSP operation determined?
A. Start date of the current operation
B. Start date of the next operation
C. Start date of the job
D. Start time of previous operation plus OSP resource

lead time

How is the need-by-date for a purchase requisition at
an OSP operation determined?
A. Start date of the current operation
B. Start date of the next operation
C. Start date of the job
D. Start time of previous operation plus OSP resource

lead time
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Review QuestionReview Question

You can change the need-by-date on a purchase
order and have a workflow triggered which sends
notification to the supplier.  Which navigation path
would be used to update the need-by-date?
A. WIP > Discrete > Discrete Jobs (M) Tools
B. WIP > Job/Schedule Details > Material

Requirements (M) Tools
C. WIP > Discrete > View Discrete Jobs (M) Tools
D. WIP > Job/Schedule Details > Operations (M) Tools

You can change the need-by-date on a purchase
order and have a workflow triggered which sends
notification to the supplier.  Which navigation path
would be used to update the need-by-date?
A. WIP > Discrete > Discrete Jobs (M) Tools
B. WIP > Job/Schedule Details > Material

Requirements (M) Tools
C. WIP > Discrete > View Discrete Jobs (M) Tools
D. WIP > Job/Schedule Details > Operations (M) Tools
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Answer to Review QuestionAnswer to Review Question

You can change the need-by-date on a purchase
order and have a workflow triggered which sends
notification to the supplier.  Which navigation path
would be used to update the need-by-date?
A. WIP > Discrete > Discrete PBS (M) Tools
B. WIP > Job/Schedule Details > Material

Requirements (M) Tools
C. WIP > Discrete > View Discrete Jobs (M) Tools
D. WIP > Job/Schedule Details > Operations (M) Tools

You can change the need-by-date on a purchase
order and have a workflow triggered which sends
notification to the supplier.  Which navigation path
would be used to update the need-by-date?
A. WIP > Discrete > Discrete PBS (M) Tools
B. WIP > Job/Schedule Details > Material

Requirements (M) Tools
C. WIP > Discrete > View Discrete Jobs (M) Tools
D. WIP > Job/Schedule Details > Operations (M) Tools
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Key Integration PointsKey Integration Points

PO

ISP WF

WIP

INV

AP

MRP

BOM

Cost
GL

111

222

333

666

555

444

999

888

777

101010

WIP Routing

Op Dept
10 out1

20 out2
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Key Setups - InventoryKey Setups - Inventory

Assembly Outside Processing Item

Item/Part number Item/Part number
(inventory item) (supplier contribution)

Planning Purchasing

WIP Receiving
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Assigning a PlannerAssigning a Planner

Use the Organization Item window to assign the
planner to the assembly for planning.
Use the Organization Item window to assign the
planner to the assembly for planning.

(N) Oracle Inventory > Items > Organization Items
(T) General Planning
(N) Oracle Inventory > Items > Organization Items
(T) General Planning

Assign a Planner
Create the item you are building in WIP and assign a planner to the assembly
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items
> Updating Organization Level Items
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Defining Planning AttributesDefining Planning Attributes

Use the Organization Item window to define MRP/MPS
planning attributes for your assembly.
Use the Organization Item window to define MRP/MPS
planning attributes for your assembly.

(N) Oracle Inventory > Items > Organization Items
(T) MPS/MRP Planning
(N) Oracle Inventory > Items > Organization Items
(T) MPS/MRP Planning

Define Planning Attributes
Determine the release time fence for your assembly
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items
> Updating Organization Level Items
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Verifying WIP AttributesVerifying WIP Attributes

Use the Organization Item window to verify that WIP
attributes have been set for the assembly being
manufactured.

Use the Organization Item window to verify that WIP
attributes have been set for the assembly being
manufactured.

(N) Oracle Inventory > Items > Organization Items
(T) Work in Process
(N) Oracle Inventory > Items > Organization Items
(T) Work in Process

Verify WIP Attributes
Verify the the attribute Build in WIP has been checked
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items
> Updating Organization Level Items
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Setting Purchasing AttributesSetting Purchasing Attributes

Use the Organization Item window to set the
purchasing attributes for the outside processing
items at each OSP operation.

Use the Organization Item window to set the
purchasing attributes for the outside processing
items at each OSP operation.

(N) Oracle Inventory > Items > Organization Items
(T) Purchasing
(N) Oracle Inventory > Items > Organization Items
(T) Purchasing

Set Purchasing Attributes
Create items representing the supplier contribution at each OSP operation
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items
> Updating Organization Level Items
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Setting Receiving AttributesSetting Receiving Attributes

Use the Organization Item window to create an item
and set the receiving attributes for each OSP item.
Use the Organization Item window to create an item
and set the receiving attributes for each OSP item.

(N) Oracle Inventory > Items > Organization Items
(T) Purchasing
(N) Oracle Inventory > Items > Organization Items
(T) Purchasing

Set Receiving Attributes
Determine the receipt routing for each OSP item
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items
> Updating Organization Level Items
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Key Setups - BOMKey Setups - BOM

• Outside Processing Resource
– charge type of po move or po receipt
– outside processing enabled
– establish the relationship with purchasing
– determine if resource is to be costed
– charge to wip at either standard or actual
– define absorption and variance accounts (both

default from the org level parameters)

• Outside Processing Resource
– charge type of po move or po receipt
– outside processing enabled
– establish the relationship with purchasing
– determine if resource is to be costed
– charge to wip at either standard or actual
– define absorption and variance accounts (both

default from the org level parameters)
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Key Setups - BOM (continued)Key Setups - BOM (continued)

• Departments
– location is the address for delivery to either

the manufacturer or second supplier
– determine if uncompleted assembly is coming

back or going to another supplier

• Routing - completion sub-inventory for automatic
completion

• BOM - supply type of operation pull for
components needed at OSP operation

• Departments
– location is the address for delivery to either

the manufacturer or second supplier
– determine if uncompleted assembly is coming

back or going to another supplier

• Routing - completion sub-inventory for automatic
completion

• BOM - supply type of operation pull for
components needed at OSP operation
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Creating a ResourceCreating a Resource

Use the Resources window to create a supplier’s
resource for each operation.
Use the Resources window to create a supplier’s
resource for each operation.

(N) Oracle Inventory > Bills of Materials > Routings
 > Resources

(N) Oracle Inventory > Bills of Materials > Routings
 > Resources

Create a Resource
Create a resource representing the supplier’s resource for each operation
•  In this form:

• OSP item is linked to outside processing resource
• the resource will be charged to WIP at standard or actual rate

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Routings > Setting Up > Defining a Resource
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Entering a LocationEntering a Location

Use the Location window to enter address
information of the suppliers where the assemblies are
to be delivered.

Use the Location window to enter address
information of the suppliers where the assemblies are
to be delivered.

(N) Oracle Inventory > Bills of Materials > Setup
 > Locations

(N) Oracle Inventory > Bills of Materials > Setup
 > Locations

Enter a Location
Create a location representing the address of where the assemblies are to be
delivered.
(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining Locations
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Defining a DepartmentDefining a Department

Use the Departments window to define departments
within your organization that represents each outside
supplier.

Use the Departments window to define departments
within your organization that represents each outside
supplier.

(N) Oracle Inventory > Bills of Materials > Routings
 > Departments

(N) Oracle Inventory > Bills of Materials > Routings
 > Departments

Define a Department
Create a department for each of your outside suppliers
Note:  For more information on defining and linking Locations and Departments,
see the Oracle Purchasing User’s Guide Release 11i.
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Setting Up > Defining a Department
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Assigning Resources to DepartmentsAssigning Resources to Departments

Use the Resources window from the Departments
window to establish the relationship between the
resources and the departments.

Use the Resources window from the Departments
window to establish the relationship between the
resources and the departments.

(N) Oracle Inventory > Bills of Materials > Routings
 > Departments (B) Resources

(N) Oracle Inventory > Bills of Materials > Routings
 > Departments (B) Resources

Assign Resources to Departments
Assign all your resources to their respective departments
Note:  A Queue Resource can be set up to represent time at the OSP supplier to
calculate the lead time without impacting cost.
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Setting Up > Assigning Resources to a Department
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Creating a RoutingCreating a Routing

Use the Routings window to link operations in a
sequence.
Use the Routings window to link operations in a
sequence.

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings

Create a Routing
Create a routing for the assembly
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Routings > Defining a Routing > Creating a Routing



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 44

Selecting Resources for an Operation  in a Routing

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Selecting Resources for an Operation
 in a Routing

Selecting Resources for an Operation
 in a Routing

Use the Operation Resources window to link the
required resources to the department in the routing.
Use the Operation Resources window to link the
required resources to the department in the routing.

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Operation Resources

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Operation Resources

Select Resources for an Operation
Select the required resources for this operation routing
•  The usage represents the cost per assembly fir the OSP resource
•  The time to be scheduled is calculated by setting up a queue resource which is
defined as scheduled and uncosted.
 (Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Routings > Defining a Routing > Assigning Operation Resources
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Verifying Charge TypeVerifying Charge Type

Use the Operation Resources window to verify what
the charge type is set to for a resource.
Use the Operation Resources window to verify what
the charge type is set to for a resource.

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Operation Resources

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Operation Resources

Verify Charge Type
Verify the OSP resource has a charge type set to PO Move or PO receipt.  This
tells the system whether or not to move the assemblies to the next operation upon
receipt.
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Routings > Defining a Routing > Assigning Operation Resources
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Assigning a Completion Sub-InventoryAssigning a Completion Sub-Inventory

Use the Routing Details window to assign a
completion sub-inventory where finished assemblies
are stored.

Use the Routing Details window to assign a
completion sub-inventory where finished assemblies
are stored.

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Routing Details

(N) Oracle Inventory > Bills of Materials > Routings
 > Routings (B) Routing Details

Assign a Completion Sub-Inventory
Assign a completion sub-inventory to the assembly.  This will allow the
assemblies to be completed directly into a sub-inventory if the last operation is an
OSP operation and the charge type is PO Move.
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Routings > Defining a Routing >Assigning a Completion
Subinventory and Locator
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Creating a Bill of MaterialCreating a Bill of Material

Use the Bills of Material window to identify the
components of the bill which are supplied by the
manufacturer.

Use the Bills of Material window to identify the
components of the bill which are supplied by the
manufacturer.

(N) Oracle Inventory > Bills of Materials > Bills > Bills(N) Oracle Inventory > Bills of Materials > Bills > Bills

Create a Bill of Material
Create a bill of material if there are parts which are supplied by the manufacturer
from the sub-inventory
Note: The supply type determines the timing of the issuance of the material.
(Help) Oracle Manufacturing Applications > Oracle Bills of Materials
> Bills of Material > Defining a Bill of Material > Creating a Bill of
Material
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Key Setups - PurchasingKey Setups - Purchasing

• Required
– Shipping network location at supplier site -

address of next supplier where assemblies are
shipped

– Supplier contact for workflow and internet
supplier portal

• Optional (to create more automated flow)
– Supplier site as pay on receipt
– Receipt routing
– Blanket PO
– Approved supplier list
– Sourcing rules

• Required
– Shipping network location at supplier site -

address of next supplier where assemblies are
shipped

– Supplier contact for workflow and internet
supplier portal

• Optional (to create more automated flow)
– Supplier site as pay on receipt
– Receipt routing
– Blanket PO
– Approved supplier list
– Sourcing rules
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Creating a Supplier SiteCreating a Supplier Site

Use the Supplier Sites window to create sites for each
OSP operation.
Use the Supplier Sites window to create sites for each
OSP operation.

(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) General
(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) General

Create a Supplier Site
Create a supplier site for each OSP operation.  Verify that each site is a pay and
purchasing site.
Note:  The Shipping Network Location represents the address of the second
supplier.  This is required for the workflow notifications and logical receipt.
(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Suppliers and
Supplier Sites Window Reference



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 50

Entering a Contact

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Entering a ContactEntering a Contact

Use the Supplier Sites window to enter contact(s) for
the outside suppliers.
Use the Supplier Sites window to enter contact(s) for
the outside suppliers.

(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) Contacts
(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) Contacts

Enter a Contact
Create a contact for each of the outside suppliers you created.
Note: This is needed for the two outside processing workflows
(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Suppliers and
Supplier Sites Window Reference
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Verifying Payment on ReceiptVerifying Payment on Receipt

Use the Supplier Sites window to verify that the
supplier site allows for payment on receipt.
Use the Supplier Sites window to verify that the
supplier site allows for payment on receipt.

(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) Purchasing
(N) Oracle Purchasing > Supply Base > Suppliers
(B) Sites (T) Purchasing

Verify Payment on Receipt
Verify that each supplier site allows for pay on receipt to allow for a more
automated flow.
(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Suppliers and
Supplier Sites Window Reference
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Entering a Blanket Purchase OrderEntering a Blanket Purchase Order

Use the Purchase Orders window to enter blanket
agreements for each OSP item.
Use the Purchase Orders window to enter blanket
agreements for each OSP item.

(N) Oracle Purchasing > Purchase Orders
 > Purchase Orders

(N) Oracle Purchasing > Purchase Orders
 > Purchase Orders

Enter a Blanket Purchase Order
Enter an approved blanket purchase order for the supplier contribution at each
operation to allow this process to be more automated.
Note: The type is Outside Processing.  OSP item must have revision.
•  Blanket agreements are not required
•  Standard PO can be auto-created using an approved requisition
• (Help) Oracle Manufacturing Applications > Oracle Purchasing >
Purchase Orders > Purchase Order Types
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Adding to the Approved Supplier ListAdding to the Approved Supplier List

Use the Approved Supplier List window to add the
OSP Suppliers.
Use the Approved Supplier List window to add the
OSP Suppliers.

(N) Oracle Purchasing > Supply Base > Approved
Supplier List

(N) Oracle Purchasing > Supply Base > Approved
Supplier List

Add to the Approved Supplier List
Add the OSP suppliers to the approved supplier list for better automated
processing.
Note: Supplier status should be approved.
(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Approved Supplier List
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Defining AttributesDefining Attributes

Use the Supplier Item Attributes window to enter item
attributes from the Approved Supplier List.
Use the Supplier Item Attributes window to enter item
attributes from the Approved Supplier List.

(N) Oracle Purchasing > Supply Base > Approved
Supplier List (B) Attributes

(N) Oracle Purchasing > Supply Base > Approved
Supplier List (B) Attributes

Define Attributes
Choose a Release Method from the list of values.  Indicate the blanket po for
sourcing.
(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Defining the Supplier/Item Attributes
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Defining Sourcing RulesDefining Sourcing Rules

Use the Sourcing Rules window to define where to
source the supplier contribution portion of the
assembly.

Use the Sourcing Rules window to define where to
source the supplier contribution portion of the
assembly.

(N) Oracle Purchasing > Supply Base > Sourcing
Rules

(N) Oracle Purchasing > Supply Base > Sourcing
Rules

Define Sourcing Rules
Create a sourcing rule for each outside processing supplier.
Note:  For more information on sourcing rules, see the Oracle Purchasing User’s
Guide Release 11i.
(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Defining Sourcing Rules
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Assigning Sourcing RulesAssigning Sourcing Rules

Use the Sourcing Rules : Bill of Distribution
Assignments window to assign the sourcing rules to
the MRP assignment set.

Use the Sourcing Rules : Bill of Distribution
Assignments window to assign the sourcing rules to
the MRP assignment set.

(N) Oracle Purchasing > Supply Base > Assign
Sourcing Rules

(N) Oracle Purchasing > Supply Base > Assign
Sourcing Rules

Assign Sourcing Rules
Use the profile option MRP Default Assignment Set to see what assignment set is
being used by planning to allow for better automation of the process.
(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Assigning Sourcing Rules and Bills of
Distribution



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 57
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Key Setups - PlanningKey Setups - Planning

• Set up planner
• Preferences on Planner’s Workbench
• MPS production attribute
• Release time fence

• Set up planner
• Preferences on Planner’s Workbench
• MPS production attribute
• Release time fence
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Creating a Planner
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Creating a PlannerCreating a Planner

Use the Planners window to identify employees who
are assigned to planning schedules.
Use the Planners window to identify employees who
are assigned to planning schedules.

(N) Oracle Inventory > Setup > Planners(N) Oracle Inventory > Setup > Planners

Create a Planner
Create a planner for the assembly to be built in WIP.
Note:  For automation, not required.
(Help) Oracle Manufacturing Applications > Oracle Inventory >
Setting Up > Inventory Structure > Defining Planners
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Defining Planning Preferences
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Defining Planning PreferencesDefining Planning Preferences

Use the Preferences window off of the MPS Planners
Workbench to set planning preferences for outside
processing assemblies.

Use the Preferences window off of the MPS Planners
Workbench to set planning preferences for outside
processing assemblies.

(N) Oracle Material Planning > MPS > Workbench
(M) Tools > Preferences
(N) Oracle Material Planning > MPS > Workbench
(M) Tools > Preferences

Define Planning Preferences
The preferences will be determined by each planner, to determine how the job
status will be created in WIP.  A status of Released automates the process even
more.
Note:  Item planner on assembly is required
(Help) Oracle Manufacturing Applications > Oracle Master
Scheduling/MRP > Setting Up > Defining Planning Parameters
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Creating a Master Production ScheduleCreating a Master Production Schedule

Use the Mater Production Schedules window to enter
a production schedule for the assembly.
Use the Mater Production Schedules window to enter
a production schedule for the assembly.

(N) Oracle Material Planning > MPS > Names(N) Oracle Material Planning > MPS > Names

Create a Master Production Schedule
Create an master production schedule for your assembly based on MDS.
Note:  Production must be enabled in order for work orders to be created
automatically.
(Help) Oracle Manufacturing Applications > Oracle Master
Scheduling/MRP > Master Scheduling > Defining a Schedule Name
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Key Setups - Costs
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Key Setups - CostsKey Setups - Costs

• Cost Rollup
• Cost Update
• Cost Rollup
• Cost Update
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Viewing a Cost
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Viewing a CostViewing a Cost

Use the Item Costs Details window to view the cost
of an assembly.
Use the Item Costs Details window to view the cost
of an assembly.

(N) Oracle Cost > Item Costs > Item Costs (B) Open(N) Oracle Cost > Item Costs > Item Costs (B) Open

View a Cost
The outside processing cost element is used to hold the cost of the OSP resource.
(Help) Oracle Manufacturing Applications > Oracle Cost Management
> Item Costing > Defining Item Costs Details
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Key Setups - Quality
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Key Setups - QualityKey Setups - Quality

• Create a quality plan
• Select transaction type
• Create a quality plan
• Select transaction type
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Creating a Quality Plan
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Creating a Quality PlanCreating a Quality Plan

Use the Collection Plans window to define what
quality information you want to collect.
Use the Collection Plans window to define what
quality information you want to collect.

(N) Oracle Quality > Setup > Collection Plans(N) Oracle Quality > Setup > Collection Plans

Create a Quality Plan
Create a quality plan for any of the outside processing suppliers.
(Help) Oracle Manufacturing Applications > Oracle Quality >
Collection Plans > Creating Collection Plans
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Selecting Quality Collection Transactions
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Selecting Quality Collection TransactionsSelecting Quality Collection Transactions

Use the Collection Transactions window to select
 the quality transaction types.
Use the Collection Transactions window to select
 the quality transaction types.

(N) Oracle Quality > Setup > Collection Plans
(B) Transactions
(N) Oracle Quality > Setup > Collection Plans
(B) Transactions

Select Quality Collection Transactions
The transaction must be Self Service Outside Processing for the ISP to enter
quality data through the portal.
Note:  Plan must be enabled to be seen in the Internet Supplied Portal.
(Help) Oracle Manufacturing Applications > Oracle Quality >
Collection Plans > Quality Data Collection During Transactions
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Key Setups - WIP
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Key Setups - WIPKey Setups - WIP

• Requisition creation time
– At job/schedule release
– At operation
– Manually

• Job Roles for Shipping Notifications
– Production manager
– Shipping manager

• Overcompletion tolerance
• Completion sub-inventory at job/schedule

• Requisition creation time
– At job/schedule release
– At operation
– Manually

• Job Roles for Shipping Notifications
– Production manager
– Shipping manager

• Overcompletion tolerance
• Completion sub-inventory at job/schedule
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Setting Requisition Creation Time
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Setting Requisition Creation TimeSetting Requisition Creation Time

Use the Work in Process Parameters window to set
the timing for the creation of a requisition for the
outside processing item.

Use the Work in Process Parameters window to set
the timing for the creation of a requisition for the
outside processing item.

(N) Oracle WIP > Setup > Parameters (T) Outside    
Processing

(N) Oracle WIP > Setup > Parameters (T) Outside    
Processing

Create Requisition Options
You can automatically create requisitions for outside processing, when the job or
schedule is released, or when you move assemblies into an outside processing
operation. You also can require that purchase requisitions be created manually.
The default setup is to automatically create the requisition when you move into an
outside processing operation. This can be changed at the organization level
parameter.
Note:  Requisition import will be run based on the option you choose.
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Setting Up > Defining WIP Parameters
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Assigning Shipping Notifications
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Assigning Shipping NotificationsAssigning Shipping Notifications

Use the Work in Process Parameters window to
define the employees who will receive the shipping
notification.

Use the Work in Process Parameters window to
define the employees who will receive the shipping
notification.

(N) Oracle WIP > Setup > Parameters (T) Outside
Processing

(N) Oracle WIP > Setup > Parameters (T) Outside
Processing

Assign Shipping Notifications
Determine who should receive the shipping notifications when the assembly is
sent from supplier to supplier.
Note:  Must be valid employees in the HR tables.
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Setting Up > Defining WIP Parameters
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Defining Overcompletion Tolerances
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Defining Overcompletion TolerancesDefining Overcompletion Tolerances

Use the Work in Process Parameters: Other window
to enter the default overcompletion tolerance percent.
Use the Work in Process Parameters: Other window
to enter the default overcompletion tolerance percent.

(N) Oracle WIP > Setup > Parameters (T) Other(N) Oracle WIP > Setup > Parameters (T) Other

Default Overcompletion Tolerance %
A hierarchy is used to establish tolerances based on settings at different levels:
•  Organization level tolerances

Set in WIP parameters, are considered if no other tolerances are set at the item
level or at the discrete job level.

•  Item level tolerances
Set in the Inventory Item Attributes form by organization, are considered for
overcompletions, indicating tolerance type and tolerance value. If no item level
tolerances are established, organization level tolerances in WIP parameters are
considered.

•  Discrete job level
Set in the Discrete Job form in the More page.

 (Help) Oracle Manufacturing Applications > Oracle Work in Process
> Setting Up > Defining WIP Parameters



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 70

Modifying Completion Sub-Inventory
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Modifying Completion Sub-InventoryModifying Completion Sub-Inventory

Use the Discrete Jobs window to modify the default
completion sub-inventory defined on the routing.
Use the Discrete Jobs window to modify the default
completion sub-inventory defined on the routing.

(N) Oracle WIP > Discrete > Discrete Jobs (T) Routing(N) Oracle WIP > Discrete > Discrete Jobs (T) Routing

Modify Completion Sub-Inventory
The completion sub-inventory defaults from the routing but it can be changed at
the job/schedule level.
(Help) Oracle Manufacturing Applications > Oracle Work in Process >
Outside Processing > Outside Processing Setup and Planning >
Setting Up Work in Process
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Key Setups - System AdministrationKey Setups - System Administration

• User id’s for suppliers
• Securing attributes
• Responsibilities
• Supplier contact at supplier site level

• User id’s for suppliers
• Securing attributes
• Responsibilities
• Supplier contact at supplier site level
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Creating a User for Each Supplier
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Creating a User for Each SupplierCreating a User for Each Supplier

Use the Users window to create a user name to
identify each outside processing supplier and select
the responsibilities.

Use the Users window to create a user name to
identify each outside processing supplier and select
the responsibilities.

(N) Oracle System Administrator > Security >
User > Define (T) Responsibilities

(N) Oracle System Administrator > Security >
User > Define (T) Responsibilities

Create a User
The supplier field on the Create User window will be the supplier contact name.
Note:  The contact name is what the workflow will be looking for (this can be by
supplier or supplier site).
(Help) Oracle Manufacturing Applications > Oracle Applications
System Administration > Overview of Oracle Applications Security >
Users Window
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Defining Securing Attributes
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Defining Securing AttributesDefining Securing Attributes

Use the Users window to define the functions within
the Internet Supplier Portal that the suppliers will be
able to use.

Use the Users window to define the functions within
the Internet Supplier Portal that the suppliers will be
able to use.

(N) Oracle System Administrator > Security > User >
Define (T) Securing Attributes

(N) Oracle System Administrator > Security > User >
Define (T) Securing Attributes

Define Securing attributes
Securing attributes are what keep the suppliers within their own user information.
(Help) Oracle Manufacturing Applications > Oracle Applications
System Administration > Overview of Oracle Applications Security >
Users Window
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Automating Manufacturing Collaboration
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Automating Manufacturing CollaborationAutomating Manufacturing Collaboration

• Autorelease of planned orders with a status of
released

• Blanket PO’s with automatic release
• Requisition creation time of job/schedule release
• Charge type of PO Move on OSP resource
• Completion sub-inventory
• Pay on receipt - autoinvoice

• Autorelease of planned orders with a status of
released

• Blanket PO’s with automatic release
• Requisition creation time of job/schedule release
• Charge type of PO Move on OSP resource
• Completion sub-inventory
• Pay on receipt - autoinvoice
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Purchase  Order Flow
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Purchase
 Order Flow
Purchase

 Order Flow
Manually create

pending
requisitions

Manually create
pending

requisitions
Manually create
purchase orders
Manually create
purchase orders

Approve purchase
orders

Approve purchase
orders

View purchase
orders

View purchase
orders

Automatically
create pending

requisitions

Automatically
create pending

requisitions

Automatically
approve pending

requisitions

Automatically
approve pending

requisitions

Run requisition
import

Run requisition
import

AutoCreate
purchase orders

AutoCreate
purchase orders

Is resource
 linked to OSP item

Manually approve
pending

requisitions

Manually approve
pending

requisitions

Purchase Order Flow
Defining a Purchase Requisition
If you want to requisition an outside processing item not usually consumed by a
job or schedule, you can manually define a requisition in Oracle Purchasing and
link it to one or more jobs or schedules.
 Restrictions for Outside Processing
•  You cannot change the status of a job or schedule to Unreleased if the job or
schedule has an outside processing resource that is linked to a purchase
requisition or a purchase order.
•  You cannot delete outside processing operations or resources at those operations
if a purchase requisition or a purchase order has been created.
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Discussing Unit Types
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Discussing Unit TypesDiscussing Unit Types

Outside
Processing
Unit Type

Assembly

Resource

Charge Amount

(Move quantity
x Usage rate or

amount)

Receipt
quantity

Receipt Quantity

Move quantity

(Move quantity x
Usage rate or

amount)

UOM

EA

HR
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Discussing Unit Types (continued)
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Discussing Unit Types (continued)Discussing Unit Types (continued)

Std
Rate

10

Usage
Rate or
Amount

$2

10 $2

Transaction
Quantities

Receipt
Qty

Charge
Amount

50 EA (50 x 10) @ $2
= $1,000

500 HR (500HR @ $2)
= $1,000

Outside
Resource

Class Management Note
Can you backflush components under lot control at an outside operation with a
PO Move resource?
Answer: Yes, as long as you set the Backflush Lot Entry parameter to one of the
FIFO options in the Work in Process Parameters window.
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System Generated Transactions  with PO Move
Resources
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System Generated Transactions
with PO Move Resources

System Generated Transactions
with PO Move Resources

Move Quantities Example

Receipt
Quantity

Outside
Processing Unit

Type

Assembly 20 100 EA

Usage Rate or
Amount

Quantity
Moved

100

Resource 10 1,000 HR 100

Additional Information
There can be only one PO Move resource per operation on a routing.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 79

Additional Information
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Calculating Requisition Quantities

Req, PO, Receipt Quantities

Move quantity

1

(Usage rate or amount x Move Quantity)

Outside
Processing Unit

Type (Item)

Assembly

Assembly

Resource

Resource (Usage rate or amount x 1)

Basis
(Resource)

Item

Lot

Item

Lot

Calculating Requisition Quantities
• When Oracle Work in Process requisitions an outside processing item with

an Outside Processing Unit Type of Resource, it uses the outside
resource’s usage rate or amount and basis, as well as the assembly move
quantity if the basis is Item, to calculate the requisition quantity.

• When Oracle Work in Process requisitions an outside processing item with
an Outside Processing Unit Type of Assembly, it does not extend the
assembly move quantity by the usage rate or amount.
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Review QuestionReview Question

Manufacturing Collaboration gives the ability of an
assembly to automatically be completed into
inventory as the supplier contribution is received.
Which of the following will prohibit the automatic
completion?
A. OSP operation is last operation on the routing
B. PO move resources tied to the last operation
C. Completion sub-inventory designation
D. PO receipt resources tied to the last operation

Manufacturing Collaboration gives the ability of an
assembly to automatically be completed into
inventory as the supplier contribution is received.
Which of the following will prohibit the automatic
completion?
A. OSP operation is last operation on the routing
B. PO move resources tied to the last operation
C. Completion sub-inventory designation
D. PO receipt resources tied to the last operation
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Answer to Review QuestionAnswer to Review Question

Manufacturing Collaboration gives the ability of an
assembly to automatically be completed into
inventory as the supplier contribution is received.
Which of the following will prohibit the automatic
completion?
A. OSP operation is last operation on the routing
B. PO move resources tied to the last operation
C. Completion sub-inventory designation
D. PO receipt resources tied to the last operation

Manufacturing Collaboration gives the ability of an
assembly to automatically be completed into
inventory as the supplier contribution is received.
Which of the following will prohibit the automatic
completion?
A. OSP operation is last operation on the routing
B. PO move resources tied to the last operation
C. Completion sub-inventory designation
D. PO receipt resources tied to the last operation
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Review QuestionReview Question

A purchase requisition can now be automatically
created for outside processing:
A. at job creation in a status of unreleased
B. when a job is changed to released
C. when a job is changed to on-hold
D. at job completion

A purchase requisition can now be automatically
created for outside processing:
A. at job creation in a status of unreleased
B. when a job is changed to released
C. when a job is changed to on-hold
D. at job completion
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Answer to Review QuestionAnswer to Review Question

A purchase requisition can now be automatically
created for outside processing:
A. at job creation in a status of unreleased
B. when a job is changed to released
C. when a job is changed to on-hold
D. at job completion

A purchase requisition can now be automatically
created for outside processing:
A. at job creation in a status of unreleased
B. when a job is changed to released
C. when a job is changed to on-hold
D. at job completion
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In this course, you should have learned how to:
• Describe the difference between Outside

Processing and Manufacturing Collaboration
• Explain why Manufacturing Collaboration is a

business solution
• Identify the key integration points
• Execute the setup steps for Manufacturing

Collaboration

In this course, you should have learned how to:
• Describe the difference between Outside

Processing and Manufacturing Collaboration
• Explain why Manufacturing Collaboration is a

business solution
• Identify the key integration points
• Execute the setup steps for Manufacturing

Collaboration
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Practice 1 OverviewPractice 1 Overview

This practice covers the manufacturing collaboration
process.
This practice covers the manufacturing collaboration
process.

Scenario
A manufacturer wants to send out an assembly to an outside processor.  Perform
the setup steps and transactions required to demonstrate the manufacturing
collaboration process.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 86

Practice 10 Solutions

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 1 SolutionsPractice 1 Solutions

Oracle Applications Logon
The following is specific information to access Vision for manufacturing:
1. Enter a url that is given to you by the instructor
2. Enter User Name: mfg
3. Enter Password: welcome
4. Click Connect
5. Select Responsibility: Manufacturing and Distribution Manager
6. Click OK
7. Select the M1 Seattle manufacturing organization in which to do all of the practices.

(N) Other—>Change Organization (M) M1 Seattle Manufacturing (B) OK
8. Verify that the requisition will be created upon job release.

(N) Work in Process > Setup > Parameters
9. Choose the Outside Processing tab

•  Requisition Creation Time:  at job/schedule release
10. Save your work.
11. Create a location that will represent the address where the goods will be sent after
they leave the first supplier.

(N) Inventory > Setup > Organization > Locations
•  Name:  you decide
•  Description:  you decide
•  Address Details Tab:
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Address:  you decide
Choose OK

•  Shipping Details tab:
Ship to location:  the name of your location created above
Ship to:  enabled
Receiving Site:   enabled
Office site:  enabled
Bill to site:  enabled
Internal site:  enabled

•  Save your work.
12. Establish the relationship between the two suppliers.  You will need to attach the
location you created above with the second supplier that you will use in the exercise.

(N) Purchasing > Supply Base > Suppliers
•  (M) View > Find
•  Supplier Name:  Industrial Dressler
•  Choose Find
•  Choose Sites
•  Choose the General tab.
•  Shipping Network Location:  the location you created above (this is needed to
link the two supplier together)
•  Save your work.

13. The suppliers are set up in sys admin, however, you will need to add the workflow
responsibility to each supplier.

•  Change your responsibility to System Administrator
(N) Security > Responsibility > Define

•  (M) View > Find
•  Responsibility Name:  @Workflow
•  Effective date to:  clear this field
•  Save your work.
•  Find a user

(N) Security > User > Define
•  (M) View > Find
•  User name:  Advanced
•  Responsibilities:  @Workflow
•  Save your work.
•  Repeat the same process for the second supplier contact.
•  User Name:  Industrial
•  Responsibilities:  @Workflow
•  Save your work.
•  Switch your responsibility back to Manufacturing and Distribution Manager.
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14. Create your items, bills and routings to be used in outside processing.
(N) Inventory > Items > Master Items

•  Item:  xx-osp assembly
•  Description:  you decide
•  Choose (M) Tools > Copy from
•  Template:  finished good
•  Save your work.  Assign the assembly to the M1 organization.
•  Choose (M) Tools > Organization assignment

Org:  M1 (enable)
•  Save your work.

15. Create two parts that will represent supplier contribution at each operation.  Use the
outside processing template.

(N) Inventory > Items > Master Items
•  Item:  xx-osp item a
•  Description:  you decide
•  Choose (M) Tools > Copy from
•  Template:  outside processing
•  Choose the purchasing tab:

Purchased:  enabled
Purchasable:  enabled
OSP item:  enabled
OSP type:  assembly
List price:  you decide

•  Choose the receiving tab:
Receipt routing:  direct

•  Save your work.  Assign the part to the M1 organization.
•  Choose (M) Tools > Organization assignment

Org:  M1 (enable)
•  Save your work.
•  Choose (M) File > New record
•  Create a second osp item using the outside processing template.
•  Item:  xx-osp item b
•  Description:  you decide
•  Choose (M) Tools > Copy from
•  Template:  outside processing
•  Choose the purchasing tab:

Purchased:  enabled
Purchasable:  enabled
OSP item:  enabled
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OSP type:  assembly
List price:  you decide

•  Choose the receiving tab:
Receipt routing:  direct

•  Save your work.  Assign the part to the m1 organization.
•  Choose (M) Tools > Organization assignment

Org:  M1 (enable)
•  Save your work.

16. Create two resources which will be linked one on one to the outside processing item
(N) Bill of Materials > Routings > Resources

•  Resource:  xx-ospresa
•  Description:  you decide
•  Type:  miscellaneous
•  UOM:  Each (you will be prompted for a choice; do not choose process)
•  Charge type:  PO Move
•  Basis:  item
•  Outside Processing:  enabled
•  Item:  xx-osp item a
•  Costed:  enabled
•  Standard rate:  enabled
•  Absorption account:  accept default
•  Variance account:  accept default
•  Choose rates

Cost type:  Pending
Rate:  1.00

•  Save your work.  You will now create a second outside processing resource.
•  Choose (M) File > New record
•  Resource:  xx-ospresb
•  Description:  you decide
•  Type:  miscellaneous
•  UOM:  each
•  Charge type:  PO Move
•  Basis:  item
•  Outside Processing:  enabled
•  Item:  the second item you created above
•  Costed:  enabled
•  Standard rate:  enabled
•  Absorption account:  accept default
•  Variance account:  accept default
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•  Choose rates
Cost type:  Pending
Rate:  1.00

•  Save your work.
•  Choose (M) File > New record

You will now create a queue resource that will be used for scheduling the
time at the suppliers.  This resource will not be costed just scheduled.

•  Resource:  xx-queue
•  Description:  you decide
•  Type:  machine
•  UOM:  hr
•  Charge type:  wip move
•  Basis:  item
•  Save your work.

17. Create two departments that represent the two outside suppliers.
(N) Bill of Material > Routings > Departments

•  Department:  xx-osp1
•  Description:  you decide
•  Choose Resources

Under the Main tab:
Resource:  xx-ospresa
Available 24 hours:  X
UOM:  will default
Units:  1
Resource:  xx-queue
Available 24 hours:  X
UOM:  will default
Units:  1

•  Save your work.
•  Choose (M) File > New record
•  Create the second department which represents the second supplier
•  Department:  xx-osp2
•  Description:  you decide
•  Location:  the location created above (this is the second supplier’s address and
is where the assemblies will be sent once they leave the first supplier.  They will
not come directly back to the manufacturer.)
•  Choose resources
•  Under the Main tab:

Resource:  xx-ospresb
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Available 24 hours:  X
UOM:  will default
Units:  1
Resource:  xx-queue
Available 24 hours:  X
UOM:  will default
Units:  1

•  Save your work.
18. Create a routing for the assembly.

(N) Bill of Materials > Routings > Routings
•  Item:  xx-osp assembly
•  Navigate to the operations region

Sequence:  10
Department:  xx-osp1

•  Choose operation resources
Sequence:  10
Resource:  xx-ospresa
Usage:  3

•  Choose costing
Standard rate:  X
Charge Type:  PO Move

•  Return to the first page
Sequence:  20
Department:  xx-osp2

•  Choose operation resources
Sequence:  10
Resource:  xx-queue
Usage:  you decide

•  Choose scheduling
Scheduled:  yes

•  Choose costing:   wip move
Sequence:  20
Resource:  xx-ospresb
Usage:  1

•  Choose costing
Standard rate:  X
Charge type:  PO Move

•  Return to the first page
•  Choose routing details.
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Completion Sub-inventory:  fgi (a must have for automatic completion)
•  Save your work.

19. Create a Bill of Material for the final assembly (optional)
(N) Bill of Material > Bills > Bills

•  Item:  xx-osp assembly
•  Navigate to the main tab

Item seq:  10
Operation seq:  10
Component:  choose a component from the seeded data
Quantity:  1

•  Choose the tab material control
Supply type:  operation pull
Supply sub-inventory:  stores

•  Save your work
20. Create a work order for a quantity of 100.

(N) Work in Process > Discrete > Discrete Jobs
•  Choose new
•  Job:  xx-osp1
•  Type:  standard
•  Assembly:  xx-osp assembly
•  Class:  discrete
•  Status:  released
•  Start quantity:  100
•  MRP Net:  will default
•  Start date:  you decide
•  Choose the routing tab

Completion sub:  verify that this field has a value
•  Save your work.
•  View the operations and make a note of the start date of the second operation.
•  Choose operations.
•  Choose dates.

21. The requisition import will run automatically after your job is created.  Verify that the
requisition import has completed normal.

(M) View > Requests
22.  Autocreate the purchase orders from the requisitions.  You will do this for both osp
items.

(N) Purchasing > Autocreate
•  Item:  xx-osp item a
•  Choose find
•  Select your requisition.
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•  Choose automatic
•  Supplier:  Advanced Network Devices
•  Site:  Santa Clara
•  Choose create
•  Make a note of your po number  ______________________.
•  Contact (on the header):  Joseph Williams
•  Need by date:  defaulted from the start date of the second operation
•  Choose shipments

Ship to:  should be the location you created.  This says the goods are not
coming back to my site but are going to an address for the second supplier.

•  Save your work.
•  Return to the header and approve the purchase order.
•  Close the window and return to the find requisitions line window.  Search for
your second osp item.
•  Item:  xx-osp item b
•  Choose find
•  Select your requisition and choose automatic.
•  Supplier:  Industrial Dressler
•  Site:  US Headquarters
•  Create the purchase order.
•  Make a note of  your po number _______________________.
•  Contact:  James Indus
•  Choose shipments

Ship to:  M1-Seattle (this will default to the location you created above)
•  Save your work.
•  Approve the purchase order.

23. Log on to the Internet Supplier Portal and create an ASN for the first purchase order.
Note: By creating an ASN for the shipment, you will only need to run the receiving
transaction processor in order for the assemblies to be moved to the next operation.  The
wip move interface manager will move the assemblies.   The system is creating a logical
receipt for the shipment from the first supplier to the second supplier.

•  User Name:  Advanced
•  Password:  welcome
•  Choose supplier services by supplier.
•  Choose Advanced Shipment Notice

Supplier Site:  choose the list and search for Santa Clara (this is case
sensitive)

Ship to:  choose the list and search (this is case sensitive)
•  Choose search
•  Select your purchase order number.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Manufacturing Collaboration
Chapter 10 - Page 94

•  Choose add to ASN.  You should see a message that says:
"total po shipments added: 1".

•  Choose next.
•  Enter the required information.
•  Choose next.
•  Choose finish.  You should see a message that says:
“an ASN has been successfully created.”
•  Choose Exit.

24. Return to the Core Manufacturing Applications and run the receiving transaction
processor.

(N) Purchasing > Reports > Run
•  Name:  Receiving Transaction Processor
•  Choose submit.

25. Verify that a workflow notification has been created for the shipment to the second
supplier.

(N) Work in Process > Notification Summary
•  Choose the flashlight to look for your notification.
•  Status:  all
•  Type:  WIP:  Shipping and Receiving Intermediate
•  Sent:  today
•  Choose find.

• You should see that a notification has been sent to the production manager
and the buyer on the second purchase order.

• The buyer is required to respond to the purchase order.
• The notification is then sent to the contact at the supplier contact.  The

supplier is required to respond saying how many assemblies were received
and if any were damaged.

• A notification is sent to the buyer once the second supplier has responded.
This notification does not require a response.

26. Verify that the assemblies have moved to the second operation.
(N) Work in Process > Discrete > Discrete Jobs

•  Job:  xx-osp1
•  Choose find.
•  Choose operations.
•  Choose the quantities tab.  You should the quantity in the queue step of the
second operation.

27. Once the workflow notifications have been processed, navigate back to the Internet
Supplier Portal, login as the second supplier  and create the ASN for the second supplier.

•  User Name:  Industrial
•  Password:  welcome
•  Choose supplier services by supplier.
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•  Choose Advanced Shipment Notice
•  Search for the Supplier Site and Ship to Location (this is case sensitive)

Supplier Site:  US Headquarters
Ship to location:  M1-Seattle (your assemblies are coming back to the

manufacturer after this operation)
•  Choose search
•  Select your purchase order and choose add to ASN.
•  You will see a message that says "Total PO shipments added: 1"
•  Choose next
•  Fill in the required information as you did for the first supplier and choose
finished.
•  You should see a message that says ASN successfully created.  Choose exit.

28. Navigate back to Core Manufacturing and run the receiving transaction processor.
(N) Purchasing > Reports > Run

•  Name:  Receiving Transaction Processor
•  Choose submit.  Once this process completes, you will need to receive the
assemblies.

(N) Purchasing > Receiving >Receipts
•  Item:  xx-osp item b
•  Choose find
•  Select the box next to the item and save your work.

29. Verify that the assemblies have moved to the to move step of the next operation and
that the assemblies have been completed into finished goods.

(N) Work in Process > Discrete >Discrete Jobs
•  Job:  xx-osp1
•  Choose find.  The status of the job should be complete.
•  Choose operations
•  Choose quantities.  There should not be any assemblies left in the job.

30. Verify that the completion transaction did occur.
(N) Inventory > Transactions > Material Transactions

•  Item:  xx-osp assembly
•  Choose find
•  Choose Transaction Type

Source:  xx-osp1
Transaction Type:  WIP Assembly Completion
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